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Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a 
document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/
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Support

Mercury Product Support

You can obtain support information for products formerly produced by Mercury as follows:

• If you work with an HP Software Services Integrator (SVI) partner (http://
h20230.www2.hp.com/svi_partner_list.jsp), contact your SVI agent.

• If you have an active HP Software support contract, visit the HP Software Support Web 
site and use the Self-Solve Knowledge Search to find answers to technical questions.

• For the latest information about support processes and tools available for products 
formerly produced by Mercury, we encourage you to visit the Mercury Customer Support 
Web site at: http://support.mercury.com.

• If you have additional questions, contact your HP Sales Representative.

HP Software Support

You can visit the HP Software Support Web site at: www.hp.com/go/hpsoftwaresupport

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many 
also require a support contract. To find more information about access levels, go to:  
http://h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to:  
http://h20229.www2.hp.com/passport-registration.html 
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Welcome to This Guide

This guide describes how to work with HP Business Availability Center 
Dashboard.

How This Guide Is Organized

The guide contains the following parts:

 Part I Dashboard

Describes how to work with Dashboard and the Dashboard views, and how 
to use the Top View, Console, Filters, Geographical Map, Custom Map, and 
Topology Map tabs to display the view’s data. 

 Part II Reports

Describes how to view the Dashboard reports, and how to use the report 
repository. 

 Part III KPIs

Describes how to manage the Key Performance Indicators (KPIs) of a 
configuration item (CI).

This chapter describes: On page:

How This Guide Is Organized 11

Who Should Read This Guide 12

Getting More Information 12
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Welcome to This Guide
 Part IV Ticker

Describes how to install and manage so the Dashboard Ticker so that you 
can display HP Business Availability Center data on your desktop in a Ticker 
Window or in a Message Window.

 Part V User Interface

Describes the pages and dialog boxes in both the Dashboard application and 
the Dashboard administration.

Who Should Read This Guide

This guide is intended for the following users of HP Business Availability 
Center:

➤ HP Business Availability Center administrators

➤ HP Business Availability Center platform administrators

➤ HP Business Availability Center application administrators

➤ HP Business Availability Center data collector administrators

➤ HP Business Availability Center end users

Readers of this guide should be knowledgeable about navigating and using 
enterprise applications, and be familiar with HP Business Availability Center 
and enterprise monitoring and management concepts.

Getting More Information

For a complete list of all online documentation included with HP Business 
Availability Center, additional online resources, information on acquiring 
documentation updates, and typographical conventions used in this guide, 
see the the HP Business Availability Center Deployment Guide PDF.
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1
Introduction to Dashboard 

This chapter includes general information about Dashboard.

This chapter describes: On page:

Concepts

About Dashboard 16

Dashboard Tabs 18

How Dashboard Works 20

Repositories 21

Views 22

Real-Time Changes to CI Properties 23

Dashboard Application Components in the Service Report 23

Visible and Hidden Child CIs 24

Dashboard General Notes and Tips 27

Tasks

View Data in Dashboard 28

Customize the Way HP Business Availability Center Displays Views 
in Dashboard

30

Display Data in Dashboard–Details 33

View Sample Details 34

Acknowledge Performance Problems 36

Analyze Real-Time Change Information 39
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Chapter 1 • Introduction to Dashboard
About Dashboard

HP Business Availability Center is a comprehensive business service 
management and application management solution. Dashboard enables 
your team to monitor the health of business services and applications from 
the point of view of the consumers of those services—the business, its 
customers, and its partners.

This section includes the following topics:

➤ “Collecting and Aggregating Data” on page 17

➤ “Prioritizing IT Operations and Maximizing Business Results” on page 17

General Reference

Dashboard Menu Options 40

Customization

Modify the Length of a CI Name 61

Modify the Maximum Number of CIs to Be Displayed in Dashboard 61

Modify the Changes Period for the Change Report 61

Modify the Number of CIs that Can Be Monitored for Change in 
Real-Time

62

Modify the Dashboard Tabs Refresh Rate 62

Customize Tooltips and Icons 63

Troubleshooting and Limitations 63

This chapter describes: On page:
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Chapter 1 • Introduction to Dashboard
Collecting and Aggregating Data
Dashboard uses data collected by HP Business Availability Center 
monitoring components, such as Business Process Monitor, SiteScope, and 
Enterprise Management Systems (EMS) integration tools, as well as data 
collected from external monitoring tools. HP Business Availability Center 
collects metrics about the end-user experience from a range of 
environments, including ERP, CRM, Web, and Citrix, and about the system 
performance from a range of back-end infrastructure components, including 
Web, application, database, and firewall servers.

The collected and aggregated data is used by the Dashboard Key 
Performance Indicators (KPIs) to provide quantifiable measurements that 
help you monitor how well your business is achieving objectives. The KPIs 
provide a real-time assessment of the present state of your business and 
processes, enable you to track critical performance variables over time, and 
help you assess the business impact of problems in the system.

At the top level, Dashboard provides an integrated view of critical 
applications and business processes; from there, you can drill down to the 
underlying IT infrastructure associated with these critical business processes. 
This drill-down view can be laid out in any number of ways, such as by data 
centers, by technology clusters, by geographical locations, and so on.

Prioritizing IT Operations and Maximizing Business 
Results
Dashboard helps you to prioritize IT operations and maximize business 
results by:

➤ Presenting global system component data organized into a logical and 
relevant framework.

➤ Providing integrated, scalable, cross-application views that reflect the health 
of mission-critical services and applications in real time. This enables IT 
operations teams to continuously manage the health of mission-critical 
services and applications from one central location.

➤ Providing a common view of how IT operations are meeting line-of-business 
goals. This enables better communication between the teams, and the 
alignment of management and IT operations around customer-centric 
values.
17



Chapter 1 • Introduction to Dashboard
➤ Providing the ability to assess actual customer impact, so that IT teams can 
prioritize response according to business impact and optimize resource 
utilization to meet critical business objectives. The end result is better 
quality of service for your end users.

➤ Providing a big-picture perspective, enabling you to see how a performance 
issue impacts the availability of any part of your business and to quantify 
the business impact of a potential failure.

➤ Providing operational-level service level management reporting. Dashboard 
uses Service Level Management data to provide an indication of whether an 
SLA is in breach of contract, or might be in breach in the near future.

Dashboard Tabs

The Dashboard application and administration use different sets of tabs.

This section includes the following topics:

➤ “Dashboard Administration Tabs” on page 18

➤ “Dashboard Application Tabs” on page 19

Dashboard Administration Tabs
The Dashboard Administration application enables you to access the tabs 
where you can perform administration tasks for Dashboard. It is accessed by 
selecting Admin > Dashboard and includes the following elements:

➤ KPIs tab. Enables you to edit the KPIs attached to a configuration item (CI), 
and to attach new KPIs to CIs. The KPIs you create are displayed in 
Dashboard to help the user monitor how well the business is achieving its 
objectives and assess the business impact of problems in the system. For 
details, see “KPIs Page” on page 324.

➤ Custom Map tab. Enables you to create a custom map to display real-time 
indicators icons representing CIs in the view on a custom image. For details, 
see “Custom Map Page” on page 267.

➤ Geographical Map tab. Enables you to create an association between 
geographical locations and status indicators using a maps applet. For details, 
see “Geographical Map Page” on page 282.
18



Chapter 1 • Introduction to Dashboard
➤ Repositories tab. Provides access to the Dashboard Repository. The 
repository provide definitions for objects in the HP Business Availability 
Center system. Many of these definitions can be customized as required by 
your organization. For details, see “Repositories” on page 21.

Dashboard Application Tabs
The Dashboard application enables you to access the tabs where you can 
view Dashboard data. It is accessed by selecting Application > Dashboard 
and includes the following elements:

➤ Top View tab. Displays the components of the active view in a hierarchical, 
top-down graphic. For details, see “Top View Page” on page 291.

➤ Console tab. Displays the components of the active view arranged in a 
hierarchical tree. For details, see “Console Page” on page 262.

➤ Filters tab. Displays a filtered list of CIs, according to the selected filter 
option. For details, see “Filters Page” on page 275.

➤ Geographical Map tab. Displays an association between geographical 
locations and status indicators using a maps applet. For details, see 
“Geographical Map Page” on page 282.

➤ Custom Map tab. Displays icons representing CIs in the view on a custom 
image. For details, see “Custom Map Page” on page 267.

➤ Topology Map tab. Displays the results of pattern views or instance views. 
For details, see “Topology Map Page” on page 290.

➤ Reports tab. Displays the Dashboard reports: KPIs Distribution Over Time, 
KPIs Over Time, KPIs Summary, KPIs Trend, Related Change Requests, and 
Service Impact reports, and the report repository. For details, see “Reports 
User Interface” on page 297.
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Chapter 1 • Introduction to Dashboard
How Dashboard Works

The physical and logical entities in your system, such as hardware, software, 
services, business processes, and so on, are represented in Dashboard by 
configuration items (CIs). The CIs are stored in the HP Universal CMDB, and 
organized into hierarchical format based on the interdependencies in your 
organization’s IT environment. 

You can view CIs in service views in Dashboard. Each service view provides a 
different aspect of your organization’s IT universe, enabling you to focus on 
the IT area that is of interest.

Each CI has one or more KPIs showing current operational status or business 
impact over time. Status propagates up the CI hierarchy, from the monitor 
(leaf) CIs at the bottom of a tree, up to the root CI shown at the top of the 
tree. The monitor CIs receive real performance metrics from the monitoring 
data collected by HP Business Availability Center, and KPI status for these 
CIs is calculated from that data. For most higher level CIs, KPI status is based 
on an aggregation of statuses for all child CIs (the calculation method used 
for this aggregation varies, according to the KPI’s business logic).

The child CIs for a CI may not be visible in a view, but the KPI status shown 
is still based on the status propagated up from both visible and hidden child 
CIs.

The incoming report data is updated every 30 seconds (configurable default 
value), so that the status information displayed in Dashboard represents the 
real-time availability of your organization’s infrastructure components. 

This section contains the following topics:

➤ “Monitoring Performance Problems” on page 21

➤ “Monitoring Service Level Agreements” on page 21
20



Chapter 1 • Introduction to Dashboard
Monitoring Performance Problems
When a performance problem is identified, you can drill down to locate the 
source of the problem, view event reports, and track problem handling. You 
can also move directly to the appropriate pages in HP Business Availability 
Center to view reports for problematic components, measurement data over 
time, and general monitoring data.

Dashboard also enables you to view operational status from the viewpoint 
of geographical locations, so you can see which locations are impacted by 
problems. 

In addition, you can isolate and manage enterprise problems discovered in 
HP Business Availability Center, and identify likely suspects that are at the 
root of the problem using the Problem Isolation application.

Monitoring Service Level Agreements
Service Level Management enables you to track applications, infrastructure, 
and services according to the service contracts you have with internal or 
external customers.

In Dashboard, you can view an SLA information bar that gives you 
advanced warning of any potential breaches of contract, and you can act 
proactively to fix a problem before it causes financial damage. 

Repositories

The Repositories tab includes the definitions for objects in the HP Business 
Availability Center system. Many of these definitions can be customized as 
required by your organization. For details, see “Repositories” on page 27 in 
CI Attribute Customization.
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Views

The CIs and relationships produced by the various CI-generating tools that 
operate within HP Business Availability Center are stored in the 
configuration management history database. 

The service views displayed in Dashboard are built from CIs contained in 
the CMDB. These CIs are mapped together to build views that meet your 
business requirements and objectives, and monitor what is important to 
you. (For a more detailed explanation of how views are built, see “Working 
with Pattern and Instance Views in IT Universe Manager” in IT World Model 
Management.) Each CI has only one instance in the CMDB. Different views 
can look at the same CI.

The CIs at the lowest level of the hierarchy represent the monitor CIs, such 
as SiteScope monitors, Business Process Monitor transactions, or metrics 
from other external monitoring sources. The upper levels of the hierarchy 
represent logical groups. CI names are either taken from the external source, 
or are defined by the administrator as part of the CI properties.

When changes are made to your organization’s infrastructure, they are 
detected by the discovery process or by the monitoring source adapters. 
Dashboard checks the engine every 60 seconds (default setting), for 
configuration changes received from the external sources. The structure and 
content of the CI hierarchies are then automatically updated and deployed 
to the Dashboard application.

In addition, changes made within HP Business Availability Center, by 
changing the profiles in End User Management Administration or manually 
updating CIs in CMDB Administration, are also automatically deployed to 
Dashboard.

KPIs are assigned, by default, to monitor CIs and propagate up the hierarchy. 
You can manually assign additional KPIs to CIs in Dashboard 
Administration. For each CI, one or more KPI columns are displayed. For 
example, Availability, System, Performance, and so on. For a list of the KPIs 
used in Dashboard, see “List of Dashboard KPIs and Their Details” in 
CI Attribute Customization.
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For each CI, each KPI column contains status icons or values, representing 
how the KPI objective is met. For details on KPI status, see “Understanding 
KPI Status” on page 203.

The views may also contain dynamic hierarchies generated by the Dynamic 
Node Factory definition file. These hierarchies are created in the CMDB at 
runtime, based on the incoming samples. The parent for a dynamic 
hierarchy is a Dynamic Node Factory CI. Note that the CIs under the 
Dynamic Node Factory parent do not generally have option menus. For 
more information on dynamic hierarchies, see “IT Universe Manager – 
Dynamic Node Factory” in IT World Model Management.

Real-Time Changes to CI Properties

Change icons are displayed in the Console tab and in the Filters tab, on the 
right of the CI name to indicate that changes were made to the first 20 
change-monitored properties of a CI, in real time. For details, see “Console 
Page” on page 262 or “Filters Page” on page 275.

Changes made to additional CIs are displayed in the Change report. For 
details, see “Change Report Page” in IT World Model Management.

To display the real-time change information, see “Analyze Real-Time 
Change Information” on page 39.

Dashboard Application Components in the Service Report 

You can build Service Reports in My BAC based on data from data sources 
from the Dashboard application. You can create a Service Report by selecting 
the Service Report portlet in My BAC, or by adding the Service Report 
component to a custom report to benefit from all the custom report 
capabilities. For details, see “Service Report” in Using My BAC or “Custom 
Report Manager” in Custom Reporting and Alerting.
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Visible and Hidden Child CIs

A CI’s child CIs can be specified as included (visible) or excluded (hidden) in 
a specific view. The status of any child CI, visible or hidden, has an impact 
on the status of its parent CI in any view where the parent CI appears. For 
details about including or excluding child CIs, see “Include Related CIs” in 
IT World Model Management.

Example

You might have the situation where, in a specific view, the Availability KPI’s 
status of the parent CI’s is Critical while the Availability KPI’s status of the 
CI’s child CIs are OK. When this happens, you would like to know what 
caused the status of the Availability KPI to be Critical. 

Use the Find Visible and Hidden Child CIs option to list all of the child CIs of 
the selected CI in the CMDB. After the list of child CIs is displayed, you can 
search for the views the child CI belongs to and then display the child CIs 
details in the specific view.
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Chapter 1 • Introduction to Dashboard
To find the Visible and Hidden Child CIs for a specific CI. In either the 
Console tab, or Filter tab in Dashboard, right-click the CI and select the Find 
Visible and Hidden Child CIs option to open the Find Visible and Hidden 
Child CIs dialog box and list all of the selected CI’s child CIs that appear in 
the CMDB (visible and hidden). 

For details, see “Find Visible and Hidden Child CIs Dialog Box”. 

The Find Visible and Hidden Child CIs page displays the following 
information:

➤ The name of the selected CI, whose child CIs you want to list, the CI’s 
KPIs, and their status in the current view.

➤ A list of the child CIs (visible and hidden) that appear in the CMDB, their 
KPIs and their status. In the Visible column, a checkmark indicates that 
the child CI is visible in the view and an X indicates that the child is 
hidden in the view.
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To search for the views that include a specific child CI. In View Explorer, 
click Search to perform a search for the CIs whose names include the 
selected child CI’s name string in all views, and display the results in the 
View Explorer search page.

Click the appropriate CI in the list to display more information about the 
selected CI in the selected view.

If the CI is not visible in any view, in Dashboard, the following message is 
displayed: Search is complete. There are no results to display for the current 
search parameters.

The CI is not visible in any view in the following situations:

➤ It is included in the CMDB but does not belong to any view.

➤ It belongs to a view but the Exclude all child CIs option has been selected 
for its parent CI in that view. For details, see “New CI Wizard” in IT World 
Model Management.
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Dashboard General Notes and Tips

Note the following when working with Dashboard:

➤ It is recommended that you use Microsoft Internet Explorer as your browser 
when using the Dashboard application.

➤ User access to Dashboard views is limited by the viewing permissions 
specified for the user. If you cannot see a view, contact your administrator. 
For details, see “Granting and Removing Permissions” in Platform 
Administration.

➤ The first time you access Dashboard, you may experience a short delay while 
Dashboard compiles the page.

➤ Dashboard uses the timestamp of the database machine hosting the 
HP Business Availability Center database. The times displayed in the tooltips 
reflect the time zone setting on that computer. If you customize the time 
zone setting in HP Business Availability Center using the Admin > Personal 
Settings > General Settings option, then the customized time zone is also 
used in Dashboard.

➤ When Dashboard does not receive data for a Business Process profile because 
a Business Process Monitor is stopped (while the profile itself is not 
stopped), this is not specifically indicated in the tooltip. In this case, after a 
while the tooltip Status parameter displays Not up to date, and the Warning 
parameter displays the number of seconds during which no data has arrived.
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View Data in Dashboard

To display data in views specific to your organization, create SiteScope 
monitors, Business Process and Real User Monitor monitors and run 
discovery on your system. The discovery process populates the CMDB. 
HP Business Availability Center collects data about end-users, business 
processes, and systems and display the data in topologies (views) relevant to 
your organization. Views display system performance data about your 
network and applications.

This section describes the processes to follow to view data in Dashboard.

This task includes the following steps:

➤ “Create SiteScope Monitors” on page 28

➤ “Create Business Process and Real User Monitor Profiles and Monitors” on 
page 28

➤ “Run Discovery” on page 29

➤ “Create Instance Views” on page 29

➤ “Display Data in Dashboard” on page 29

Create SiteScope Monitors
Create SiteScope monitors to collect network and system data about your 
system for use in HP Business Availability Center. SiteScope monitors 
information is displayed in System views. For details, see “System 
Availability Management” in Using System Availability Management.

Create Business Process and Real User Monitor Profiles 
and Monitors
Create Business Process and Real User Monitor profiles and monitors to 
collect performance data for HP Business Availability Center. Business 
Process and Real User Monitor monitors information is displayed in End-
User Monitor views. For details, see “General and Administration” in Using 
End User Management.
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Run Discovery
Collect information about your system by performing discovery to enable 
you to discover the IT infrastructure resources and their interdependencies 
such as applications, databases, network devices, servers, and so on. Each 
discovered IT resource is delivered to, and stored in, the configuration 
management database (CMDB) where the resource is represented as a 
managed configuration items (CIs). 

Discovery is an ongoing, automatic process that continuously detects 
changes that occur in the IT infrastructure and updates the CMDB 
accordingly. You do not need to install any agents on the devices to be 
discovered. Discovery processes have corresponding views that are 
automatically correlated with the CIs discovered during discovery and 
displayed in views. For details, see “Discovery Probe Installation” in 
Discovery.

Create Instance Views
The IT universe model in the CMDB can be very large, holding thousands of 
configuration items (CIs). A view enables you to build a subset of the overall 
IT universe model, containing only those CIs relating to a specific area of 
interest. Some views are automatically created when you use standard 
SiteScope, Business Process and Real User Monitor profiles and monitors. 
You can also define your own instance views to display only the 
information that is relevant to your organization’s business needs. For 
details, see “IT World Model Management Settings” in IT World Model 
Management.

Display Data in Dashboard
Use Dashboard’s tabs to display the CIs in the created views. For details, see 
“Display Data in Dashboard–Details” on page 33.
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Customize the Way HP Business Availability Center Displays 
Views in Dashboard

You can customize the way HP Business Availability Center displays views in 
Dashboard. 

The following flowchart describes the process of customizing the way a view 
is displayed in Dashboard to reflect your organizational requirements.

This task includes the following steps:

➤ “Set Your Views in CMDB For Display in Dashboard” on page 31

➤ “If Required, Modify KPI Defaults in Dashboard Administration” on page 31

➤ “If Required, Define a Custom Map in Dashboard Administration” on 
page 32
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➤ “If Required, Configure Geographical Map in Dashboard Administration” 
on page 32

➤ “Display Data in Dashboard” on page 32

Set Your Views in CMDB For Display in Dashboard
HP Business Availability Center provides several default views. If required, 
you can create custom views in CMDB Administration. 

For details about instance views, see “Create and Populate an Instance View” 
in IT World Model Management.

For details about pattern views, see “Pattern View Workflow” in IT World 
Model Management.

If Required, Modify KPI Defaults in Dashboard 
Administration
Monitor CIs associated with default sources generally have default KPIs. For 
example, Business Process Monitor, Real User Monitor, and SiteScope 
monitor CIs that you configure in End User Management Administration or 
System Availability Management Administration, all have default KPIs.

Note that CIs with default KPIs that are placed under other CIs in a view 
generally propagate their KPIs upward to the parent CIs.

You can modify the business rule (or its properties) used by a KPI. 
Alternatively, you can modify or delete a KPI associated with a higher level 
CI in a view if the KPI originated from a lower level CI, was propagated 
upward, and is not appropriate for the higher lever CI (for example, if you 
want to only see performance and not availability). You can also add a new 
KPI to a higher level CI. To do that, select Admin > Dashboard, select a view, 
and click the KPIs tab. For details, see “KPIs Page” on page 324.

You can also choose to save historical data for a KPI if you want to see the 
associated data in the KPI over Time report. For details, see “Persistent Data 
and Historical Data” on page 214.
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If Required, Define a Custom Map in Dashboard 
Administration
You can add a custom image upon which you place status indicators that 
display the real time status for specified CIs. Each status indicator displays 
the worst status from all KPIs associated with that CI. For example, if you 
place on the image a status indicator for a Line of Business CI, the status 
indicator displays the worst status of all KPIs associated with the Line of 
Business CI.

The custom image can be useful for representing data centers, geographical 
distribution of IT resources, and so on. To do that, select Admin > 
Dashboard, select a view, and click the Custom Map tab. For details, see 
“Display a View in a Custom Map” on page 129.

If Required, Configure Geographical Map in Dashboard 
Administration
The geographical map displays status indicators showing real-time status for 
CIs at different locations. When location parameters are defined for a CI in 
CMDB Administration, a status indicator automatically appears on the 
geographical map at the defined location. When there are multiple CIs with 
the same defined location, one status indicator is displayed for the location, 
showing the worst status for all KPIs associated with all CIs at that location.

Use the geographical map's zoom and center functions to focus on the parts 
of the map relevant to the defined locations. To do that, select Admin > 
Dashboard, select a view, and click the Geographical Map tab. For details, 
see “Display and Customize a View in Geographical Map” on page 112.

Display Data in Dashboard
Use Dashboard’s tabs to display different aspects of the view’s data. For 
details, see “Display Data in Dashboard–Details” on page 33.
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Display Data in Dashboard–Details

You can display the data obtained from different profiles and monitors in 
the different tabs of Dashboard to view different aspects of the data. Select:

➤ The Top View tab to display the components of the active view in a 
hierarchical, top-down graphic. To access the view, select Applications > 
Dashboard > Top View. For details, see “Display and Customize View 
Information in Top View” on page 70.

➤ The Console tab to display the components of the active view arranged in a 
hierarchical tree. To access the view, select Applications > Dashboard > 
Console. For details, see “Display and Customize View Information in the 
Console Tab” on page 88.

➤ The Filters tab to display a filtered list of CIs, according to the selected filter 
option. To access the view, select Applications > Dashboard > Filters. For 
details, see “Display and Customize a View Information in Filters” on 
page 96.

➤ The Geographical Map tab to display an association between geographical 
locations and status indicators using a maps applet. To access the view, 
select Applications > Dashboard > Geographical Map. For details, see 
“Display and Customize a View in Geographical Map” on page 112.

➤ The Custom Map tab to display icons representing CIs in the view on a 
custom image. To access the view, select Applications > Dashboard > Custom 
Map. For details, see “Display a View in a Custom Map” on page 129.

➤ The Topology Map tab to display the results of pattern views or instance 
views. To access the view, select Applications > Dashboard > Topology Map. 
For details, see “Display and Customize a View Information in the Topology 
Map” on page 136.

➤ The Reports tab to display the Dashboard reports: KPIs Distribution Over 
Time, KPIs Over Time, KPIs Summary, KPIs Trend, Related Change Requests, 
and Service Impact reports, and the report repository. For details, see 
“Reports User Interface” on page 297.
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View Sample Details

If required, you can set Dashboard to provide data from the last sample that 
arrived for a monitor CI. This data is viewed in the Event Details dialog box 
for the CI. The Event Details dialog box displays all of the parameters for the 
CI, and gives the parameter values at the last update. For details, see “Event 
Details Dialog Box” on page 322. You can also add the last sample detail 
information to a KPI’s tooltip. For details, see “Display the Last Sample 
Details” in CI Attribute Customization.

Example–View Sample Details for a CI

Click the Console or Filters tabs in Dashboard, and click the status icon for a 
monitor CI. (If there is an associated Event Details dialog box for a CI, then 
the cursor changes to a hand when you hold the cursor over the status icon 
for the CI.) 
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The Event Details dialog box appears as follows:
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Acknowledge Performance Problems

The Acknowledging utility enables you to track performance problems 
identified in your system and network infrastructure by keeping a record of 
when the problem was acknowledged and by which user. 

You can acknowledge a problem by selecting the Ack check box for a CI in 
the Top View, Console, and Filters tabs (you can clear the acknowledgment 
by selecting the check box again). In the Console and Filters tabs you can 
set/unset the acknowledgement by clicking the icon. You can also set/unset 
acknowledgment and view the CI acknowledgment history by using the 
context menu in the Top View, Console, and Filters tabs.

After a problem CI is acknowledged, or the acknowledged status is cleared, 
you can view the history in the Acknowledged Details dialog box. For 
details, see “Acknowledgment History and Details Dialog Box” on page 260.

By default, the Ack column is displayed. It can be hidden by users with 
administrative permissions. The Acknowledgment-related context menu 
options remain available. 

For details about the Console tab, see “Console Page” on page 262.

For details about the Filters tab, see “Filters Page” on page 275.

Note: The Ack check box is enabled only if there is at least one KPI defined 
for the CI, and at least one of the KPIs has a status other than OK (green).
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Example–View Acknowledgment Details

A tooltip for the Ack icon displays the current status of the CI’s 
acknowledgment.

To view the details of the current acknowledgment or the acknowledgment 
history of the CI, click the down arrow to the right of a CI and select 
Acknowledgement > Acknowledgment Details. You can then select one of 
the following options:

➤ Acknowledgment details. Displays the details of the currently opened 
acknowledgment in the Acknowledgment details box.

➤ CI history. Displays the details of all of the acknowledgments over time in 
the Acknowledgment details box.
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The Acknowledgment details box displays the date and time when the 
acknowledgment status was modified, the name of the user who modified 
the status, and the type of action that was performed. For details, see 
“Acknowledgment History and Details Dialog Box” on page 260.

You can add information about the actions you are going to perform to 
solve the problem in the Add details box and then click Add to add the 
information you entered to the acknowledgment history.

Example–Set or Unset Acknowledgment Details

You can acknowledge a problem. Click the down arrow to the right of a CI 
and select Acknowledgement > Set/Unset Acknowledgment (you can unset 
the acknowledgement by selecting the same option and clicking OK).

Note: The Ack check box is enabled only if there is at least one KPI defined 
for the CI, and at least one of the KPIs has a status other than OK (green).

In the Add details box, enter information about the acknowledgment.

Click OK to set or unset the acknowledgment depending on the previous 
status of the dialog box.
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Analyze Real-Time Change Information

This section describes the steps to follow to display real-time change 
information in the Console tab and in the Filters tab, and in the Change 
report.

This task includes the following steps:

➤ “Set the CIT to Monitor Changes to Its Properties” on page 39

➤ “Customize the Number of CIs Monitored for Real-Time Change” on 
page 39

➤ “Customize the Change Icon Display Period” on page 39

➤ “View Real-Time Changes” on page 39

Set the CIT to Monitor Changes to Its Properties
Select the Change Monitored parameter for the configuration item type 
(CIT) properties you want to monitor. For details, see “Add/Edit Attribute 
Dialog Box” in CI Attribute Customization.

Customize the Number of CIs Monitored for Real-Time 
Change
A limited number (20 by default) of CIs (and their child CIs) can be 
monitored simultaneously for real-time changes. This number can be 
customized. For details, see “Modify the Number of CIs that Can Be 
Monitored for Change in Real-Time” on page 62.

Customize the Change Icon Display Period
By default the Change icon is displayed for 24 hours (default value) after a 
change occurs. This time period can be customized. For details, see “Modify 
the Changes Period for the Change Report” on page 61.

View Real-Time Changes
Real-time changes for the first 20 CIs set to display real-time changes is 
displayed in the Console tab or in the Filters tab. 

For details about the Console tab, see “Console Page” on page 262.
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For details about the Filters tab, see “Filters Page” on page 275.

Changes made to other CIs are displayed in the Change report. For details, 
see “Change Report Page” in IT World Model Management.

Dashboard Menu Options

From most tabs in Dashboard and from the View Explorer, you can access 
context menu options that enable you to move to different tabs or 
applications filtered for the selected CI.

Click the down arrow next to a CI name to access the menu options for that 
CI. Available options depend on the type of CI and the context menu 
defined for the CI. If no context menu is defined for the CI, the menu arrow 
is not displayed. If one of the menu options is not supported for the selected 
CI, that option is disabled.

The menu options are available for CIs in the Console and Filters tabs, and 
in View Explorer. 

For advanced information on the various menu options, see “Context Menu 
Items Repository Reference” in CI Attribute Customization.

The available menu options of a CI can include the following functionality:

➤ Enable you to move to other HP Business Availability Center applications or 
SiteScope to view information and reports related to the CI, or to open 
standalone reports or views. For example, you can view a trend report on 
the End User Management page, including measurement data for the CI 
over a specified time period. 

➤ Enable you to move to the Filters tab to view the CIs of a CI’s subtree where 
you can filter the subtree CIs and monitor CIs according to the current 
active filter selected in the Filters tab.

The menu options displayed in Dashboard View Explorer and the main page 
of the Console and Filters tabs depend on the selected view and the selected 
CI. They can be a subset of the options described in this section. The options 
are listed in alphabetical order.
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This section includes the following topics:

➤ “Acknowledgment” on page 42

➤ “Application Mapping” on page 43

➤ “Drill to Diagnostics” on page 44

➤ “Filters” on page 45

➤ “Find Visible and Hidden Child CIs” on page 46

➤ “Go to BPI” on page 46

➤ “Go to Report” on page 47

➤ “Go to Siebel Diagnostics” on page 55

➤ “Go to Problem Isolation” on page 58

➤ “HP Service Center” on page 58

➤ “Properties” on page 58

➤ “Show Service Impact” on page 58

➤ “Show Related CIs” on page 59

➤ “Top View” on page 59
41



Chapter 1 • Introduction to Dashboard
Acknowledgment
This menu lists options similar to options in the Top View tab to view 
different trees centered on the selected CI. 

Sub-Menu Options Description

Acknowledgment Details Available for all CIs. 

Opens the Acknowledgment details page that 
displays information about the CI’s 
acknowledgment. 

For details, see “Acknowledgments Details Dialog 
Box” on page 261.

Set/Unset 
Acknowledgment

Available for all CIs. 

Opens the Set/Unset Acknowledgments page where 
you can set or clear the CI’s acknowledgment. 

For details, see “Acknowledgment History and 
Details Dialog Box” on page 260.
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Application Mapping
This menu lists options that enable you to open specific capabilities filtered 
by the selected CI.

Sub-Menu Options Description

Show Impact Available for SAP-specific CIs. 

Opens a dialog box that shows the impact of a root 
cause object by displaying all of the objects that are 
affected by it. For details about the report, see 
“Show Impact Report” in Solutions and Integrations.

For details about the SAP Systems view, see “SAP 
Systems View” in Solutions and Integrations.

Problem Isolation Available for SAP-specific CIs. 

Isolates a CI’s problem in a separate browser dialog 
box. For details about the report, see “Problem 
Isolation Report” in Solutions and Integrations.

For details about the SAP Systems view, see “SAP 
Systems View” in Solutions and Integrations.
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Drill to Diagnostics 
This menu lists options that enable you to open specific pages in the 
Diagnostics application filtered by the selected CI. This option is displayed 
only if you have installed Diagnostics.

Sub-Menu Options Description

Layers View Available for:

➤ All Probe Group, and Probe CIs in the 
Diagnostics View.

➤ Business Process Step CI, in the End User 
Monitors View. 

Note: This option is displayed only if you have 
installed Diagnostics.

Opens the Layers (Load) view, with the following 
characteristics:

➤ For a Business Process Step CI, the view displays 
the layer(s) of the transaction that corresponds to 
the Business Process Step CI.

➤ For a Probe Group CI, the view displays the 
performance metrics for the Probe Group.

➤ For a Probe CI, the view displays the performance 
metrics for the Probe. 

For more information about Diagnostics, see 
HP Diagnostics User’s Guide.

Server Requests Available for the Real User Monitor Business Process 
Step CIs in the End User Monitors View

Note: This option is displayed only if you have 
installed Diagnostics.

Opens the Server Requests View in the 
HP Diagnostics application with the URL(s) that 
correspond to the Real User Monitor Business 
Process Step CIs selected. 

For more information about Diagnostics, see 
HP Diagnostics User’s Guide.
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Filters
This menu lists filters that you can use to display subsets of the selected CI’s 
children on the Filters page. 

Summary View Available for all Diagnostics Probe Group and 
Diagnostics Probe CIs in the Diagnostics View. 

Note: This option is displayed only if you have 
installed Diagnostics.

Opens the Diagnostics Probe Group Summary View 
for the probe or the probe group in the 
HP Diagnostics application. 

For more information about Diagnostics, see 
HP Diagnostics User’s Guide.

Transactions View Available for all Business Process Step CIs in the End 
User Monitors View.

Note: This option is displayed only if you have 
installed Diagnostics.

Opens the Transactions view that displays 
performance metrics for the transactions being 
executed by your applications. The transaction that 
corresponds to the selected Business Process Step CI 
is highlighted.

For more information about Diagnostics, see 
HP Diagnostics User’s Guide.

Sub-Menu Options Description

Filter Subtree Available for all CIs. 

Opens the Filters page, which displays the selected 
CI subtree filtered by the active filter.

Filter Subtree Monitors Available for all CIs. 

Opens the Filters page, which displays the monitor 
CIs in the subtree of the selected CI filtered by the 
active filter.

Sub-Menu Options Description
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Find Visible and Hidden Child CIs
This option is available for all CIs. 

Returns all of the visible and hidden child CIs of the selected CI as they 
appear in the CMDB.

For details, see “Visible and Hidden Child CIs” on page 24.

Go to BPI
This option is available for Business Process, BPI Monitor, and BPI Monitor 
CIs.

Opens the HP Business Process Insight application. For details, see “Integrate 
HP Business Process Insight Data Into HP Business Availability Center” in 
Solutions and Integrations.

Show Complete Subtree Available for all CIs. 

Opens the Filters page, which displays the complete 
subtree of the CI as if it was filtered by the Show All 
active filter. That filter appears in the Active Filters 
box.

Show Subtree Monitors Available for monitor CIs. 

Opens the Filters page, which displays the monitor 
CIs in the subtree of the CI as if it was filtered by the 
Show Monitors Only active filter. That filter appears 
in the Active Filters box.

Sub-Menu Options Description
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Go to Report
This option is available for all CIs.

This menu lists options that enable you to access all types of reports that 
display information about the selected CI.

Sub-Menu Options Description

Change Rule Available for all CIs whose properties have changed. 

Opens the Change report for the CI. The Change 
report displays information about the changes 
made to the properties of CIs for all CIs that were 
assigned to keep this information.

For details about the report, see “Change Report 
Page” in IT World Model Management.

Component Topology Available for Deep Transaction Tracing CIs. 

Opens the RTM report. The RTM report displays a 
top view map for the flow of information across 
components in the target machine, over a specified 
time period. The report shows activity for all 
components on the machine during the time 
period, not for any individual transaction. The 
report also displays statistics on the interaction 
between components (for example, failed, late, and 
total counts for events). 

For details about the Deep Transaction Tracing Sites 
view, see “Deep Transaction Tracing View” on 
page 157.

For details about the Component Topology report, 
see “View Deep Transaction Tracing Information in 
Dashboard” on page 163.
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Configuration Item Status 
Alerts

Available for all CIs. 

Opens the Configuration Item Status Alerts report 
for the CI. The Configuration Item Status Alerts 
report lists all of the alerts that occurred in the 
specified period of time.

For details about the report, see “Configuration 
Item Status Alerts Report” in Custom Reporting and 
Alerting.

End User Summary Available for Real User Monitor-specific CIs. 

Opens the End User Summary report. The End User 
Summary report displays data for specific end users 
configured for Real User Monitor in End User 
Management Administration. 

For details, see “End User Summary Report” in Using 
End User Management.

For details about the Real User Monitor views, see 
Chapter 18, “Real User Monitor Views” in Using End 
User Management.

Event Count Over Time Available for Real User Monitor-specific CIs. 

Opens the Event Count Over Time report. The 
Event Count Over Time report displays data for all 
events, or sessions with events, in monitored 
applications that you configured in End User 
Management Administration, broken down by 
time intervals. 

For details, see “Event Count Over Time Report” in 
Using End User Management.

For details about the Real User Monitor views, see 
Chapter 18, “Real User Monitor Views” in Using End 
User Management.

Sub-Menu Options Description
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Event Summary Available for Real User Monitor-specific CIs. 

Opens the Event Summary report. The Event 
Summary report displays a summary of events in 
monitored applications that you configured in End 
User Management Administration. 

For details, see “Event Summary Report” in Using 
End User Management.

For details about the Real User Monitor views, see 
Chapter 18, “Real User Monitor Views” in Using End 
User Management.

Event Summary (Errors 
Monitor)

Available for RUM Error Events CIs. 

Opens the Event Summary report. For details, see 
“Event Summary Report” in Using End User 
Management.

Event Summary (Event 
Monitor)

Available for RUM Informational Events CIs. 

Opens the Event Summary report. For details, see 
“Event Summary Report” in Using End User 
Management.

Event Summary (HTTP 
Error Monitor)

Available for RUM HTTP Error Events CIs. 

Opens the Event Summary report. For details, see 
“Event Summary Report” in Using End User 
Management.

Event Summary 
(Information Event 
Monitor)

Available for RUM Informational Event Monitor 
CIs. 

Opens the Event Summary report. For details, see 
“Event Summary Report” in Using End User 
Management.

KPIs Over Time Available for all CIs. 

Opens the KPIs Over Time report for the CI. The 
KPIs Over Time report shows the status or value, 
over time, of selected CIs and KPIs that are 
accessible from the Dashboard application.

For details about the report, see “KPIs Over Time 
Report”.

Sub-Menu Options Description
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Operations Health Available for Web Service Operation, SiteScope 
Monitor, and Diagnostics Web Service Monitor CIs.

Opens the Health Report in the HP Business 
Availability Center for SOA application filtered for 
the specific operation. For details, see “Health 
Report” in Solutions and Integrations. 

Related Change Requests Available for all CIs.

Opens the Related Change Requests report that 
displays all change requests in the system that have 
direct or indirect impact on the selected CI. 

For details, see “Change Report Page” in IT World 
Model Management.

SAP Transaction Changes Available for SAP-specific CIs. 

Opens the SAP Transaction Changes report. The SAP 
Transaction Changes report displays the SAP 
transactions and SAP transports and the impact of 
transports on each transaction. 

For details about the report, see “SAP Transaction 
Changes Report” in Solutions and Integrations.

For details about the SAP System view, see “SAP 
Systems View” in Solutions and Integrations.

SAP Transport Changes Available for SAP-specific CIs. 

Opens the SAP Transport Changes report. The SAP 
Transport Changes report displays the changes 
inside the Transport and the impact on the SAP 
transaction. 

For details about the report, see “SAP Transport 
Changes Report” in Solutions and Integrations.

For details about the SAP System view, see “SAP 
Systems View” in Solutions and Integrations.

Sub-Menu Options Description
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Server Summary Available for Real User Monitor-specific CIs. 

Opens the Server Summary report. The Server 
Summary report displays data for the servers 
monitored by the Real User Monitor probe. 

For details about the report, see “Server Summary 
Report” in Using End User Management.

For details about the Real User Monitor views, see 
Chapter 18, “Real User Monitor Views” in Using End 
User Management.

Service Level Available for Deep Transaction Tracing CIs. 

Opens the Service Level Analysis report. The Service 
Level Analysis report provides a graphical view of 
response time for the transaction over time. 
Displayed information includes average response 
time, maximum response time, and transaction 
volume over each reporting time period. 

For details about the Deep Transaction Tracing Sites 
view and the Service Level Analysis report, see 
“Understanding Deep Transaction Tracing 
Integration in Dashboard” on page 155.

Session Analyzer Available for Real User Monitor-specific CIs. 

Opens the Session Analyzer report. The Session 
Analyzer report displays session data for specific 
applications configured for Real User Monitor in 
End User Management Administration. 

For details, see “Session Analyzer Report” in Using 
End User Management.

For details about the Real User Monitor views, see 
Chapter 18, “Real User Monitor Views” in Using End 
User Management.

Sub-Menu Options Description
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Siebel Cross-Performance Available for the Siebel Application Server, Siebel 
Web Server Extension, Siebel Component Group, 
Siebel Component, and Siebel Web Application CIs. 

Opens the Cross-Performance report for the CI. The 
Cross-Performance report displays the behavior of a 
measurement running on several monitored servers, 
or the behavior of several measurements from 
various types of monitors running on one 
monitored server. 

For details about the report, see “Cross-Performance 
Report” in Using System Availability Management.

SiteScope Available for SiteScope Profile, SiteScope Group, and 
SiteScope Measurement Group CIs. 

Opens the appropriate monitor page in SiteScope.

For details about SiteScope, see SiteScope 
documentation.

Systinet Web Service Data Available for Business Unit CIs, Web Service CIs, 
and Web Service Operation CIs, when there is an 
integration between HP Business Availability Center 
and HP SOA Systinet. 

Opens the HP SOA Systinet application, focused on 
the relevant Web service. For details, see the HP SOA 
Systinet documentation.

For details on the integration with HP SOA Systinet, 
see “Integrating with HP SOA Systinet” in Solutions 
and Integrations.

Sub-Menu Options Description
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Tracking Available for Deep Transaction Tracing CIs. 

Opens the Transaction Tracking Report. The 
Transaction Tracking report lists information for 
every instance (run) of the Business Process Monitor 
transaction over a specified time period. The 
displayed information includes start time, response 
time, and the result of the run. 

For details about the Deep Transaction Tracing Sites 
view, and the Transaction Tracking report, see 
“Understanding Deep Transaction Tracing 
Integration in Dashboard” in Solutions and 
Integrations.

Transaction Analysis Available for all CIs. 

Opens the Transaction Analysis report for the CI. 
The Transaction Analysis report provides an in-
depth picture of the performance of transactions. 

For details about the report, see “Transaction 
Analysis Report” in Using End User Management.

Trend Available for all CIs. 

Opens the trend report for the CI. Trend reports 
enable you to compare multiple measurements 
from several profiles. 

For details about the report, see “Trend Report 
Manager” in Custom Reporting and Alerting. 

Sub-Menu Options Description
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Triage Available for Real User Monitor-specific CIs and for 
Siebel-specific CIs. 

Opens the Triage report. The Triage report displays 
transaction data for Business Process Monitor, and 
Real User Monitor profiles for the past day. 

For details, see “Triage Report” in Using End User 
Management.

For details about the Real User Monitor views, see 
Chapter 18, “Real User Monitor Views” in Using End 
User Management.

For details about the Siebel Sites view, see “Siebel 
View” in Solutions and Integrations.

Web Services Health Available for Web Services CIs.

Opens the Health Report in the HP Business 
Availability Center for SOA application filtered for 
the specific. 

For details, see “Health Report” in Solutions and 
Integrations. 

Sub-Menu Options Description
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Go to Siebel Diagnostics
This menu lists options that enable you to open specific pages in the 
Business Availability Center for Siebel filtered by the selected CI.

Sub-Menu Options Description

Siebel Database 
Breakdown

Available for the Siebel Site, Siebel Application, and 
Siebel Enterprise CIs.

Opens the Database Breakdown tab in Business 
Availability Center for Siebel to enable you to create 
and analyze database logs that record the SQL 
activity between Siebel components and the Siebel 
database. 

For details, see “Siebel View” in Solutions and 
Integrations.

Siebel SARM Available for the Siebel Site, Siebel Application, and 
Siebel Enterprise CIs.

Opens the SARM - User Trace Breakdown tab in 
Business Availability Center for Siebel to enable you 
to create and record the SQL activity in each 
monitored Siebel site. 

For details, see “Siebel View” in Solutions and 
Integrations.
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Show Tasks in Error Available for Siebel Application Server, Siebel 
Component Group, and Siebel Component CIs. 

Opens a separate page with the Task Diagnostics 
Tool filtered by:

➤ The selected site, server, and Exited with Error 
status for Siebel Application CIs

➤ The selected site, server, selected Component 
Group CI, and Exited with Error status for 
Component Group CIs

➤ The selected site, server, selected Component 
Group CI, selected Component CI, and Exited 
with Error status for Component CIs

For details about the Siebel CIs, see “Default CITs in 
the Siebel View” in Solutions and Integrations.

For details about the Siebel Task Diagnostics Tool, 
see “Siebel View” in Solutions and Integrations.

Sub-Menu Options Description
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Show Running Tasks Available for Siebel Application Server, Siebel 
Component Group, and Siebel Component CIs. 

Opens a separate page with the Task Diagnostics 
Tool filtered by:

➤ The selected site, server, Running status, and 
Session type for Siebel Application CIs

➤ The selected site, server, selected Component 
Group CI, Running status, and Session type for 
Component Group CIs

➤ The selected site, server, selected Component 
Group CI, selected Component CI, Running 
status, and Session type for Component CIs

For details about the Siebel CIs, see “Default CITs in 
the Siebel View” in Solutions and Integrations.

For details about the Siebel Task Diagnostics Tool, 
see “Siebel View” in Solutions and Integrations.

Show Processes This option is available for Siebel Application 
Server, Siebel Component Group, and Siebel 
Component CIs. 

This option opens the Task Diagnostics Tool filtered 
by:

➤ The selected site, and server for Siebel 
Application CIs

➤ The selected site, server, and selected Component 
Group CI for Component Group CIs

➤ The selected site, server, selected Component 
Group CI, and Component CI for Component 
Group CIs

For details about the Siebel Task Diagnostics Tool, 
see “Siebel View” in Solutions and Integrations.

For details about the Siebel CIs, see “Default CITs in 
the Siebel View” in Solutions and Integrations.

For details about the Process Diagnostics Tool, see 
“Siebel View” in Solutions and Integrations.

Sub-Menu Options Description
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Go to Problem Isolation
You can access the appropriate pages in the Problem Isolation application 
filtered by the selected CI. Problem Isolation enables you to isolate 
enterprise problems discovered in HP Business Availability Center, and to 
identify likely suspects to help in solving the root cause of the problem.

This option is available for all CIs. 

Opens the Problem Isolation application, which is also accessible via 
Applications > Problem Isolation. The user enters the application on the 
Problems List page.

For details about the Problem Isolation application, see Using Problem 
Isolation.

HP Service Center
This option is available for Business Service CIs or EMS Monitor CIs under 
Business Service CIs. 

Opens the HP ServiceCenter application.

Properties
This option is available for all CIs. 

Opens the Properties dialog box appropriate for the CI. 

For details, see “Working with CIs” in IT World Model Management.

Show Service Impact
This option is available for all CIs.

Opens the Service Impact report that displays the impact of the current CI 
on the services that depend on that CI. If there are no services attached to 
the CI, the report is empty. For details, see “Service Impact Report” on 
page 316.
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Show Related CIs 
This option is available for all CIs. 

Performs a search for related CIs and displays the result in the Search tab of 
View Explorer. 

For details about the Search tab, see “Using the Search Tool” in Reference 
Information.

Top View
This menu lists options similar to options in the Top View tab to view 
different trees centered on the selected CI. 

Sub-Menu Options Description

Show in Top View Available for all CIs. 

Opens the Top View tab with the view’s tree 
centered on the selected CI. 

For details about the Top View tab, see “Top View 
Page” on page 291.

Show Path to Root Available for all CIs. 

Opens a Top View page that displays the path from 
the selected CI to the root CI, in the Filters or 
Console tab. For example:
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Show Problematic Subtree Available for all CIs. 

Opens a dialog box with capabilities similar to the 
Top View tab capabilities. The dialog box displays 
all of the child CIs with Critical, Major, or Minor 
status and enables you to find the problematic child 
CI that causes the selected parent CI to have a status 
other than OK. It is enabled only for CIs that have 
at least one KPI with a status other than OK.

For example, the Default Client_SanityBPM_1 CI has 
the following children:

If you select the Top View >Show Problematic 
Subtree option for Default Client_SanityBPM_1, the 
following children are displayed:

Sub-Menu Options Description
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Modify the Length of a CI Name

To change the default length of the CI name, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and in the Dashboard Application - Dashboard 
Layout Properties table, modify the CI name maximum character length 
entry. When the CI name is longer than this value, it is shortened in the 
display and a tooltip displays the complete name. Default is 40.

Modify the Maximum Number of CIs to Be Displayed in 
Dashboard

To change the default number of CIs that can be displayed in Dashboard 
Console and Filters pages, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and in the Dashboard Application - Dashboard 
Layout Properties table, modify the Displayed CI limit entry. Default is 3000.

Modify the Changes Period for the Change Report

The Change report enables you to view the changes made to CI’s properties 
for all properties that were selected to keep this information. The report 
shows change information for the last time period that is specified in the 
Change period parameter. To modify the default time period (set at 1440 
minutes (24 hours)) select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, click Applications context, select Dashboard 
Application, locate the Changes period in the Change Impact Properties 
area, and enter the time period (in minutes) in the Value box. The 
recommended value is the default: 1440 minutes.

Note: The change takes effect after the server has been restarted.

For details about the Change report, see “Change Report Page” in IT World 
Model Management.
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Modify the Number of CIs that Can Be Monitored for 
Change in Real-Time

In the Console tab and in the Filter tab, a limited number (20 by default) of 
CIs (and their children) can be monitored for real-time changes at any one 
time. This number can be customized.

For details about real-time monitoring for change, see “Analyze Real-Time 
Change Information” on page 39.

Note: You can increase the default number of CIs that can be monitored but 
be aware that this might overload HP Business Availability Center.

To modify the default number of CIs that can be monitored for change in 
real-time, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, click Applications context, select Dashboard 
Application, and modify the value of the Maximum monitored CIs 
parameter in the Change Impact Properties area. The recommended value is 
20.

Note: The change takes effect after the server has been restarted.

Modify the Dashboard Tabs Refresh Rate

When you open a Dashboard tab for a view tree with a large infrastructure, 
you may experience a short delay while Dashboard builds the view.

The tab is refreshed every 30 seconds. If no change is made to the view, the 
display remains the same. If many changes have been made to a view, or if 
CIs have been deleted from the view, that view’s information in the tab is 
automatically reloaded after 30 seconds and displays the changes. 
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While reloading, the following message is displayed in the top right corner 
of the screen: The model has changed. Reloading... After reloading is 
complete, the following message is displayed in the top right corner of the 
screen: Top view has been updated with model changes. Last Update in the 
bottom left corner of the screen indicates the last time an update of the top 
view was reloaded. The refresh rate of the view can be modified. To modify 
the refresh rate, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Dashboard Application, 
and locate the UI Refresh Rate entry in the Dashboard Application - Service 
Impact table. Change the default.

Customize Tooltips and Icons

You can customize some aspects of the user interface.

➤ Modifying Tooltip Border and Header Colors. A KPI tooltip border and 
header have a default color that you can modify. For details, see “Modify the 
Tooltip Border and Header Colors” in CI Attribute Customization.

➤ Specifying a Different Icon Set. A different icon is used for the KPI status for 
each value range. 

You can replace the icons set in the Top View tab and for the KPIs in the 
other Dashboard. You can also replace the Trend and History icons with 
customized ones. For details, see “Change the KPI Status Icons” in 
CI Attribute Customization.

Troubleshooting and Limitations

This section includes troubleshooting and limitations for Dashboard.

This section includes the following topics:

➤ “Monitoring Usage in the System” on page 64

➤ “Using Dashboard Administration Logs” on page 64

➤ “Loss of Data after Renaming Transactions” on page 65
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Monitoring Usage in the System
You can monitor usage of the Dashboard application in a sessions log file. A 
line is added to the <HP Business Availability 
Center server root directory>\log\EJBContainer\bam.sessions.log file for 
every 6-, 12-, and 24-hour period, stating the number of Dashboard users 
during that time period. If a user accesses Dashboard, then closes 
HP Business Availability Center, then accesses the Dashboard application 
again, this counts as two user sessions in the log file.

To change the time period, open the <HP Business Availability 
Center server root directory>\conf\settings\BACAppSettings.xml file, look 
for the keys: session.log.interval.0, session.log.interval.1, or 
session.log.interval.2. Change the key to match the required time period as 
follows:

Using Dashboard Administration Logs
To facilitate the creation of troubleshooting logs, you must enable Debug 
mode. For details, see “About HP Business Availability Center Logs” in 
Reference Information. The logs are located in the <HP Business Availability 
Center home>\log\EJBContainer folder:

➤ bam.app.rules.log. To verify the status of a KPI, scan the log file manually 
or via a script for errors in the rule calculations. The log should not 
contain any errors such as Java exceptions. 

➤ TrinitySamples.log. To verify that samples have reached the HP Business 
Availability Center Bus, scan the log file manually or via a script for 
samples coming from SiteScope or Business Process Monitor.

Key Represents:

session.log.interval.0 a 6 hour period

session.log.interval.1 a 12 hour period

session.log.interval.2 a 24 hour period
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A utility called BusDiscovery can be activated to search for samples 
transmitted on the Bus. The utility is available under the <HP Business 
Availability Center home folder>\tools\BusDiscovery directory. Below is a 
sample command line that causes the utility to dump the arriving samples 
into 
D:\Temp\drv.log: sprinter -dc_attach localhost -dc_print_format 
sample_per_line -drv_log_file D:\Temp\drv.log

Loss of Data after Renaming Transactions
If a transaction in an HP Virtual User Generator script is renamed, Business 
Availability Center considers it as a new transaction. A new BPM Transaction 
from Location CI is created in the CMDB using the new name, and the CI 
with the old transaction name is removed after it stops receiving samples. In 
Dashboard, the new CI will not display trend and history status data from 
before the transaction name change.
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Dashboard Top View

This chapter describes Dashboard Top View.

This chapter describes: On page:

Concepts

Understanding Top View 68

Tasks

Display and Customize View Information in Top View 70

Access an External Application from Top View 71

General Reference

KPI Icons in Top View 73

Dynamic URL Parameters 74

Top View Menu Options 75

Customization

Customize the Layout of the Hierarchy in Top View 77

Changing the KPI Status Icons 79

View Chinese or Japanese Characters in Top View 79

Change Fonts in Top View 80

Change the Number of CI Levels Displayed in Top View 80

Change the Number of CI Levels That Can Be Expanded in Top View 80
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Understanding Top View

Top View enables you to see the business availability of your system 
components at a glance. The CI bars in the tab provide a visual 
representation of real-time IT performance metrics mapped onto business 
applications, based on the hierarchy tree structure defined for each view. 
The connecting lines between the bars define the relationships between the 
CIs.

By presenting an integrated, single view of essential applications and 
business processes, the Top View tab is able to provide you with an overall 
perspective on the health of your business services, and enables you to 
instantly assess how a performance issue impacts the availability of any part 
of your business. Each CI in the active view is color coded to indicate the 
worst status held by the CI’s KPIs.

This section includes the following topics:

➤ “Interactive Map” on page 68

➤ “Understanding the Colors and the Icons” on page 69

➤ “Virtual Containers” on page 70

Interactive Map
The Top View tab presents an interactive map of the CIs that can be 
intuitively manipulated using the mouse, enabling you to drill down to 
specific branches of the tree and to focus on particular business areas or 
problem areas.

By default, the Top View tab displays four levels of CIs. The rest of the CIs 
are collapsed. You can then expand a CI at the fourth level and see its 
children.

Hide or Display the View Bar in Top View When the View has a 
Single Root CI

81

Customize the Background Image for Top View 82

This chapter describes: On page:
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The lines connecting the bars represent the branches of the tree. The bars 
and lines can be manipulated to change the amount of information 
displayed and the overall layout of the diagram, as described in “Top View 
Page” on page 291.

Understanding the Colors and the Icons
Each CI contained in the view is displayed as a bar, color-coded according to 
the current worst operational status for that CI. For details about color 
coding, see “Understanding KPI Status” on page 203.

The icons displayed under a CI bar identify the relevant KPIs for the CI. 
These icons are also color coded to indicate the status of that KPI. 

Note: The root CI does not display KPI icons because it is a container and 
not a real CI.

For a list of the KPIs used in Dashboard, see “List of Dashboard KPIs and 
Their Details” in CI Attribute Customization.
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Virtual Containers
Virtual container CIs are displayed in Top View in regular CI bars, but their 
names appear between brackets. The bar is color-coded according to the 
current worst operational status for the group CI’s children CIs. You cannot 
right-click the bar to display context menu options.

Virtual containers are created by selecting the attribute by which you want 
to group the CIs in pattern views. For details, see “Group By Dialog Box” in 
IT World Model Management.

Display and Customize View Information in Top View

This section describes the steps needed to display a view information in Top 
View, and gives examples.

This task includes the following steps:

➤ “Access Top View and Display the View Information” on page 71

➤ “Customize the View Information in the Top View Page” on page 71

➤ “Filter the Relevant Information in Top View” on page 71
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Access Top View and Display the View Information
Select Applications > Top View tab to display the CIs of the selected view in 
a top-down, graphical diagram. Select the required view from the View 
Explorer. The name of the selected view is displayed in the central bar of the 
diagram.

The configuration items (CIs) in the view are displayed in hierarchical 
format within a single, interactive graphical interface, enabling you to gain 
a big-picture perspective of business availability for both the end-user and 
system Key Performance Indicators (KPIs) of your organization. 

For details, see “Top View Page” on page 291.

Customize the View Information in the Top View Page
Customization options are available to filter parts of the hierarchy and to 
deal with acknowledgments. For details about the options, see “Dashboard 
Top View” on page 67 and look for Customization.

Filter the Relevant Information in Top View
Context menu options are available to filter parts of the hierarchy and to 
deal with acknowledgments. 

For details, see “Top View Menu Options” on page 75.

Access an External Application from Top View

You can configure Dashboard Top View so that a user can open an external 
application. You do that by specifying the URL for the external application 
on the Infrastructure Settings page. 

Specifying a URL automatically adds the Open in New Window option to 
the context menu options in Top View. By default, no URL is specified and 
the Open in New Window option does not appear in the context menus in 
Top View. 

You can also use a dynamic URL that can be used, for example, to integrate 
external tools with HP Business Availability Center.
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To specify the URL, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Dashboard Application, 
and locate the Top View URL to Open entry in the Top View Properties table. 
Modify the value to the URL. To reset the URL to the default (empty), click 
Default.

Note: 

➤ The change takes place immediately.

➤ You must disable your browser’s pop-up blockers to open a window with 
the external application.

The URL you specify can be a regular URL or a dynamic URL. Use the 
following syntax (HTTP GET format) for a dynamic URL:

Use only the parameters you need in any combination. For example:
http://<URL>?nodeName=NODE.NAME&nodeParentId=NODE.PARENTID
adds the CI name and the ID of the parent CI to the URL.

When the user selects Open in New Window, Top View calls the URL in 
another window and supplies it with the values of the parameters you 
specified in the URL. The URL page uses the values of the parameters to 
display what is necessary. 

For details, see “Dynamic URL Parameters” on page 74.

http://<URL>?nodeName=NODE.NAME&nodeId=NODE.ID
&nodeStatus=NODE.STATUS&nodeParentId=NODE.PARENTID
&nodeChildId=NODE.CHILDIDS
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KPI Icons in Top View

A CI can have one of the following icons:

Note: 

In the Top View tab, the icon for a CI with a Stopped or Downtime status CI 
is gray with a green border.

You can customize the set of icons used in Dashboard. For details, see 
“Change the KPI Status Icons” in CI Attribute Customization.

Icon Description

Availability KPI (with OK status)

Customer KPI (with OK status)

System/HP System KPI (with OK status)

OT Impact KPI (with OK status)

Performance KPI (with OK status)

PNR KPI (with OK status)

RT Impact KPI (with OK status)

User KPI (with OK status)

All other KPIs (with OK status)

The CI has been acknowledged
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Dynamic URL Parameters

The parameters for a dynamic URL are: 

Constant Description

NODE.NAME The name of the CI. When the URL is executed, 
NODE.NAME is replaced by the name of the CI from 
which you want to open the URL The page specified 
in the URL opens and is filtered to display only 
information related to the CI.

NODE.ID The ID number of the CI. When the URL is 
executed, NODE.ID is replaced by the ID number of 
the CI from which you want to open the URL The 
page specified in the URL opens and is filtered to 
display only information related to the CI.

NODE.STATUS The status of the CI. When the URL is executed, 
NODE.STATUS is replaced by the status of the CI 
from which you want to open the URL The page 
specified in the URL opens and is filtered to display 
only information related to status. The available 
statuses are:

-4 downtime

-3 stop

-2 no data

-1 uninitialized

0 critical

5 major

10 minor

15 warning

NODE.PARENTID The ID of the parent CI. When the URL is executed, 
NODE.PARENTID is replaced by the ID of the parent 
of the CI from which you want to open the URL. 
The page specified in the URL opens and is filtered 
to display only information related to the parent CI.
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Top View Menu Options

Right-click a CI bar to display the following menu options (in alpahbetical 
order):

NODE.CHILDIDS The ID number of the CI children. When the URL is 
executed, NODE.CHILDIDS is replaced by a list of 
the IDs of the children of the CI from which you 
want to open the URL. The page specified in the 
URL opens and is filtered to display only 
information related to the children CI.

NODE.NAME The name of the node.

NODE.ID The ID number of the node.

NODE.STATUS If you want to filter by status, use 
NODE.STATUS.

NODE.PARENTID The ID of the parent CI.

NODE.CHILDIDS The ID number of the CI children.

Menu Option Description

Acknowledgment Details To display acknowledgment information for the CI. 
For details, see “Acknowledge Performance 
Problems” on page 36.

Expand more levels Opens a number of levels (7 by default) below the 
selected level.

Constant Description
75



Chapter 2 • Dashboard Top View
Expand to problem Collapses the branches where CIs do not have 
Critical or Major statuses.

For example, in the End User Locations view, Default 
Client_SanityBPM support is red. 

Right-click Default Client_SanityBPM and select the 
Expand to problem option, to get more information 
about the problem by displaying lower levels of the 
view and by collapsing non-problematic branches.

Open in new window Opens a pop-up window that contains the page 
accessed by the specified URL. This is useful to open 
external applications. By default, this option does 
not appear in the menu.

Set/Unset 
Acknowledgment

Enables you to set or clear the CI acknowledgment. 
For details, see “Acknowledge Performance 
Problems” on page 36.

View in Console Displays the CI’s branch in the Console tab.

Menu Option Description
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Customize the Layout of the Hierarchy in Top View

You can customize the layout of the hierarchy in the Top View page. By 
default, the parent CI is displayed above the child CIs and the child CIs are 
close to the bottom part of the Top View tab.

To customize the layout of the hierarchy, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and locate the Top View Graph Layout entry in the 
Top View Properties area. Select the type of layout (listed below in 
alphabetical order).

Type of Layout Description

BOTTOM Default. The parent CI is above the child CIs and is 
centered on the page. 

LEFT The child CIs are to the left of the parent CI and the 
parent CI is centered on the page. 
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RADIAL The second level of the tree is distributed around 
the parent and the parent is centered on the page.

RIGHT The child CIs are to the right of the parent CI and 
the parent CI is centered on the page. 

Type of Layout Description
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Note: The change takes place immediately.

Changing the KPI Status Icons

You can use different status icons. For details, see “Change the KPI Status 
Icons” in CI Attribute Customization.

View Chinese or Japanese Characters in Top View

To view Chinese or Japanese characters in Top View, install the Chinese or 
Japanese packages. For details, see “Working in Non-English Locales” in 
Reference Information.

TOP The parent CI is under the child CIs and is centered 
on the page. 

Type of Layout Description
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Change Fonts in Top View

To change the font displayed in Top View for all locales, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, choose 
Applications, select Dashboard Application, and locate the Top View Font 
Name entry in the Top View Properties table. Enter the appropriate font 
name in the Value box. This change is performed during the next log in.

Change the Number of CI Levels Displayed in Top View

By default, the Top View tab displays four levels of CIs. The rest of the CIs 
are collapsed. You can then expand a CI at the fourth level and see its 
children.

To modify the number of levels displayed when you open the Top View tab, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
choose Applications, select Dashboard Application, and locate the Top View 
Number of Levels entry in the Dashboard Application - Top View Properties 
table. Modify the value. Valid values are 2 to 100. This change is performed 
during the next log in. If you select 2, the name of the view and the top 
level CIs are displayed.

Change the Number of CI Levels That Can Be Expanded in 
Top View

To change the default setting for the number of levels of CIs that are 
displayed when you select the Expand more levels context menu item, on 
the Infrastructure Settings page, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and locate the Top View expand levels entry in the 
Dashboard Application - Top View Properties table. Modify the value. Valid 
values are 2 to 12. This change is performed during the next log in.
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Hide or Display the View Bar in Top View When the View 
has a Single Root CI

You can select to hide or display the view bar in the Top View tab, when the 
view has a single root CI. 

To hide or display the view bar in Top View when the view has a single root 
CI, select Admin > Platform > Setup and Maintenance > Infrastructure 
Settings, choose Applications, select Dashboard Application, and locate the 
Hide view bar in Top View entry in the Top View Properties table. Set the 
parameter to:

➤ true. The view bar is not displayed as the root of the hierarchy, the root of 
the hierarchy is the single root CI. 

➤ false. The view bar is the root of the hierarchy. 
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Customize the Background Image for Top View

To change the background color or add a background image to the Top View 
tab or to the NOC standalone page, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Applications, and locate in the Dashboard Application - Top 
View table:

➤ Top View Background Color Property. Modify the default value to change 
the color of the Top View tab background or of the NOC standalone page 
background. For example, you can display the Top View tab with a black 
background (#000000).

➤ Top View Background Image. Enter the name of the image you want to use 
as a background image for the Top View tab or the NOC standalone page 
and put the appropriate image in the following location: 
<HP Business Availability Center root 
directory>/AppServer/webapps/site.war/bam/
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This chapter describes the Dashboard Console.

This chapter describes: On page:

Concepts

Understanding the Console Page 84

Service Level Management Results in the Console Page 86

Unavailability Calculation 87

Tasks

Display and Customize View Information in the Console Tab 88

Customization

Modify the Number of Levels Displayed in the Console Tab 90

Display Children Section Expanded 90

Display the Information in Columns 90

Modify the Background Color of the Console Page 91

Add a Details Link to CIs in the Console Page 91
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Understanding the Console Page

The Console page shows the components of the active Dashboard view 
organized into the same hierarchy tree format that you defined for the CIs 
in Dashboard Administration. For details, see “Working with CIs” in 
IT World Model Management. 

The tree is built from group CIs (parents and children) and monitor CIs.

This section includes the following topics:

➤ “KPI Status” on page 84

➤ “CIs” on page 85

➤ “Drill Down” on page 86

KPI Status
The KPI columns for the view (for example, System, Performance, and 
Availability) contain colored indicators representing performance status for 
each CI under that KPI (if the KPI is applicable for the CI). Note that if a KPI 
is relevant for at least one CI in the tree branches currently displayed, then 
that KPI is displayed for all CIs. The KPIs that are not relevant for a 
particular CI display a hyphen (-) meaning that the KPI is not applicable for 
this CI.

For an explanation of the status icons, see “Understanding KPI Status” on 
page 203.
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CIs
The Console tab top level displays the view and the status of the top level 
CIs’ KPIs. The tree pane provides a “snapshot” of tree branches at two 
consecutive levels (configurable default). For example, when you first access 
the view, if there is only one parent, you see the two highest levels: Tours 
Business (parent) and Springfield and Unionville (children).

If there is more than one child, all CIs are shown collapsed when you first 
access the view.

You can expand each CI individually to show its child CIs, or you can use 
the Expand All/Collapse All buttons to expand all CIs in the view (so that 
you see child CIs for all CIs). These buttons are shown only when one or 
more of the currently displayed CIs can be expanded or collapsed.

After a CI is expanded using either of these methods, it remains expanded 
for as long as the browser window is open, even if you move to another 
HP Business Availability Center application.

If you move from another tab to a CI in the Console tree pane (for example, 
by clicking a CI name in the Filters tab, or by selecting an option from a CI 
options menu), then the relevant CI name is shown highlighted in the tree 
(and in the View Explorer), and the CI is shown expanded. However, CIs 
expanded in this way do not retain the setting and are collapsed again when 
you move away from that level of the view.
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Drill Down
To view the CIs two levels down from the current CIs, click a drill-down link 
(linked CI name). CIs are displayed as drill-down links if there is at least one 
level below the CI, or if there is at least a CI with child CIs within the same 
branch. In the previous example, the CIs Springfield and Unionville are shown 
as drill-down links because Tours Business is a CI with child CIs. Click 
Springfield to display the CI’s child CIs. The view of the tree changes; 
Springfield is shown as the parent CI and the level under the selected CI is 
displayed.

The CIs at the new level are by default shown collapsed; however, if the 
displayed level contains only one parent CI, or if you have previously 
expanded CIs, then the child CIs are shown for the relevant CIs.

Service Level Management Results in the Console Page

You can use the Dashboard Console to proactively monitor your service 
level agreements (SLAs). The console displays a PNR KPI bar that enables you 
to see which SLAs are problematic. You can drill down to see which specific 
CI may cause you to breach a service contract. 

Dashboard calculates whether the measurements of an SLA are within the 
limits set out in a service level agreement (as defined in Service Level 
Management). Furthermore, Dashboard calculates whether an SLA is in 
breach of contract, or might be in breach in the near future.

Dashboard displays the results color-coded according to the status of the CI 
(that is, whether the CI is functioning within the SLA’s time constraints). 

For details on attaching a PNR (point of no return) KPI to a CI to view data 
in Dashboard, see “Example–Attaching a PNR KPI to a CI” on page 216.
86



Chapter 3 • Dashboard Console
For details about the tooltip that is displayed when you move the mouse 
over the PNR KPI, see “SLM PNR Rule” in CI Attribute Customization.

Unavailability Calculation

Service level agreements regularly include a clause covering unavailability, 
that is, the period of time that a system may be down. For example, if 
availability must be 98.5%, then a system may be unavailable 1.5% of the 
time. 

The Dashboard PNR Rule (the rule always assigned to the PNR KPI) 
calculates unavailability according to the target availability for the CI (the 
time that the component must be available, according to the SLA). This 
calculation is also based on the measurements for the Service Level 
Management Availability KPI that is attached to the CI when creating the 
SLA.

The following example shows how Dashboard calculates the time a system 
may be unavailable:

If unavailability reaches above this limit, Dashboard changes the status icon 
colors in the SLM tab.

The start of the week is Monday, 8 Aug 05 00:00 AM.
Today is Friday 12 Aug 05 10:15 AM.
The time range is Week to Date.
The time interval is Business Hours, that is, 8:00 AM to 5:00 PM, Monday to Friday.
The time that has passed for this time range is:
4 whole days (Monday to Thursday) = 4 x 9 = 36 hours.
Part of a day (Friday) = 8:00 AM - 10.15 AM = 2.25 hours.
Total time = 38.25 hours.
Availability (as defined in SLA) = 98.5%
Availability, therefore, must be 98.5% x 38.25 = 37.68 hours.
Maximum unavailability = 38.25-37.68 = 0.57 hours.
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Display and Customize View Information in the Console Tab

This section describes the processes for viewing information in the Console 
tab, and gives examples.

This task includes the following steps:

➤ “Select a View and Display a View Information in the Console Page” on 
page 88

➤ “Customize the View Information in the Console Page” on page 88

➤ “Access Additional Information” on page 88

Select a View and Display a View Information in the 
Console Page
The data displayed in the Console tab depends on the view you have 
selected. Select a view and click the Console tab to display the components 
of the active Dashboard view organized into the same hierarchy tree format 
defined for the CIs in Dashboard Administration. The KPIs columns for the 
view (for example, System, Performance, or Availability) contain colored 
indicators representing performance status for each KPI under the CI. For 
details, see “Console Page” on page 262.

Customize the View Information in the Console Page
Customization options are available to filter parts of the hierarchy and to 
deal with acknowledgments. For details about the options, see “Dashboard 
Console” on page 83 under Customization.

Access Additional Information
Access more information by using the context menu options. 

For details, see “Dashboard Menu Options” on page 40.

Example–Find Visible and Hidden Child CIs 

You can display a CI’s visible and hidden child CIs in a specific view. For 
details, see “Visible and Hidden Child CIs” on page 24 and locate the Find 
Visible and Hidden Child CIs section.
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Example–Searching for Views that Include a Specific Child

In View Explorer, click Search to perform a search for the CIs whose names 
include the selected child CI’s name string in all views, and display the 
results in the View Explorer search page.

Click the appropriate CI in the list to display more information about the 
selected CI in the selected view.

If the CI is not visible in any view, in Dashboard, the following message is 
displayed: Search is complete. There are no results to display for the current 
search parameters.

The CI is not visible in any view in the following situations:

➤ It is included in the CMDB but does not belong to any view.

➤ It belongs to a view but the Exclude all child CIs option has been selected 
for its parent CI in that view. For details, see “New CI Wizard” in IT World 
Model Management.
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Modify the Number of Levels Displayed in the Console Tab

To modify the number of levels in the Console tab, select Admin > Platform 
> Setup and Maintenance > Infrastructure Settings, choose Applications, 
select Dashboard Application, and locate the Business Console - Number of 
display levels entry in the Dashboard Layout Properties table. Modify the 
value. Default is 2. If you specify 1 only the parent CIs are displayed.

Display Children Section Expanded

To display the children section expanded when accessing the Console page, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
click Applications context, select Dashboard Application, and change the 
Business Console -Default state in the Dashboard Application - Dashboard 
Layout Properties table to expanded. The default is collapsed. The change is 
performed immediately.

Display the Information in Columns

You can modify the Console tab definition to display columns instead of 
one table.

To display the Console tab in columns, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications context, select 
Dashboard Application, open the Business Console - Number children 
sections in the Dashboard Application - Dashboard Layout Properties table, 
and specify the number of columns you want to display in the Console tab. 
The default is 1. You can select a number between 1 and 3. The change is 
performed immediately.
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Modify the Background Color of the Console Page

To modify the background color of the Console tab, edit the /* added for 
bam */ section of the stylesheet used by the Dashboard Console tab located 
at
<HP Business Availability Center root directory>/AppServer/
webapps/siet.war/static/act/stylesheets/Properties.css. 

It is recommended to backup the original stylesheet before making any 
changes. 

Add a Details Link to CIs in the Console Page

To add a Details link for every CI in the tab, select Admin > Platform > Setup 
and Maintenance > Infrastructure Settings, choose Applications, select 
Dashboard Application, and in the Dashboard Application - Dashboard 
Layout Properties table, modify the Show element CMDB details link in UI 
entry. Default is false. For details, see “Node Details Dialog Box” on 
page 289.
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4
Dashboard Filters

This chapter describes the Dashboard Filters.

About the Filters Tab

The Filters tab enables you to view operational status for specific segments 
or components of your business. The Filters tab displays (in a flat 
non-hierarchical way) the configuration items (CIs) that match the 
following criteria: they belong to the selected view, and at least one of their 
Key Performance Indicators (KPIs) has the status specified in the active filter.

This chapter describes: On page:

Concepts

About the Filters Tab 96

Tasks

Display and Customize a View Information in Filters 96

Search for Specific CIs and Filter the Results 97

Create or Customize an Active Filter 101

Create a Temporary Filter Using Quick Filter 103

Customization

Add a Details Link to CIs in the Filters Page 105
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This section includes the following topics:

➤ Access Additional Information

➤ Visibility Levels

Access Additional Information
Access more information by using the context menu options. For details, see 
“Dashboard Menu Options” on page 40.

Visibility Levels
The visibility levels you can select when defining a filter include:

Visibility Level Filter Description

Global Global filters are predefined and built-in. They 
are available for all customer users. They 
cannot be modified. You can use them as 
templates to build public or private active 
filters. Their names have the following syntax: 
global:<name>. They appear in the list of 
active filters as gray text strings. For a list of 
global active filters, see “Predefined Filters” on 
page 273.

Public Administrators or users with the appropriate 
permissions can build public active filters. 
Those filters are available for all users at the 
specific customer. You can use the global active 
filters as templates to build public active filters. 
Their names have the following syntax: 
public:<name>. They appear in the list of 
active filters as black text strings.
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Private Users can build their own private active filters. 
Those filters are available only to the user who 
created them. You can use the global and 
public active filters as templates to build 
private active filters. Their names have the 
following syntax: private:<name>. They 
appear in the list of active filters as black text 
strings.

For each user name used when logging on to 
HP Business Availability Center, Dashboard 
creates an associated filters file. When you log 
on to HP Business Availability Center using a 
specific user name, you can only view and 
modify the filters contained in the associated 
filters file. The file is updated with the filter 
modifications made by each user who logs in 
under this user name, so any changes you 
make to the filters may overwrite 
modifications made by previous users.

Temporary Another type of private active filter. These 
filters are created when you select statuses in 
the Quick Filter and click Apply or when you 
use the Filter subtree - Monitors only option in 
a CI context menu. The name of the 
temporary filter is temp: Quick Filter. For 
details, see “Create a Temporary Filter Using 
Quick Filter” on page 103. You cannot save 
temporary filters.

Visibility Level Filter Description
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Note: 

➤ If more than one user is logged in at the same time using the same user 
name (for example, admin), then every time one of the users saves a 
change to the filters, the associated filters file is updated with a copy of 
that user’s filters. 

➤ The information displayed in the Filters tab is not refreshed while the 
Defining/Editing Filters dialog box is open. (This also applies when the 
Defining/Editing Filters dialog box is not in focus.)

Display and Customize a View Information in Filters

This section describes the processes for displaying and customizing a view 
information in the Filters tab, and gives examples.

This task includes the following steps:

➤ “Select a View in View Explorer” on page 96

➤ “Set the Active Filters” on page 96

➤ “Customize the View Information in the Filters Page” on page 97

Select a View in View Explorer
The data displayed in the Filters tab depends on the view you have selected. 
For details, see “Filters Page” on page 275.

Set the Active Filters
You use the Active Filters capability to create filters that enable you to filter 
the CIs displayed in the Filters tab, enabling you to focus on the specific 
view, on specific CI types or statuses, or on problematic areas. For details, see 
“Filters Page” on page 275.

You can also create a new active filter. For details, see “Create or Customize 
an Active Filter” on page 101.
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Customize the View Information in the Filters Page
Customization options are available to filter parts of the hierarchy and to 
deal with acknowledgments. For details about the options, see “Dashboard 
Filters” on page 93 and locate Customization.

Search for Specific CIs and Filter the Results

You can search for a specific CI using the View Explorer search function to 
filter the list of CIs that HP Business Availability Center displays. For more 
details about the Search feature, see “View Explorer User Interface” in 
Reference Information.

You can locate CIs by their name, by related CIs, by their CITs, in the 
current view, or in all views. If, in addition to using the Search feature in 
View Explorer, you display the Filters tab in the right pane of the 
Dashboard, the resulting filtered report displays only the CIs that have been 
located by the search filtered by the selected filter in the Filters tab. 

For details, see “Filters Page” on page 275.
97



Chapter 4 • Dashboard Filters
Example–Searching for CIs in the Current View

You can search for CIs in the current view by name, related CIs, or CITs.

The result is a list of all of the CIs corresponding to the search criteria listed 
in View Explorer. The Filters tab displays a filtered list of the CIs and the CI’s 
children CIs corresponding to the search criteria filtered by the active filter 
and the current operational status in each KPI for each of the CIs. 
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If the search result is a single CI, or if you click one of the CIs in the results 
of the search list, the Filters tab displays the selected CI and its child CIs 
filtered by the active filter, and the current operational status in each KPI for 
each of the CIs.
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Example–Searching for CIs in More Than One View

You can search for CIs in all views by name, related CIs, or their CITs.

The result is a list of all of the CIs and the views that include them, 
corresponding to the search criteria listed in View Explorer. The Filters tab 
displays a filtered list of the CIs corresponding to the search criteria, filtered 
by the active filter and the current operational status in each KPI for each of 
the CIs. 
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You can click a specific CI in the results of the search list to display in the 
Filters tab a filtered list of the CIs corresponding to the search criteria and to 
the selected view, filtered by the active filter and the current operational 
status in each KPI for each one of those CIs.

Create or Customize an Active Filter

Active Filters enable you to focus on a specific view, CI type or status, or 
problematic areas.

The currently active filter is displayed in the Active Filters box in the Filters 
tab. You can select a different filter from the Active Filters list.

The Active Filters list contains the Dashboard predefined filters (shown as 
gray text strings) and any additional filters you defined (shown as black text 
strings). 
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To define or customize filters, access the Filters tab, and select one of the 
following options:

➤ To define a completely new filter, click New. The Defining/Editing Filters 
Page opens. 

➤ To use an existing filter as the basis for the new filter, select the filter name 
in the Select a filter list and then click Save As. The Filter Name dialog box 
opens, where you can specify a name for the filter you are creating. You are 
then returned to the Defining/Editing Filters Page.

For details, see “Filters Page” on page 275.

Example

The private:Custom Filter filters for Application KPIs and DT Failed Impact 
KPIs with the OK status.
102



Chapter 4 • Dashboard Filters
Create a Temporary Filter Using Quick Filter

Quick Filter enables you to display CIs whose KPIs have one of the selected 
statuses. The filter is a temporary filter that persists until you log off, change 
its selection of statuses, or select another filter.

After you select a combination of filters to display a view’s data, you can 
further refine the report by selecting specific KPI’s statuses. The displayed 
CIs have at least one KPI with one of the selected statuses.

For details, see “Filters Page” on page 275.

Note: You cannot save the settings you selected in Quick Filter, but you can 
create a similar filter using Active Filter. For details, see “Defining/Editing 
Filters Dialog Box” on page 271.
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Example

The global:Show All report includes the following data:

To display only the CIs whose KPIs have OK and/or Critical statuses, select 
those statuses in the Quick Filter bar and click Apply.
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The following filtered report is displayed:

Add a Details Link to CIs in the Filters Page

To add a Details link for every CI in the Filters page, select Admin > Platform 
> Setup and Maintenance > Infrastructure Settings, choose Applications, 
select Dashboard Application, and in the Dashboard Application - 
Dashboard Layout Properties table, modify the Show element CMDB details 
link in UI entry. Default is false. For details, see “Node Details Dialog Box” on 
page 289.
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Geographical Map

This chapter describes the Dashboard Geographical Map.

This chapter describes: On page:

Concepts

Understanding Geographical Maps 108

Location Status Information 109

Understanding Google Earth 110

Understanding Virtual Earth 111

Understanding the Maps Applet 112

Tasks

Display and Customize a View in Geographical Map 112

Display a Geographical Map With Google Earth 118

Create a Geographical Map for an Unavailable Zoom Level of a 
Specific Area

122

General Reference

City Names Format 122

Setup Requirements for the Map Applet 123

Customization

Customize Virtual Earth 123

Customize Maps Applet 125
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Understanding Geographical Maps 

In Dashboard, you can associate a geographical map with a view. If you have 
specified locations for the view’s CIs, real-time status indicators representing 
the CIs statuses are displayed on the map at those geographical locations. 

The location is defined individually for group or leaf (monitor) CIs in a view. 
You can specify the CI location when you define a new CI or when you edit 
a CI’s properties. For details, see “Properties Tab” in IT World Model 
Management. You can also specify geographical locations for end-user groups 
in “New/Edit End-User Group” in Using End User Management. If you do not 
specify a geographical location for at least one CI in the view, the 
Geographical Map tab displays only the map.

Each status indicator in the map can represent one or more CIs from the 
view with the same location. If you select a CI in View Explorer, the 
geographical map is redisplayed automatically and shows only the selected 
CI and the CI’s children status indicators if a location is specified for them. 
If you select another view, the geographical map reloads automatically to 
show the view’s CI status indicators in the appropriate locations.

If you search for a specific CI in View Explorer and you click the result of the 
search, the geographical map is not automatically redisplayed. The map is 
redisplayed only when you go back to browser mode. It shows only the 
selected CI and the CI’s children status indicators if a location is specified for 
them.

To determine a location status, Dashboard takes the worst KPI status for all 
KPIs attached to all the CIs assigned to that location and determines an 
overall worst status. 

In Dashboard Administration, in the geographical map, you can shift the 
map’s focus and enlarge or shrink the map to fit the view it represents. 
When you save the changes, the modified map is automatically displayed 
when you select the view in the Geographical Map tab in Dashboard. For 
details, see “Geographical Map Page” on page 282. 

If you have an Internet connection, geographical maps can be displayed 
using Virtual Earth. For details, see “Understanding Virtual Earth” on 
page 111. 
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If you do not have an Internet connection, geographical maps can be 
displayed using a maps applet. For details, see “Understanding the Maps 
Applet” on page 112.

Note: The Virtual Earth map is only available in English and cannot be 
translated. For localization, use the maps applet. The Maps Applet does not 
display the names of cities or countries.

Location Status Information

The map displays color-coded status indicators that represent the worst KPI 
status for all CIs attached to the location at each geographical location. The 
color coding is the same as for other icons in Dashboard. For more 
information about color coding, see “Understanding KPI Status” on 
page 203.

Geographical Map Tooltips
Tooltips provide the worst status for each KPI associated with the location, 
and how long the KPI has been at that status. A KPI is associated with a 
location if that KPI is assigned to at least one of the CIs attached to the 
location.
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The tooltip includes the following information:

Understanding Google Earth

Note to HP Managed Software Solutions users: This feature is not available 
when working with HP Managed Software Solutions.

You can view the geographical map information in a three-dimensional map 
using the Google Earth feature. This feature is available only to the 
administrator. 

Note: The integration of CI locations with your Google Earth installation is 
at the beta stage.

Item Description

KPI Name The name of the KPI. The color of the header 
indicates the worst status of the KPI.

Location The name of the location (country, city, and state, if 
applicable).

Status The status of the KPI.

Held status since The time and date when the KPI status changed to 
the current status.

Caused by The names of the CIs/monitors where the problem 
occurred.
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Understanding Virtual Earth

If you have an Internet connection you can display the geographical map 
using Microsoft MSN Virtual Earth. HP Business Availability Center 
integrates Virtual Earth online mapping functionality, available over MSN, 
to enable you to use the geographical map of a view. If the view’s CIs are 
assigned geographical locations, real-time status indicators are displayed on 
the map at those geographical locations. 

Virtual Earth geographical maps are based on Microsoft Network (MSN) 
technology and use dynamic HTML.

The Virtual Earth geographical map presents a flat geopolitical view of the 
planet where you can display the country borders, the geographical features, 
or both.

When you magnify the view, the main cities appear for the part of the map 
that is displayed on the screen.
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Understanding the Maps Applet

The maps applet presents a flat geopolitical view of the planet. 

You can use the maps applet to display the geographical map of a view. The 
map displays the worst status at each geographical location and detailed 
information about the CI’s KPIs.

Display and Customize a View in Geographical Map

This section describes the processes to view real-time status indicators in a 
geographical map, and gives examples.

This task includes the following steps:

➤ “Specify the Hierarchy Structure of the Business Process Monitoring Source 
Adapter” on page 113

➤ “Assign a Geographical Location to the Appropriate CIs” on page 114
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➤ “Select the Display Technology” on page 115

➤ “Assign a Geographical Map to a View” on page 116

➤ “Refine the Geographical Map” on page 117

➤ “View the Geographical Map” on page 118

➤ “Adjust the Displayed Geographical Map” on page 118

Specify the Hierarchy Structure of the Business Process 
Monitoring Source Adapter
The geographical map displays real-time status indicators showing the worst 
status at different geographical locations. To view this information you must 
change the hierarchy structure of the Business Process Monitoring source 
adapter to Transactions/Locations.

Select Admin > Universal CMDB > Modeling > Source Manager, and click 
the Edit button for the Business Process Monitoring source adapter and 
select the Transactions/Locations hierarchy structure.

Example

The Business Process Monitoring source adapter hierarchy is 
Transaction/Location.
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Assign a Geographical Location to the Appropriate CIs
To view the real-time status indicators corresponding to a view’s CI on the 
map, you must assign a geographical location to the relevant CIs in the 
view.

Select Admin > Universal CMDB > Modeling > IT Universe Manager, click 
the CI, enter the country, state, and city information in the Properties dialog 
box, and click Apply. 

Example

The jpetstore CI is located in Paris, France.
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Select the Display Technology
You can display a geographical map using Virtual Earth, a maps applet, or 
Google Earth. You must select the display technology as follows:

➤ Virtual Earth. If you have an Internet connection, use Virtual Earth to 
display the geographical map. To enable Virtual Earth, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, click 
Applications, select Dashboard Applications, and locate the Use Virtual 
Earth entry in the Dashboard Application - Maps Management Properties 
table. Set the property value to true. This is the default. 

➤ Maps Applet. If you do not have access to Internet, use the maps applet to 
display the geographical map. To enable maps applet, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, click 
Applications, select Dashboard Applications, and locate the Use Virtual 
Earth entry in the Dashboard Application - Maps Management Properties 
table. Set the property value to false. 

➤ Google Earth. The Google Earth display technology is available only in 
Dashboard Administration. If you have access to Internet, you can use 
Google Earth to display the geographical map. You must specify that you 
want to display the Export to Google Earth button in the Geographical Map 
tab in Dashboard Administration. To display the Export to Google Earth 
button in the Geographical Map tab in Dashboard Administration, select 
Admin > Platform > Setup and Maintenance > Infrastructure Settings, click 
Applications, select Dashboard Applications, and locate the Enable Export to 
Google Earth button entry in the Dashboard Application - Maps 
Management Properties table. Set the property value to true (false hides the 
Export to Google Earth button).

Note to HP Managed Software Solutions users: The Export to Google Earth 
button is not available when working with HP Managed Software Solutions.
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Assign a Geographical Map to a View
Assign a map to a view by selecting a view in the Geographical Map and 
saving the map.

To assign a geographical map to a view, select Admin > Dashboard, click the 
Geographical Map tab to open the Geographical Map Administration page, 
select the appropriate view in the View list in View Explorer, and click Save.

If you assigned geographical location to a view’s CIs, the corresponding 
status indicators are displayed on the map as soon as you assign a map to 
the view. To assign a geographical location to a view’s CI, select Admin > 
Universal CMDB > Modeling > IT Universe Manager, select the view and the 
CI, and click the Properties tab. Enter the geographical location in the 
Country, State, and City boxes.

Note: To remove CI icons from the map, you must delete their geographical 
location.
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Example

The map shows the status of the jpetstore CI in Paris, France.

Refine the Geographical Map
As an administrator, you can refine the geographical display depending on 
the type of display you have selected using the following possibilities:

➤ Adjust the geographical map using the elements described for each type of 
map. For details, see “Geographical Map Page” on page 282.

➤ Customize the map. For details about Virtual Earth, see “Customize Virtual 
Earth” on page 123. For details about the Map Applet, see “Customize Maps 
Applet” on page 125.

You can save the changes.
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View the Geographical Map
To view the resulting geographical Virtual Earth or maps applet map, click 
Application > Dashboard, select the view in View Explorer, and click the 
Geographical Map tab.

Note: Google Earth is available only in Dashboard Administration and only 
to users with administrative permissions.

Adjust the Displayed Geographical Map
As a user, you can adjust the geographical display in different ways 
depending on the type of display you have selected. The changes cannot be 
saved. For details, see “Geographical Map Page” on page 282.

Display a Geographical Map With Google Earth 

Note to HP Managed Software Solutions users: This feature is not available 
when working with HP Managed Software Solutions.

Note: 

➤ This feature is only available in Dashboard Administration.

➤ The integration of CI locations with your Google Earth installation is at 
the beta stage.

You can view the geographical map information in a three-dimensional map 
using the Google Earth feature. This feature is available only to the 
administrator. This section describes the processes to view status indicators 
in Google Earth.
118



Chapter 5 • Geographical Map
This task includes the following steps:

➤ “Import Location Status into Google Earth” on page 119

➤ “Set the Refresh Rate for the View” on page 120

➤ “View Indicators by Status” on page 121

➤ “View Connecting Lines” on page 121

Import Location Status into Google Earth
You can import the location status information shown in the geographical 
map for the current view into a local Google Earth application. After 
importing the information, Google Earth displays all the CI status indicators 
in the appropriate geographical locations.

To list all the views you create in the same folder, create a new folder (for 
example, an HP Business Availability Center folder) in the Places folder in 
Google Earth, and then add to that folder all the views you create. 

You can create a view in Google Earth by creating a network link using the 
view’s URL. This creates a container folder and a sub-folder.

To import location status into Google Earth: 

 1 If you have not already installed Google Earth on your local computer, open 
the Google Earth site (http://earth.google.com/) and download the 
application.

 2 Open the Google Earth application.

 3 Click the My Places directory in the Places area.

 4 Select Add > Network Link. 

The Google Earth - New Network Link dialog box opens.

 5 Enter the view name in the Name box.
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 6 Copy the URL displayed in the Integration with Google Earth page to the 
Location box.

Note: This URL creates a container folder called by the name you specified 
in the Name box, and a sub-folder called by the name of the view.

 7 If this is the first time you are creating a view in Google Earth, in the Create 
In area, click New Folder and enter HP Business Availability Center to create 
a new folder called HP Business Availability Center.

If the HP Business Availability Center folder already exists in the Create In 
area tree, select the folder (you can also set the cursor on the folder before 
you select Add > Network Link in step 4).

 8 Click OK to close the New Network Link dialog box. 

The Google Earth page displays the HP Business Availability Center folder in 
the Places area. 

Open the HP Business Availability Center directory to list the views you 
have added.

Set the Refresh Rate for the View
You can set the refresh rate of the view sub-folder.

To set the refresh rate for the view: 

 1 Right-click the view sub-folder.

 2 Select Edit.

 3 Select Refresh Parameters to open the Time-Based Refresh area.

 4 In the Time-Based Refresh area, select Periodically from the When list and 
select 1 minute. 

 5 Click OK.
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View Indicators by Status
You can filter the status indicators that are displayed in Google Earth to 
include specific statuses.

To view the indicators by status:

 1 In the Places area, expand the HP Business Availability Center folder.

 2 Select the view you want to display. The folder displays the list of statuses of 
the CIs in the view.

 3 Select one or more of statuses. Only the CIs with the selected statuses are 
displayed in Google Earth.

View Connecting Lines
Different locations are connected with a line when you specify different 
geographical locations for monitor CIs and non-monitor CIs they monitor 
in the view. For example: 
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To view the connecting lines:

 1 In Google Earth, select the view you want to display.

 2 Select Connecting Lines in your view folder to display the connecting lines 
in Google Earth:

If you select Connecting Lines in more than one view, you will see all the 
lines of all the selected views at the same time.

Create a Geographical Map for an Unavailable Zoom Level 
of a Specific Area

If you need a zoom level of a specific area that is not available in 
Geographical Map, create a picture of the map and use the Custom Map 
feature instead.

City Names Format

The city names use UTF8 format. If HP Business Availability Center is 
working with MS-SQL Server, or an Oracle Server that is not configured for 
UTF8 support, non-English characters (for example, é) are displayed as 
empty square brackets [ ].
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Setup Requirements for the Map Applet

The maps applet requires that Sun JRE plug-in 1.4.2_08 or later be installed 
on the client machine. If an earlier version is installed, then HP Business 
Availability Center automatically tries to download JRE 1.4.2_08 when you 
access the maps applet.

Customize Virtual Earth

This section includes customization steps that can be performed to 
configure a Virtual Earth map.

This section includes the following topics:

➤ “Adjust the Virtual Earth Map” on page 123

➤ “Specify the Size of the Indicators” on page 123

➤ “Specify the Statuses to Be Displayed” on page 124

➤ “Specify the Time Delay” on page 124

Adjust the Virtual Earth Map
You can zoom or shift the Virtual Earth map so that it shows the 
information you require. For details, see “Geographical Map Page” on 
page 282.

Specify the Size of the Indicators
You can modify the default size (19 pixels) of the indicators that are 
displayed on the Virtual Earth map.

To modify the size of the indicators, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Applications, and locate the Indicator size in Virtual Earth entry in the 
Dashboard Application - Maps Management Properties table. Enter the size 
(in pixels) of the indicator. Default is 19.
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Specify the Statuses to Be Displayed
You can select the statuses you want to display in the Virtual Earth map.

To specify the statuses to be displayed, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Applications, and locate the Ignore gray statuses entry in the Dashboard 
Application - Maps Management Properties table. Select one of the 
following options:

➤ ALL. Locations with gray statuses (downtime, stopped, no data and 
uninitialized) are not displayed on the map. 

➤ NO. Locations with gray status are displayed on the map.

➤ UNINITIALIZED. Locations with gray statuses (downtime, stopped, and no 
data) are displayed on the map, locations with uninitialized status are not 
displayed.

Specify the Time Delay
You can modify the default time delay between the completion of new 
location download from the server and the display of the information by 
Virtual Earth (in seconds). Use larger values if user has slower connection.

To modify the time delay, select Admin > Platform > Setup and Maintenance 
> Infrastructure Settings, click Applications, select Dashboard Applications, 
and locate the Wait after getting data entry in the Dashboard Application - 
Maps Management Properties table. Enter the delay (in seconds). The 
default is 4. 
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Customize Maps Applet

This section includes customization steps that can be performed to 
configure a maps applet map.

This section includes the following topics:

➤ “Adjust the Maps Applet” on page 125

➤ “Specify the Map Refresh Rate” on page 125

➤ “Specify the Maximum Number of CIs Displayed in a Location’s Tooltip” on 
page 126

Adjust the Maps Applet
You can adjust the maps applet so that it shows the required information. 
For details, see “Geographical Map Page” on page 282.

Specify the Map Refresh Rate
You can modify the default of the map refresh rate. The default is 30 
seconds.

To specify the map refresh rate, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Applications, and locate the Maps Applet Refresh Rate entry in the 
Dashboard Application - Maps Management Properties table. Enter the 
refresh rate.
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Specify the Maximum Number of CIs Displayed in a 
Location’s Tooltip
You can specify the maximum number of CIs that can be displayed in the 
tooltip for a location in the Geographical Map. The default is 10. 

Keep in mind that the CIs are displayed in the Caused by section in the 
tooltip, so do not specify more than can be accommodated.

To specify the maximum number of CIs displayed in a location’s tooltip, 
select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
click Applications, select Dashboard Applications, and locate the Maximum 
CIs in tooltip for location entry in the Dashboard Application - Maps 
Management Properties table. Enter the new maximum.
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Custom Map

This chapter describes the Dashboard Custom Map.

This chapter describes: On page:

Concepts

About Custom Map 128

Tasks

Display a View in a Custom Map 129
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About Custom Map

The Custom Map feature enables you to associate a view’s CIs represented by 
real-time status indicators with a custom image that describes the real world 
that your view represents. The graphical representation of a view used by 
your organization can be a logical network diagram, business logic, or any 
other graphics.

For example, you can associate a graph representing your company’s 
network with real-time data coming from the different parts of the network.

One custom map can be defined for each view. The image shown in the 
Custom Map tab is the one defined for the active view. When you select a 
different view, the corresponding image is automatically displayed in the 
tab. If you do not define a custom map for a view, users accessing the 
Custom Maps tab, when that view is active, see a message stating that there 
is no defined image for the view.

You can create a custom map by adding CI icons from the view and 
associating them with elements of the custom image. The status indicator 
shows the worst status (worst of all KPIs) for that CI.
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Note: When a CI is removed from the IT universe model, the corresponding 
CI icon (in Dashboard Administration) and the corresponding status 
indicators (in Dashboard) are automatically removed from the relevant 
custom maps.

When you place the cursor over the status indicator, a tooltip shows the 
name of the associated CI, and KPI details. For details, see “Custom Map 
Page” on page 267.

When you click a status indicator, the corresponding CI in the View 
Explorer is highlighted. If necessary, the View Explorer automatically 
expands to show the selected CI.

Note: 

➤ The tab displays the image centered in the image pane. If the image is 
larger than the image pane, use the scroll bars. 

➤ When a CI is removed from the IT universe model, the corresponding CI 
icon (in Dashboard Administration) and the corresponding status 
indicators (in Dashboard) are automatically removed from the relevant 
custom maps.

Display a View in a Custom Map

This section describes the processes to view real-time status indicators in a 
custom map, and gives examples.

This task includes the following steps:

➤ “Create a Custom Map for a View” on page 130

➤ “Add CIs to the Custom Map” on page 131
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➤ “Display a View’s Custom Map” on page 132

➤ “Access Additional Information” on page 132

Create a Custom Map for a View
You can create a custom map by selecting a view and attaching the URL of 
the custom image to that view. For details, see “Custom Map Page” on 
page 267.

Any type of image that can be displayed by the browser can be loaded from 
any URL (including HTTP protocol and HTTP authentication). You must 
make sure that the URL is available at all times.

The best image to select depends on the customer’s environment. The 
custom map feature does not resize the image, so in higher resolution 
screens it looks different from the same image in lower resolution screens. 
Additionally, you can view the Custom Map tab with or without View 
Explorer which influences the size of the image you want to display.

Example

You want to use a picture of your network to display the status of each 
element in the network:
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Add CIs to the Custom Map
You can add CI icon(s) to the image, to create an association between the 
image and the view. Select the CI in View Explorer, and click Add CI Icon. 
The CI icon is displayed in the left top corner of the diagram with a blue 
outline. Drag the CI to the required location in the diagram. The CI icon is 
set at that position.

For details, see “Custom Map Page” on page 267.

Example

You add the appropriate CI to the custom map:
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Display a View’s Custom Map
After you complete the custom map, display it in Dashboard to view the CI’s 
status in the appropriate location in the diagram.

Example

You add the appropriate CI to the custom map:

Access Additional Information
Use the context menu options to access more information. For details, see 
“Dashboard Menu Options” on page 40.
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Topology Map

This chapter describes Dashboard Topology Map.

Understanding the Dashboard Topology Map

The topology map in Dashboard displays the results of a pattern or an 
instance view. You set up the topology map by creating an instance view or 
pattern view in View Manager. For information on those views, see 
“Instance Views and Pattern Views” in IT World Model Management.

The topology map shows the results of the currently selected view in the 
View Explorer, and consists of CIs and relationships that are defined in the 
view you created in View Manager. You can change the way the maps are 
displayed by selecting one of the view layouts (Hierarchical, Symmetric, 
Circular, or Orthogonal). For details, see “Layout Properties Dialog Box” in 
Reference Information.

This chapter describes: On page:

Concepts

Understanding the Dashboard Topology Map 133

Tooltips 136

Tasks

Display and Customize a View Information in the Topology Map 136

Customization

Customizing a View’s Layout 137
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For details about the Topology Map, see “Topology Map Page” on page 290.

This section includes the following topics:

➤ “Select Multiple CIs” on page 134

➤ “Navigate Between Different Map Levels” on page 134

➤ “View the Selected CI in the Console Page” on page 135

Select Multiple CIs
In the topology map, you can select multiple CIs by holding down the CTRL 
button and clicking the CIs or dragging the mouse diagonally along the CIs. 
The result is shown in the following figure:

If you select multiple CIs, only one CI has a black selection rectangle around 
it, while all of the other selected CIs have red selection rectangles around 
them. In this situation, when you right-click anywhere on the map to open 
the context menu, the option is performed only on the CI surrounded by 
the black rectangle.

Navigate Between Different Map Levels
An icon with a downward arrow indicates that there is an additional CI 
layer beneath it, created by a parent or child organization rule defined in 
View Manager (in a pattern view). For information on how to set up 
organization rules, see “Adding Folding Rules to Relationships” in IT World 
Model Management.
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For example, if the IP CI is defined as a child of the host CI in View 
Manager, you can double-click any host icon in the topology map to display 
a map of IPs connected with that host.

To drill down to the lower level(s), double-click an icon with a downward 
arrow.

To move up one level in the topology map, select a CI that has an additional 
CI layer above it, and click the Up layer button. The Up layer button is 
enabled only if there is an additional CI layer above it, created by a parent or 
child organization rule defined in View Manager.

The icon that represents each CI in the topology map is defined by the 
administrator in CI Type Manager. For information on how to assign an 
icon to a CIT, see “Icon Page” in CI Attribute Customization.

The colors displayed for a CI icon represent the worst status of all KPIs for 
the CI, apart from Change. For information on status levels, see 
“Understanding KPI Status” on page 203.

View the Selected CI in the Console Page
You can view the selected CI and its direct child CIs in the Console page. 

To view the selected CI and its direct child CIs in the Console page, right-
click the required CI and select Open in Console. The Console page opens 
and displays the selected CI and its direct child CIs. For details about the 
Console page, see “Console Page” on page 262.
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Tooltips

When you point to a relationship in the topology map, a tooltip is displayed 
that contains the relationship CI type of the selected relationship as defined 
in CI Type Manager. For details, see “CI Type Manager” in CI Attribute 
Customization.

When you point to a CI in the topology map, a tooltip is displayed 
containing information about the CI, as seen below. 

Display and Customize a View Information in the Topology 
Map

You can display and customize a view’s topology map.

This task includes the following steps:

➤ “Select a View in View Explorer” on page 137

➤ “Customize the View Information in the Filters Page” on page 137
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Select a View in View Explorer
To view the results of an instance view or a pattern view defined in View 
Manager in the Topology Map, access the Topology Map. For details, see 
“Topology Map Page” on page 290.

Customize the View Information in the Filters Page
Customization options are available to filter parts of the hierarchy and to 
deal with acknowledgments. For details, see “Topology Map” on page 133 
under Customization.

Customizing a View’s Layout

Display the contents of the topology map using different layout options. For 
details, see “Layout Properties User Interface” in Reference Information.
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Dashboard Reports 

This chapter describes the Dashboard reports.

This chapter describes: On page:

Concepts

Report Repository 142

Working with Dashboard Reports 142

Understanding the KPIs Over Time Report 143

Understanding the Related Change Requests Report 154

Understanding Deep Transaction Tracing Integration in Dashboard 155

General Notes 163

Tasks

View Deep Transaction Tracing Information in Dashboard 163

Install and Deploy the Deep Transaction Tracing Package 167

Activate Deep Transaction Tracing in HP TransactionVision 168

View KPIs Over Time Information 170

View Related Change Requests Reports 172

View Service Impact Report 172
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Report Repository

The Report Repository page displays all reports previously saved in 
Dashboard, Service Level Management, and End User Management (Triage 
report only). For details, see “Report Repository” in Custom Reporting and 
Alerting.

Working with Dashboard Reports

The Dashboard reports are:

➤ KPIs Summary. Displays a summary of KPI status distribution over time for each 
selected KPI. For details, see “KPIs Summary Report” on page 308.

➤ KPIs Trend. Enables you to analyze the trend for changes in KPI status over time, for 
selected statuses. For details, see “KPIs Trend Report” on page 311.

➤ KPIs Distribution Over Time. Enables you to analyze KPI trend by viewing KPI 
status distribution over time for selected statuses. For details, see “KPIs 
Distribution Over Time Report” on page 300.

➤ KPIs Over Time report. Displays the status or value, over time, of selected 
CIs and KPIs that are accessible from the Dashboard application. For details, 
see “KPIs Over Time Report” on page 303.

The Report Repository displays a list of reports saved to the report 
repository. For details, see “Report Repository” in Custom Reporting and 
Alerting.

You can print the generated report, send the report by e-mail, open the 
report in different formats, publish the report in different formats, or save 
the report to the report repository. For details, see “About Working in 
Reports” in Reference Information.
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Note: 

➤ Data is displayed in a report starting from the point that data was 
collected for the selected CIs. For example, if you set the report to show 
data every week for the past month, but data was collected only for the 
past two weeks, the report shows data from two weeks ago to the present 
date.

➤ The KPI Summary, KPI Trend, and KPI Distribution Over Time reports are 
generated only for CIs of type Application, Business Process, Business 
Service, and Line of Business; in addition, the CIs must be flagged to save 
KPI data over time (historical data). For details, see “Persistent Data and 
Historical Data” on page 214. (Contact Customer Support if you need to 
change the supported CITs.)

➤ HP Business Availability Center records in a reports log errors that occur 
when generating reports. The reports log can also include the following 
activities: creating a new report, generating a report, modifying the 
report filter(s), drilling down in reports, and so on. For details about the 
reports log, see “Reports Log” in Platform Administration.

➤ HP Business Availability Center enables you to generate Dashboard 
reports automatically, and to specify a header and a footer for those 
reports. For details, see “Customizing Reports” in Platform Administration.

Understanding the KPIs Over Time Report

KPIs Over Time reports show the status or value, over time, of selected CIs 
and KPIs that are accessible from the Dashboard application. The report is 
also accessible from View Explorer.

The report includes filtering (by CI, KPI, and time). It can be displayed as a 
table or a chart.
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For example, when you encounter a problem with a specific CI while 
viewing the Dashboard, and the Performance and Availability KPIs are 
attached to that CI, you can view the KPIs Over Time report of that CI’s 
Performance and Availability. You can also receive a daily report showing all 
CIs statuses in the past day.

You can also add a KPIs Over Time report to a custom report. For details, see 
“Customizing Reports” in Custom Reporting and Alerting.

You can also schedule when to run the report. For details, see “Scheduling 
User Reports or the Performance Update Report” in Platform Administration.

The report is designed to provide information about the KPIs of higher level 
CIs; for example, Business Services, Application, Business Processes CIs, and 
so on. It is not designed to provide information about the KPIs of monitor 
CIs. To obtain similar information about the KPIs of monitor CIs, see “Real 
User Monitor Reports User Interface” in Using End User Management, “Alerts 
and Reports” in Using System Availability Management, or “Trend Report 
Manager” in Custom Reporting and Alerting.

The report displays data only for CIs whose KPIs are persistent. For details, 
see “Persistent Data and Historical Data” on page 214.

Status Information or Value Information
You can select to display data about either status-based KPIs or value-based 
KPIs. To reflect these capabilities, two types of KPIs Over Time reports are 
available:

➤ Reports that display status information. For details, see “KPIs Over Time 
Reports with Status Data” on page 145. To display such information, the 
KPIs must be persistent. For more details, see “Persistent Data and Historical 
Data” on page 214.

➤ Reports that display value information. For details, see “KPIs Over Time 
Reports with Value Data” on page 151.
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KPIs Over Time reports display the status or value of each CI and each 
instance of the attached KPIs. For example, when you select one CI with the 
Availability and Performance KPIs, and one CI with the Availability KPI the 
report has only three rows:

The statuses are shown over time, starting with the event and ending with 
the next event. 

KPIs Over Time Reports with Status Data
If you select the Statuses option when you generate a KPIs Over Time report, 
the report displays only the status of the relevant KPIs. Those KPIs may also 
have values in the HP Universal CMDB but the status report does not show 
those values.

The reports can be displayed in graph or table format.

For details, see “KPIs Over Time Reports with Status Data” on page 145.

You can drill down to the following information items:

➤ A specific segment of the time period. For details, see “Drilling Down by 
Time Segments in Status KPIs Over Time Reports” on page 147.

➤ Status information about the children that contribute to the status of the 
selected CI’s KPI. For details, see “Drilling Down to Influencing Children in 
KPIs Over Time Reports with Status Data” on page 148.

➤ Status information about the parents of the CI whose status is influenced by 
the status of the selected CI’s KPI. For details, see “Drilling Up to Influenced 
Parents in KPIs Over Time Reports with Status Data” on page 149.

CI KPI

First Availability

Second Availability

Performance
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Tooltips are shown for each status. The background of the tooltip reflects 
the color of the status according to the KPI’s objectives.

 

This section includes the following topics:

➤ “Drilling Down by Time Segments in Status KPIs Over Time Reports” on 
page 147

➤ “Drilling Down to Influencing Children in KPIs Over Time Reports with 
Status Data” on page 148

➤ “Drilling Up to Influenced Parents in KPIs Over Time Reports with Status 
Data” on page 149
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Drilling Down by Time Segments in Status KPIs Over Time 
Reports

Click any time segment in the graph time footer to drill down (zoom) on all 
of the CI and KPI information for that period of time. The time segment you 
zoom on is split into four equal parts that can also be zoomed until each 
time segment is one minute long.

The From date and time of the segment you select becomes the From date 
and time of the whole time footer and the To date and time of the segment 
you select become the To date and time of the whole time footer.

For example, if the time period you selected is from 7/13/05 8:51 AM till 
7/13/05 4:44 PM, the time footer is split into four equal segments as follows:

If you drill down on the first segment of the time footer, the From date and 
time of that segment is 7/13/05 8:51 AM, and its To date and time is what is 
indicated under the second tick of the time footer: 7/13/05 11:29 AM.

The drilled down report time From and To fields display those dates and 
times, and the time footer of the report displays this period of time split into 
four equal parts: (11:29-8:51)/4=39 mn. The first part starts at 8:51 AM, and 
ends at 8:51+:39=9:30, the second part starts at 9:30 and ends at 
9:30+:39=10:09, and so on.
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Drilling Down to Influencing Children in KPIs Over Time 
Reports with Status Data

Click the Drill to influencing children button  for a specific CI’s KPI to 
display status information about the children that contribute to the status 
of the CI’s KPI.

Note: You can drill down to influencing children or drill up to influenced 
parents only when the CIs have persistent data.

For example, the view has the following hierarchy:

If you drill down the app_world_2 CI and the Performance KPI, the 
information that is displayed is the status of all of the Performance KPIs for 
all of the children of the app_world_2 CI that have a Performance KPI and of 
the parent itself. 

Note: Drill down to the level of the monitor CI is unavailable as there is no 
calculated status for those CIs and only raw data is available. To obtain 
similar information about the KPIs of monitor CIs, see “Real User Monitor 
Reports User Interface” in Using End User Management, “Alerts and Reports” 
in Using System Availability Management, or “Trend Report Manager” in 
Custom Reporting and Alerting.
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If you click the Drill to influencing children button for the app_world_2 CI 
and the Performance KPI in the following graph:

Then the drilled down report displays the status of all of the Performance 
KPIs for all of the children of the app_world_2 CI that have a Performance 
KPI, as follows:

If the selected CI and KPI do not have influencing children, then the report 
displays the message: No influencing children found.

Drilling Up to Influenced Parents in KPIs Over Time Reports 
with Status Data

Click the Drill to influenced parents button for a specific CI’s KPI to display 
status information about the parents of the CI whose status is influenced by 
the status of the selected CI’s KPI. A CI may have more than one parent but 
the parent CIs that are displayed in the report are the parent CIs that are 
part of the view.

Note: You can drill down to influencing children or drill up to influenced 
parents only when the CIs have persistent data.
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For example, if you drill up to influenced parents for the trx_weekly_plan CI 
and the Availability KPI, the information that is displayed is the status of all 
of the Availability KPIs for all of the parent(s) of the trx_weekly_plan CI and 
of the influencing child.

The report about the status of trx_weekly_plan CI displays information about 
the Availability and Performance KPIs, as follows:

If you drill down to influenced parents for the Availability KPI, the report 
displays the status of the Availability KPI for the app_world_2 CI (parent of 
trx_weekly_plan CI), as follows:

If the selected CI and KPI do not have influenced parents, then the report 
displays the message: No influenced parents found.
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Note: The number of lines that can be displayed in the table is not limited. 
This might slow performance when displaying the table; in such cases it is 
recommended to limit the time period or the number of CIs and KPIs you 
want to display.

KPIs Over Time Reports with Value Data
If you select the View Value over Time option when you generate a KPIs over 
Time report, the report displays only the values of the relevant KPIs. Those 
KPIs may also have statuses in CMDB but the value report does not show 
those statuses.

Reports of this type are relevant for KPIs with business rules that calculate 
meaningful values, such as rules for calculating percentage, volume, 
financial impact, or Real User Monitor values. 

You can select the number of sampling points in the Every boxes.

The report can be displayed as a graph or as a table.

You can drill down each point in the graph to display the data in the period 
of time that corresponds to your selection. For example, if you have selected 
to display information every day for the past week, then drilling down on 
one point displays the detailed information for every hour of the selected 
day, and then drilling down on one hour displays the detailed information 
for 5 minutes intervals in the hour, and so on down to a minute interval.

Drilling Down to HP Diagnostics 
If HP Diagnostics is enabled, you can drill down to HP Diagnostics views from 
the KPIs Over Time report for Business Process Step CIs in the End User 
Monitors View, and for the Diagnostics Probe Group, and Diagnostics Probe 
CIs in the Diagnostics View. 

By default, if HP Diagnostics is enabled, the Application KPI is automatically 
added to all relevant CIs in the CMDB. The relevant CIs are the logical CIs. 
For details, see the HP Diagnostics User’s Guide.
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The following table displays the Diagnostics drill down options for CIs in 
KPIs Over Time reports:

For example, in the End Users View, click the down arrow to the right of a 
Business Process Step CI and select one of the following options:

The HP Diagnostics views accessed via the context menu options that are 
available from the KPIs Over Time report are as follows:

➤ Summary View. This option is available for all Diagnostics Probe CIs. This 
option is displayed only if you have installed Diagnostics. 

This option opens the Probe Summary View in the HP Diagnostics 
application, for the probe group and for the time frame specified in the View 
box in the KPIs Over Time report. 

For more information about Diagnostics, see the HP Diagnostics User’s Guide.

➤ Layers View. This option is available for all Business Process Monitor, and 
Diagnostics Probe CIs. This option is displayed only if you have installed 
Diagnostics. 

CI Type Diagnostics drilldown options

Diagnostics Probe Group ➤ Summary View (Probe Group Summary)

➤ Layers View (Load)

Diagnostics Probe ➤ Summary View (Probe Summary)

➤ Layers View (Load)

Business Process Step ➤ Transactions View

➤ Layers View
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The Layers (Load) view displays the performance metrics for the Diagnostics 
layers where processing has taken place in your application, for the 
transaction that corresponds to the Business Process Monitor CI or for the 
selected Probe CI and for the time frame specified in the View box in the 
KPIs Over Time report. 

For more information about Diagnostics, see the HP Diagnostics User’s Guide.

➤ Transactions View. This option is available for all Business Process Step CI. 
This option is displayed only if you have installed Diagnostics. 

The Transactions view displays performance metrics for the transactions 
that are being executed by your applications, with the transaction 
corresponding to the Business Process Step CI highlighted, and for the time 
frame specified in the View box in the KPIs Over Time report. For more 
information about Diagnostics, see the HP Diagnostics User’s Guide.

The context menu options that are available from the KPIs Over Time report 
are a subset of the Drill to Diagnostics options available in Dashboard. For 
details, see “Drilling Down to HP Diagnostics” on page 151.

Notes and Tips

➤ The context menu of all CIs except for monitors CIs includes the KPIs Over 
Time Report option. The report displays data only for CIs whose KPIs are 
persistent. For details, see “Persistent Data and Historical Data” on page 214.

➤ Saving historical data for long periods of time or for many CIs and KPIs can 
require a lot of database memory, so this option should be used with care. 
When you no longer require data to be saved for a CI, clear the Save 
historical data for this CI check box for that CI.

➤ The number of lines that can be displayed in the table is not limited. This 
might slow performance when displaying the table; in such cases it is 
recommended to limit the time period or the number of CIs and KPIs you 
want to display.
153



Chapter 8 • Dashboard Reports
Understanding the Related Change Requests Report

If you are working with Change Control Management, HP Business 
Availability Center provides an option that enables you to view the impact 
of IT changes submitted to the service desk. You can view this information 
in a Related Change Requests report, opened in Dashboard for a specific CI.

The Related Change Requests report shows all change requests in the system 
that have direct or indirect impact on the selected CI. It is generated by 
Change Control Management, and provides a direct link to the original 
change request.

You can view the report at any time to check the change requests in the 
system for a CI. When a CI is registering a problem, by showing a status 
other than OK, you can use the report to determine if the problem is due to 
a submitted change, before beginning more extensive research into the 
problem.

To enable the integration and view the report in Dashboard, you must set up 
the environment, and configure settings in HP Business Availability Center. 
For details, see “View Related Change Requests Reports” on page 172.

Viewing the Related Change Requests Report for a CI
The Related Change Requests report is opened from the context menu for a 
CI in Dashboard. 

The Related Change Requests report lists all change requests that impacted 
on the CI during the default time period. The list may include change 
requests that resulted in a direct change to the CI (a CCI), or that affected 
the CI as a result of a modification to the change request (an ACI).

For information on the parameters in the report, see “Related Change 
Requests Report” on page 314.
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Understanding Deep Transaction Tracing Integration in 
Dashboard

Deep Transaction Tracing provides a monitoring layer for collecting 
information about the behavior of Business Process Monitor transactions 
within the target machine, achieved through integration with 
HP TransactionVision application. The resulting information is displayed in 
the Deep Transaction Tracing view in Dashboard.

Deep Transaction Tracing enables component level breakdown for your 
Business Process Monitor transactions. This is achieved through integration 
with HP TransactionVision application, to provide an additional level of 
business process monitoring in HP Business Availability Center. 

HP TransactionVision technology enables monitoring of a transaction at the 
component level within a target machine. As the transaction flows through 
the target machine via CICS, JMS, EJBs, servlets, and WebSphere MQ, 
HP TransactionVision tracks and analyzes the interaction with each 
component. 

HP TransactionVision sends the data on the transaction’s path through the 
monitored components to HP Business Availability Center; in HP Business 
Availability Center, the received data is mapped to a Deep Transaction 
Tracing monitor that is correlated with the appropriate Business Process 
Monitor transaction. In Dashboard, you can then see availability and 
performance information for the transaction within the target machine, and 
you can open breakdown reports for the transaction at component level. 

This section includes the following topics:

➤ “Deep Transaction Tracing Architecture” on page 156

➤ “Deep Transaction Tracing View” on page 157

➤ “Deep Transaction Tracing Reports” on page 159
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Deep Transaction Tracing Architecture
The following diagram illustrates the path of the Deep Transaction Tracing 
data: 

When Business Process Monitor runs a script (transaction monitor), the 
transactions in the script performs specific tasks in the components of the 
target (external) machine. The Deep Transaction Tracing feature tracks the 
behavior of the transactions as they flow through the target machine via 
each component. 

The HP TransactionVision sensors collect data on transaction traffic inside 
the target machine while the transaction is running, and pass it to the 
analyzer service (the logic engine), installed on a server that is running the 
WebSphere application. The analyzer performs calculation and analysis of 
the data.
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A data sample containing information about the behavior of the 
transactions inside each component of the target machine is sent to 
HP Business Availability Center using the Extensible Data Representation 
(XDR) format. The samples are caught on the HP Business Availability 
Center bus by a special Dynamic Node Factory, and are used to create new 
Deep Transaction Tracing Monitor CIs, and to set KPI status for the CIs.

Deep Transaction Tracing View
You can view Deep Transaction Tracing information for transactions in 
Dashboard in the Deep Transaction Tracing View.

Note: The Deep Transaction Tracing View is added to the Views list in View 
Explorer after the Deep Transaction Tracing package is installed. If the view 
is not in the Views list, contact your administrator. 

The Deep Transaction Tracing View is displayed like any other view in 
Dashboard. The view contains all Business Process CI types (such as Business 
Process Group, Business Process Step, Business Process Transaction from 
Location), and in addition contains all Deep Transaction Tracing Monitor 
CIs. Its structure is as follows:

The Deep Transaction Tracing Monitor CIs in the view are dynamically 
created by a Dynamic Node Factory, based on the incoming samples from 
HP TransactionVision. Each Deep Transaction Tracing Monitor CI is given 
the same name as the Business Process Monitor transaction it relates to, and 
is added to the hierarchy under the relevant Business Process Step CI, using 
its own icon.

The Deep Transaction Tracing View is displayed like any other view in 
Dashboard. The view contains all Business Process CI types (such as Business 
Process Group, Business Process Step, Business Process Transaction from 
Location), and in addition contains all Deep Transaction Tracing Monitor 
CIs. 
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The Deep Transaction Tracing View structure is as follows:

Under the Business Process Step, you can see information on both the 
emulated user experience (as shown for the BPM Transaction from Location 
CIs) and on how the transaction behaved in the target server (as shown for 
the Deep Transaction Tracing Monitor CI).

The KPIs for the Deep Transaction Tracing Monitor are:

➤ Performance

➤ Availability

➤ DT Total Impact

➤ DT Failed Impact

➤ DT Late Impact
158



Chapter 8 • Dashboard Reports
For details, see “List of Dashboard KPIs and Their Details” in CI Attribute 
Customization.

Deep Transaction Tracing Reports
From the Deep Transaction Tracing view, you can access reports in the 
HP TransactionVision application that provide you with breakdown 
information for the transaction at component level. 

The reports are opened from the menu options for a Deep Transaction 
Tracing Monitor CI in the Console and Filters tabs: Select Deep Transaction 
Tracing Reports, then select the required report type from the displayed list. 
HP TransactionVision opens in a new browser dialog box, displaying the 
selected report for the relevant transaction.

For HP Business Availability Center to open the reports, you must configure 
the URL to point to the HP TransactionVision machine, and the required 
user name and password. For more information, see “Configure Access 
Parameters to the HP TransactionVision Server” on page 165.

Note: Your Web browser should be set to accept all cookies when working 
with HP Business Availability Center. If this is not done, you might 
encounter problems when drilling down to the HP TransactionVision 
reports.

This section includes the following topics:

➤ “Tracking Report” on page 159

➤ “Service Level Report” on page 161

➤ “Component Topology Report” on page 162

Tracking Report

The Tracking Report menu option opens the Transaction Tracking Report, 
which lists information for every instance (run) of the Business Process 
Monitor transaction over a specified time period. The displayed information 
includes start time, response time, and the result of the run.
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To see a more detailed breakdown of behavior on the target machine for a 
run of the transaction, click the Tx Class link to drill down to the 
Transaction Details report; from there, click an event link to drill down to an 
event details report.

For more detailed information on the report and on how to set viewing 
options, see the HP TransactionVision documentation, available from the 
Help menu in the HP TransactionVision application.
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Service Level Report

The Service Level Report menu option opens the Service Level Analysis 
report, which provides a graphical view of response time for the transaction 
over time. The displayed information includes average response time, 
maximum response time, and transaction volume over each reporting time 
period.

For more detailed information on the report and on how to set viewing 
options, see the HP TransactionVision documentation, available from the 
Help menu in the HP TransactionVision application.
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Note: You need Adobe SVG Viewer 3 installed on your local machine to see 
the Service Level Analysis report. Download from the Adobe Web site 
http://www.adobe.com/svg/viewer/install/main.html.

Component Topology Report

The Component Topology menu option opens the RTM report, which 
displays a top view map for the flow of information across components in 
the target machine, over a specified time period. The report shows activity 
for all components on the machine during the time period, not for any 
individual transaction. The report also displays statistics on the interaction 
between components (for example, failed, late, and total counts for events).

For more detailed information on the report and on how to set viewing 
options, see the HP TransactionVision documentation, available from the 
Help menu in the HP TransactionVision application.
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General Notes

➤ HP Business Availability Center records, in a reports log, errors that occur 
when generating reports. The reports log can also include information about 
the following activities: creating a new report, generating a report, 
modifying the report filter(s), drilling down in reports, and so on. For details 
about the reports log, see “Reports Log” in Platform Administration.

➤ HP Business Availability Center enables you to generate Dashboard reports 
automatically, and to specify a header and a footer for those reports. For 
details, see “Customizing Reports” in Platform Administration.

View Deep Transaction Tracing Information in Dashboard

To view Deep Transaction Tracing data in HP Business Availability Center, 
you install HP TransactionVision, and deploy the Deep Transaction Tracing 
package.

In addition, you must configure the URL, user name, and password to open 
the Deep Transaction Tracing reports. The reports are opened from the Deep 
Transaction Tracing context menu, used with Deep Transaction Tracing 
Monitor CIs in Dashboard. The menu contains options to open the 
following dynamic reports in HP TransactionVision for the selected 
transaction:

➤ Tracking Report

➤ Service Level Report

➤ Component Topology Report

The following steps describe the process used to integrate with 
HP TransactionVision in order to view Deep Transaction Tracing 
information in Dashboard. 
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Note: 

➤ Your Web browser should be set to accept all cookies when working with 
HP Business Availability Center. If this is not done, you may encounter 
problems when drilling down to the HP TransactionVision reports.

➤ You need Adobe SVG Viewer 3 installed on your local machine to see the 
Service Level Analysis report. Download from the Adobe Web site 
http://www.adobe.com/svg/viewer/install/main.html.

This task includes the following steps:

➤ “Install Business Process Monitor and Define Profiles to Run Transactions” 
on page 164

➤ “Deploy HP TransactionVision” on page 165

➤ “Deploy the Deep Transaction Tracing Package” on page 165

➤ “Configure Access Parameters to the HP TransactionVision Server” on 
page 165

➤ “Set Up Mapping Between HP TransactionVision data and Business Process 
Monitor Data” on page 166

➤ “Activate Deep Transaction Tracing in HP TransactionVision” on page 166

➤ “View Deep Transaction Tracing Information in Dashboard” on page 166

Install Business Process Monitor and Define Profiles to 
Run Transactions
To view Deep Transaction Tracing Information in Dashboard, you must 
create Business Process profiles and define the profiles to run transactions.

For details, see “Creating Business Process Profiles” in Using End User 
Management.
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Deploy HP TransactionVision
Install HP TransactionVision on a separate machine from HP Business 
Availability Center. 

For installation instructions and system requirements, see the 
HP TransactionVision documentation.

Deploy the Deep Transaction Tracing Package
HP TransactionVision is installed on a separate machine in your 
environment, and the Deep Transaction Tracing package is installed on the 
HP Business Availability Center to integrate the HP TransactionVision data 
into HP Business Availability Center.

For details, see “Install and Deploy the Deep Transaction Tracing Package” 
on page 167..

Configure Access Parameters to the HP TransactionVision 
Server
To open the HP TransactionVision reports from Dashboard, the URL, user 
name, and password to access the HP TransactionVision machine must be 
configured in HP Business Availability Center. This is done on the 
Infrastructure Settings page.

To configure the HP TransactionVision access parameters, select Admin > 
Platform > Setup and Maintenance > Infrastructure Settings, choose 
Applications, select Dashboard Applications, and in the 
HP TransactionVision table, locate:

➤ The HP TransactionVision Machine Base URL entry, and enter the URL for 
the HP TransactionVision machine. Include the full domain or host name 
and the port. For example:
http://<HP TransactionVision host name>:9080/

➤ The User name for HP TransactionVision login parameter, and enter the 
required user name (default is Admin).

➤ The User password for HP TransactionVision login parameter and enter the 
required password (default is Admin).
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Set Up Mapping Between HP TransactionVision data and 
Business Process Monitor Data
To view Deep Transaction Tracing data correlated with Business Process 
transactions in Dashboard, a link must be made between the two. This is 
done in End User Management Administration by enabling the breakdown 
data flag for a transaction monitor, so creating a mapping for the 
transaction monitor to the HP TransactionVision application.

As a result of this mapping, when the Deep Transaction Tracing View is 
displayed in Dashboard, you can see each Deep Transaction Tracing CI 
(created from the incoming HP TransactionVision samples) alongside the 
corresponding BPM Transaction from Location CI. For an example of the 
view structure, see “View Deep Transaction Tracing Information in 
Dashboard” on page 163.

To enable Deep Transaction Tracing for a Transaction Monitor, select Admin 
> Monitors, and in the Monitors tab, right-click the required transaction 
monitor, and select Edit. In the right pane, expand the Transactions 
Breakdown Settings area. Select Enable diagnostics breakdowns and click 
OK.

Activate Deep Transaction Tracing in 
HP TransactionVision
In the HP TransactionVision application, you must activate the Mercury 
BAC job by pointing to the HP Business Availability Center server and 
starting the job. You must also configure the transactions on the 
HP TransactionVision side. 

For details, see “Activate Deep Transaction Tracing in HP TransactionVision” 
on page 168.

View Deep Transaction Tracing Information in Dashboard
You can view Deep Transaction Tracing information for transactions in 
Dashboard in the Deep Transaction Tracing View. For details, see 
“Understanding Deep Transaction Tracing Integration in Dashboard” on 
page 155.
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Note: The Deep Transaction Tracing View is added to the Views list in View 
Explorer after the Deep Transaction Tracing package is installed. If the view 
is not in the Views list, contact your administrator. 

Install and Deploy the Deep Transaction Tracing Package

HP TransactionVision is installed on a separate machine in your 
environment, and the Deep Transaction Tracing package is installed on the 
HP Business Availability Center to integrate the HP TransactionVision data 
into HP Business Availability Center.

Installing the Deep Transaction Tracing package creates:

➤ The Deep Transaction Tracing view. For details, see “Understanding Deep 
Transaction Tracing Integration in Dashboard” on page 155.

➤ The Deep Transaction Tracing Monitor CIT in the CMDB.

➤ The Dynamic Node Factory that creates Deep Transaction Tracing CIs from 
the incoming samples.

To deploy the Deep Transaction Tracing package:

 1 Install HP TransactionVision application on a separate machine, using 
WebSphere as the application server. For installation instructions and 
system requirements, see the HP TransactionVision documentation.

 2 On the HP Business Availability Center Data Processing Server, copy the 
DeepTransactionTracing.zip file from:

<HP Business Availability Center server root 
directory>\mam_lib\packages_extension

to:

<HP Business Availability Center server root directory>\mam_lib\packages
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Deploy the Deep Transaction Tracing package using the JMX console. 
Follow the instructions for deploying HP Business Availability Center 
packages. For details, see “Package Manager Window” in IT World Model 
Management.

Activate Deep Transaction Tracing in HP TransactionVision

In the HP TransactionVision application, you must activate the Mercury 
BAC job by pointing to the HP Business Availability Center server and 
starting the job. You must also configure the transactions on the 
HP TransactionVision side. 

After activating the job and configuring transactions, HP TransactionVision 
sends samples for Deep Transaction Tracing to HP Business Availability 
Center.

To activate Deep Transaction Tracing in HP TransactionVision:

 1 Log into HP TransactionVision. In the top menu, select Current Project > 
Job Status. The Job Status page opens. Click the Mercury BAC link.
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 2 The Edit Job page opens. In the Startup Parameters (optional) box enter:
- BAC <HP Business Availability Center Gateway Server host name>. 
For example: -BAC mymachine

 3 Click Finish.

 4 On the Job Status page, click the Start Job button to start the Mercury BAC 
job. For each transaction monitor set for Deep Transaction Tracing in 
HP Business Availability Center, you must configure the equivalent 
transaction on HP TransactionVision (you need the exact name of the 
transaction monitor). For details, see the HP TransactionVision 
documentation.
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View KPIs Over Time Information

The steps below describe the process used to set up to view KPIs over time 
information in Dashboard.

This task includes the following steps:

➤ “Save KPI Status Information for the KPIs Over Time Reports” on page 170

➤ “Access KPIs Over Time Reports” on page 170

➤ “Drill Down to HP Diagnostics” on page 171

➤ “Access KPIs Distribution Over Time Report” on page 171

➤ “Access the KPIs Summary Report” on page 171

➤ “Access the KPIs Trend Report” on page 171

Save KPI Status Information for the KPIs Over Time 
Reports
Persistent data is used to produce KPIs Over Time reports with status 
information, as described in “KPIs Over Time Report” on page 303. Set the 
Save KPI data over time for this CI option to save the calculated 
measurement for each of the CI KPIs, at 15 minute intervals (default value). 
This is done by activating the saveValuesToPersistency global attribute in 
the Rules Repository. For details, see “Persistent Data and Historical Data” 
on page 214.

This option is selected, by default, for Business Services, Applications, 
Business Processes and others. This option is not available for Monitor type 
CIs.

Access KPIs Over Time Reports
You can access the KPIs Over Time reports from different locations in 
HP Business Availability Center.

To access KPIs Over Time report, see “KPIs Over Time Report” on page 303.
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Note: The context menu includes the KPIs Over Time Report option for all 
CIs except for monitors. The report displays data only for CIs whose KPIs are 
persistent. For details, see “Persistent Data and Historical Data” on page 214.

Drill Down to HP Diagnostics 
If HP Diagnostics is enabled, you can drill down to HP Diagnostics views from 
the KPIs Over Time report for Business Process Step CIs in the End User 
Monitors views, and for the Diagnostics Probe Group, and Diagnostics Probe 
CIs in the Diagnostics View. For details, see “Understanding the KPIs Over 
Time Report” on page 143.

Access KPIs Distribution Over Time Report
KPIs Distribution Over Time report enables you to analyze KPI trend by 
viewing KPI status distribution over time for selected statuses. For details, 
see “KPIs Distribution Over Time Report” on page 300.

Access the KPIs Summary Report
KPIs Summary report enables you to view a summary of KPI status 
distribution over time for each selected KPI. For details, see “KPIs Summary 
Report” on page 354.

Access the KPIs Trend Report
KPIs Trend report enables you to analyze the trend for changes in KPI status 
over time, for selected statuses. For details, see “KPIs Trend Report” on 
page 359.
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View Related Change Requests Reports

This section includes describes the steps that must be performed to display 
the Related Change Requests report.

If you are working with Change Control Management, then you have the 
option to view in Dashboard a Related Change Requests report for a CI, 
showing the impact of planned IT changes which have been submitted to 
the service desk. 

To view Related Change Requests reports in Dashboard, you must set up the 
integration environment and configure infrastructure settings, as described 
in the following sections.

This task includes the following steps:

➤ “Follow the Requirements for Integrating with Change Control 
Management” on page 172

➤ “Configure Infrastructure Settings to Work with Change Control 
Management” on page 172

➤ “Display the Related Change Requests Report” on page 174

Follow the Requirements for Integrating with Change 
Control Management
To set up integration with Change Control Management: HP Business 
Availability Center and HP Change Control Management should be working 
with the same CMDB server.

Configure Infrastructure Settings to Work with Change 
Control Management
In order to enable the integration and view the Related Change Requests 
report in Dashboard, you must set up the environment, and configure 
settings in HP Business Availability Center. The Related Change Requests 
context menu option is enabled only if HP Business Availability Center is 
configured to work with Change Control Management. 
172



Chapter 8 • Dashboard Reports
Note: The Related Change Requests option is enabled only if HP Business 
Availability Center is configured to work with Change Control 
Management. For more information, see “Understanding Deep Transaction 
Tracing Integration in Dashboard” on page 155.

To view change request information in Dashboard, select Admin > Platform 
> Setup and Maintenance > Infrastructure Settings, choose Applications, 
select Dashboard Application, and locate the Active entry in the Change 
Control Management Integration Settings table. 

➤ Set the CCM Integration Status property to True.

➤ In the CCM Web Service address property, define the address of the server 
where Change Control Management is installed.

➤ In the CCM Statuses property, define the change request statuses used in 
Change Control Management that you want to include in the Related 
Change Requests reports. By default, HP Business Availability Center is 
configured to use the CLOSED and IN_PROGRESS statuses.

You can change the default statuses or add additional ones, as long as you 
use the definition used in Change Control Management (<Change Control 
Management root directory>\conf\enumeration-labels.properties). For 
example, the value StatusEnum.ASSIGNED=Assigned should be entered in 
the CCM Statuses property as ASSIGNED.

➤ In the CCM Username and CCM Password properties, enter the details of a 
user that exists in Change Control Management. The defaults are username 
admin, with no password.

Note: Restart the Gateway Server for the changes to take effect.
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Display the Related Change Requests Report
If you are working with Change Control Management, then HP Business 
Availability Center provides an option that enables you to view the impact 
of IT changes that have been submitted to the service desk. You view this 
information in a Related Change Requests report, opened in Dashboard for a 
specific CI.

The Related Change Requests report shows all change requests in the system 
that have direct or indirect impact on the selected CI. It is generated by 
Change Control Management, and provides a direct link to the original 
change request.

You can view the report at any time to check the change requests in the 
system for a CI. When a CI is registering a problem, by showing a status 
other than OK, you can use the report to determine if the problem is due to 
a submitted change, before beginning more extensive research into the 
problem.

For more details on the report, see “Related Change Requests Report” on 
page 314.

View Service Impact Report

The Service Impact report displays information about how a CI impacts the 
Business Services it belongs to. Data about the affected Business Service CIs 
includes KPI data, over-time data, and SLA data. For example, if a host CI 
has critical status, you can use the report to display the status of the Business 
Service CIs to which the host CI is attached.

This task includes the following steps:

➤ “Access the Service Impact Report for a CI” on page 175

➤ “Modify the Default KPIs and Rules Used to Display Data in Service Impact” 
on page 176

➤ “Send a Service Impact Report URL” on page 176
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Access the Service Impact Report for a CI

To view the Service Impact report for a CI, right-click the CI and select the 
Show Service Impact option. For details, see “Service Impact Report” on 
page 368.

Example

The following Service Impact report lists the Business Service CIs impacted 
by the tx_10 CI. It also indicates, in the Service Details area, the status of the 
KPIs, the current and forecasting statuses of the SLAs that include the 
Business Service CI selected in the Business Services Summary table.
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Modify the Default KPIs and Rules Used to Display Data in 
Service Impact
You can modify the default KPIs and rules from which the system derives 
the parameters needed to get the data displayed in Service Impact (for 
example, from the Number of Open Incidents Rule the system derives the 
state and severity of tickets to be counted in the over time number of open 
incidents). If you change the KPI or rule to be used in the Service Impact 
report, you must configure the new KPI Id in Infrastructure Settings.

To modify the settings, select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select Dashboard Application, 
and locate the relevant entries in the Dashboard Application - Service 
Impact table. Modify the value of the following parameters:

➤ Number of Open Incidents KPI. Sets the Id number of the KPI that defines 
open incidents in the report. The default is 2600 for the Open Incidents KPI.

➤ Number of open Incidents Rule. Sets the Id number of the rule that defines 
open incidents in the report. The default is 2600 for the Open Incidents 
rule.

➤ Number of Users' Sessions KPI. Sets the Id number of the KPI that defines 
the number of user sessions in the report. The default is 1050 for the Volume 
KPI. 

➤ Number of Users' Sessions KPI's caption. Defines the caption in the report 
for the Number of Users' Sessions KPI. 

Send a Service Impact Report URL
You can also send a Service Impact report as:

➤ An XML file containing all the relevant data for generating the report in any 
application. The information included in the report can then be used by 
another application, like Change Control Management or HP operation 
applications (Network Node Manager, Service Desk, and so on). 

➤ A URL that accesses the HTML report, included in an alert notification For 
example, if an alert assigned to a host CI is triggered and the alert includes 
the URL of the Service Impact report for the host CI, the user can view 
information about the impact of the host CI on the Business Service CI. For 
details, see “Configure Alert Actions” in Custom Reporting and Alerting.
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To access a Service Impact report from any application, or to send the URL 
of the Service Impact report in an alert notification, use the following URLs:

➤ To display the XML page (no login required):
http://<server_name>/TopazSiteServlet?createSession=true
&requestType=login&directLogin=true&directLoginEncrypted=true
&userlogin=<user_name>&userpassword=<password>
&applicationId=bam&customerId=<customer_id>
&portlet_url=/service-impact/main/xml.do?ciId=<CI_id> 

➤ To access the login page:
http://<server_name>/topaz/login.jsp?portlet_url=/service-
impact/main/page.do?ciId=<CI_id> 

The following parameters are used in the URLs:

➤ <user_name> and <password> are the HP Business Availability Center 
user name and password and must be encrypted according to what 
HP Business Availability Center is using.

➤ <customer_id> is the code of the customer.

➤ <CI_id> is the internal number of the CI. The internal number of a CIT 
appears in the ID box in the Element ID tab in the Node Condition 
dialog box. For details, see “Node/Relationship Condition Dialog Box” in 
Reference Information and locate Element ID Tab.
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KPIs 

This chapter describes how to edit the KPIs attached to a CI, and to attach 
new KPIs or delete KPIs.

This chapter describes: On page:

Concepts

Introducing KPI Configuration 182

How Dashboard KPIs Work 184

About Business Rules 187

No Data Timeout for Transaction CIs 190

KPI Objectives 191

Selectors for KPIs 201

KPIs for User Modes 202

Understanding KPI Status 203

Trend and History 210

Persistent Data and Historical Data 214

Tasks

Configure a KPI 215

Attach KPIs to CIs 220

Edit KPI Properties 221

Set Up the Real-Time Monitoring of CI Property Changes 226

Define Selector Expressions 228
181



Chapter 9 • KPIs
Introducing KPI Configuration

The Dashboard KPIs (Key Performance Indicators) provide quantifiable 
measurements that help you monitor in real-time how well your business is 
achieving its objectives. The KPIs provide real-time status for the CIs 
representing your business and processes, enabling you to assess the 
business impact of problems in the system.

Each KPI works with a predefined set of values, against which the incoming 
metrics are measured. The resulting measurement for the KPI is translated 
into a color-coded status indicator, displayed in the Dashboard Console, 
where the color represents a more desirable or less desirable condition for 
the KPI. You can learn more about KPI functionality in “How Dashboard 
KPIs Work” on page 184.
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CIs can have multiple KPIs attached. KPIs can be attached to a CI as follows: 

➤ KPIs may be attached to the CI as part of the CI creation.

➤ For CIs created by the source adapters in Source Manager, all CIs are 
automatically assigned default KPIs, according to the nature of the CI. 
For example, a CI for a Business Process Monitor profile has default KPIs 
for availability and performance. You can edit a source adapter to define 
additional KPIs that you want added to the created CIs.

For more information on the source adapters and how they define the 
default KPIs, see “Overview of Source Manager” in IT World Model 
Management.

➤ CIs that are added manually or by Discovery Manager do not have 
automatically assigned KPIs. For information on how Discovery Manager 
creates CIs, see “Discovery Overview” in Discovery.

➤ KPIs may be attached to a CI as a result of propagation from child CIs. Most 
KPIs propagate up through the hierarchy, so that parent CIs have the same 
KPIs as all their child CIs.

➤ KPIs may be manually attached to a CI in the Dashboard Administration 
KPIs tab. You may want to attach new KPIs to a CI, in addition to the 
default/propagated KPIs, to broaden the information derived from the 
monitoring measurements. For example, you can add an OT Impact KPI to 
assess the ongoing cost of an application that is not available.

In the KPIs tab, as well as attaching new KPIs to a CI, you can edit existing 
KPIs and delete attached KPIs.
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How Dashboard KPIs Work

HP Business Availability Center provides a selection of predefined KPIs to 
work with Dashboard. The definitions for the KPIs are contained in an XML 
file, which contains the default parameters for creating each KPI instance.

Note: You can edit the KPI definitions, or create customized KPIs, in the KPIs 
Repository, as described in “List of Dashboard KPIs and Their Details” in 
CI Attribute Customization.

Each CI has its own attached KPIs (that define what is being monitored for 
that specific CI). Each attached KPI generally defines:

➤ The business rule (for example, Performance rule) to be used with the 
collected metrics, to calculate a measurement for the KPI.

➤ The source for the metrics to be used for the KPI: either from data samples 
(for monitoring CIs), or from other KPIs. In the latter case, the KPI metrics 
may be taken from the child CIs (when using, for example, the Summary of 
Values rule), or from another KPI attached to the same CI (when using, for 
example, the Impact Over Time rule).

➤ The thresholds (objective values) that the KPI measurement is compared 
against; and the status (color) allocated to the KPI, based on the defined 
thresholds.

➤ Where and how to display the status indicator for the KPI in Dashboard, and 
where to store the KPI measurement.

For most KPI types, the KPIs propagate up to all parent CIs (there are 
exceptions to this, for example, the PNR (Service Level Management) KPI). 
This means that if you attach a KPI, for example, Volume, to a child CI, then 
a Volume KPI is also added to each parent CI for that child, up to the top of 
the subtree.
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Each KPI added by propagation has its own KPI instance definition, with its 
own business rule and properties. For example, the Volume KPI for a child 
CI may use the RUM Page Monitor Volume Rule, while the Volume KPI for 
the parent CI (added by propagation from the child CI) may use the Worst 
Child Rule.

The calculations required by the KPI business rule are made by the Business 
Logic Engine. When a data sample arrives on the bus and is identified (by 
means of the KPI selector) as relevant for a specific monitoring CI, the 
required metrics are passed to the relevant KPI instance for that CI, for 
example, an Availability KPI. At regular intervals (default 15 seconds) the 
Business Logic Engine recalculates the measurement for the KPI using the 
metrics received for the KPI since the last calculation.

If the new measurement causes a change in the status of the KPI, the new 
status is passed to the parent CIs. The Business Logic Engine then 
recalculates the measurement for the corresponding KPI of each parent CI, 
using the new received status information. If the new measurement causes a 
change in the status for that KPI, the new status is again passed up the 
hierarchy to the corresponding KPI instances for the parent CIs, and so on. 

You can change the default Business Logic Engine calculation time interval 
in the Infrastructure Settings page. For details, see “Change the Default 
Business Logic Engine Calculation Time Interval” on page 245.

Notes and Limitations for KPIs and CIs

➤ Any change you make to the KPIs for a CI—adding new KPIs, deleting KPIs, 
or editing KPI properties—changes the CI in the HP Universal CMDB, 
meaning that the changes are seen in any view that includes the CI.

➤ You must create at least one HP Business Availability Center profile database 
for Dashboard to receive data samples. For details, see “Database 
Administration” in Platform Administration.

➤ There are no restrictions on the type of KPI that can be attached to a CI, or 
on the type of business rule that you can select from the allowed rules list 
for a KPI. You must ensure that you select KPIs and business rules that are 
appropriate for the CI type.
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➤ The Application KPI is only applicable for CIs corresponding to 
HP Diagnostics (and is attached automatically to HP Diagnostics CIs when 
HP Diagnostics is supported in HP Business Availability Center). For more 
information, see the HP Diagnostics User’s Guide.

➤ KPIs added to a CI as part of a SLA definition in Service Level Management 
Administration have no relevance to the Dashboard KPIs and do not appear 
in the KPIs tab. Conversely, KPIs added to a CI in the KPIs tab have no 
relevance for the CI when it is included in an SLA, and do not appear for the 
CI in Service Level Management.

➤ Deleting a KPI may impact on other KPIs that are dependent on the first KPI. 
For example, OT Impact is calculated based on the status of another KPI, 
such as Availability; in this case, deleting the Availability KPI would prevent 
calculation of OT Impact. 

➤ KPIs created for CIs by the source adapter templates frequently have 
objective values that differ from the default ones used by the business rule. 
However, when editing one of these KPIs, if you select a different rule and 
then revert to the original rule, then the original objective values are 
replaced with the rule default values.

➤ The Edit KPI for child transactions button is enabled for all KPIs, but:

➤ The option is only relevant Transaction and Availability KPIs (an error 
message is displayed for other KPIs).

➤ The option has validity only when there are Business Process Monitor 
transaction CIs contained in the subtree. 

Changes made in the Edit KPIs for Child Transaction window have no effect 
on KPIs other than Transaction and Availability, or on CIs for which the 
option does not apply.

➤ After applying the Edit KPI for child transactions option, a KPI was saved 
successfully message is displayed in the top-right corner of the page, even if 
no changes were made to any CIs.
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➤ If a transaction CI in the subtree is using a business rule other than the 
default monitor rule for the KPI (Transaction Availability rule or Transaction 
Performance rule), then when you apply the Edit KPI for child transactions 
option, the existing rule is replaced with the default rule.

➤ The Objectives area in the Edit KPIs for Child Transaction window displays 
the default Operator for the rule. When you apply your changes, the 
displayed default operator is updated to all transaction CIs (regardless of 
which operator they were using previously).

About Business Rules

A KPI must always have an associated business rule that defines the logic to 
be performed (by the Business Logic Engine) to calculate the measurement 
for the KPI. The properties and objectives that are assigned to the KPI 
depend on the selected rule. 

HP Business Availability Center provides predefined rules for use with the 
KPIs. The rules are defined in the Business Rules Repository, where you can 
edit the rules, or create customized rules. For information on the business 
rules available in Dashboard, the roles they play, and how to edit them, see 
“List of Dashboard Business Rules” in CI Attribute Customization.

Some business rules are specific to a particular KPI, while others can be used 
for a variety of KPIs. In the KPIs Repository, each KPI has a defined default 
rule, and a list of rules that can be used with that KPI. (If required, the 
default rule and the allowed rule list can be modified.)

When a CI is created by the source adapters in Source Manager, it is assigned 
KPIs and business rules according to the adapter definitions. When a KPI is 
added manually to a CI in the KPIs tab, it is assigned the default business 
rule defined for the KPI (the default rule is usually a rule for groups). For 
example, for the RT Impact KPI, there are two applicable rules: Real Time 
Impact Rule and Sum of Values Rule. When you add a new RT Impact KPI to 
a CI, the default rule for the KPI, Sum of Values Rule, is automatically 
assigned. You can change the assigned rule when adding or editing the KPI 
in the KPIs tab, by selecting a new rule from the list of allowed rules for the 
KPI. 
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There are two categories of business rule, monitor rules and group rules, as 
described in the following sections. Most KPIs work with at least one rule 
from each category. 

This section includes the following topics:

➤ “Monitor Rules” on page 188

➤ “Group Rules” on page 189

Monitor Rules
Monitor rules (also called leaf rules) are business rules that are applied to leaf 
CIs of monitor type. Monitor rules are used to calculate a measurement for 
the KPI based on original sample data that is caught by the KPI selector. For 
example, the Availability Rule calculates the Availability KPI for BPM 
Transaction from Location CIs, based on the sample data received from 
Business Process Monitor.

A monitoring CI is intended to receive incoming metrics, generally received 
via one of the data collector, such as SiteScope, Business Process Monitor, or 
Real User Monitor. Monitoring CIs are automatically added to the 
HP Universal CMDB by the source adapters in Source Manager, according to 
the monitoring definitions. These monitoring CIs have default KPIs that use 
a monitor rule, and predefined selector.

In general, the leaf CIs in a subtree (the CIs that form the lowest level of the 
hierarchy) should always be one of the monitoring CIs. When creating new 
subtrees in your views in IT Universe Manager, you attach monitoring CIs 
created by the source adapters as leaf nodes, and these CIs then pass KPI 
status up the hierarchy.
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Group Rules
Group rules are business rules that determine KPI status based on data 
received from other KPIs, rather than from original sample data. The 
received data can come from the KPIs of child CIs, or from another KPI 
associated with the same CI.

Note: Even though this category are called group rules, some of them are also 
applicable for monitoring/leaf level CIs. For example, the Impact Over Time 
Rule (used with the OT Impact KPI) can be used with a group CI or a 
monitoring CI. What all rules in this category have in common is that their 
status calculations are contingent on data received from other KPI instances, 
rather than from the samples.

The group rules vary in the type of logic they use to arrive at a status result. 
For example:

➤ The rule may select a KPI status held by one of the child CIs, and apply that 
status to the parent, as done by the Worst Child Rule.

➤ The rule may aggregate the received data to calculate a measurement, and 
compare the measurement with defined objectives, as done by the Sum of 
Values Rule.

➤ The rule may calculate a measurement based on the status of another KPI for 
the CI, and compare the measurement with defined objectives, as done by 
the Real Time Impact Rule when receiving status from the Availability KPI.
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No Data Timeout for Transaction CIs

When a KPI is using a monitor rule (for example, the Transaction 
Availability Rule), the Business Rule Parameters area includes the No data 
timeout property. This property defines the number of seconds from the 
time the last sample was received for the KPI, until the KPI is timed out—at 
which point the KPI changes to decay status (gray). 

The default value for the No data timeout property is generally taken from 
the monitor rule definitions (as defined in the Business Rules Repository). 
However, for Business Process Monitor transaction CIs, Dashboard calculates 
a new No data timeout value, based on the schedule for running the 
transaction. The calculation takes the schedule interval (defined in End User 
Management Administration) for the business process profile that contains 
the transaction (default value = 15 minutes) and adds an additional 90 
seconds. For example, for a transaction with a schedule interval of 15 
minutes, the No data timeout value is 990 seconds. (For details on defining 
the profile schedule, see “About Managing Business Process Profiles” in 
Using End User Management.) 

This calculation method means that the timeout value is automatically 
adjusted to align with changes made to the profile schedule interval in End 
User Management Administration, so that the KPI is not incorrectly timed 
out. If there is more than one scheduling scheme in effect, the following 
rules are used for the calculation:

➤ If multiple schedules are defined for a profile running on a Business Process 
Monitor instance, the largest schedule interval is used (all schedules are 
treated equally, whether they apply to the whole week or part of the week).

➤ If the profile is assigned to several locations, each with a different schedule, 
then smallest interval from amongst the locations is used (after first 
applying the rule above).
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KPI Objectives

The KPI objectives define the standards for allocating business status to the 
KPI.

The following sections describe objectives and how to define them for a KPI.

➤ “About Status and Objectives” on page 191

➤ “Defining Logical Objectives” on page 194

➤ “Excluding Statuses” on page 195

➤ “Units of Measurement for Objectives” on page 198

➤ “Example of Defining Objectives” on page 200

About Status and Objectives
The status displayed for a KPI in Dashboard provides an indication of how 
well a business process or system is meeting your business objectives. Based 
on traffic light colors (with additions), the Dashboard shows you if the KPI 
measurement is meeting the objective requirements (green), or is critically 
failing (red), or is at some business risk level between the two. 

Five statuses are available in Dashboard (for active status), each representing 
a different level of business performance:

➤ OK (green)

➤ Warning (olive)

➤ Minor (yellow)

➤ Major (orange)

➤ Critical (red)

Depending on the CI and KPI types, active status may be represented in 
Dashboard using from two to all five of these status levels. In most cases 
(not for SiteScope measurements), the KPI is assigned a status as follows:

➤ The business rule calculates a measurement for the KPI.

➤ The calculated measurement is compared with defined objective values. 
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➤ The KPI is assigned a status according to where the measurement falls 
within the objectives. For example, a KPI measurement of 50% may fall 
within the definition for the Minor objective, so the KPI is assigned Minor 
status (yellow).

The objective values used for each KPI can originate from various sources:

➤ The business rule definitions in the Business Rules Repository provide 
default objective values for every rule that uses objectives. The business rules 
generally define different objective values for each of the five statuses used 
in Dashboard. You can define new default objective values for a business 
rule, as described in “Rule Details Dialog Box” in CI Attribute Customization.

➤ The source adapter may specify specific objective values to be used with the 
business rule for a KPI. These values override the values from the Business 
Rule Repository. You can modify the template for a source adapter to define 
custom objective values, as described in “Modify an Adapter Template” in 
IT World Model Management.

➤ The source adapter may specify reference values for the objective 
parameters, so that the objective values are taken from the threshold values 
defined in End User Management Administration. These values override the 
values from the Business Rule Repository.

➤ You can modify the objective values for an individual KPI in the Dashboard 
Administration KPIs tab, while adding or editing a KPI. The new values 
override values from the source adapter or from the business rule. For 
details, see “No Data Timeout for Transaction CIs” on page 190. 

SiteScope Monitoring CIs

For SiteScope monitoring CIs, KPI status is based on the status received from 
SiteScope (calculated according to the thresholds defined in SiteScope). 
Three status levels are used in Dashboard: 

➤ OK (green) in Dashboard corresponds to Good or OK status in SiteScope

➤ Minor (yellow) in Dashboard corresponds to Warning status in SiteScope

➤ Critical (red) in Dashboard corresponds to Error status in SiteScope

The SiteScope status definitions cannot be changed in Dashboard, so the 
business rules for SiteScope KPIs do not include objective values.
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End User Monitoring CIs 

For end user monitoring CIs (from Business Process Monitor, Real User 
Monitor), KPI status is calculated by comparing the KPI measurement with 
objective values.

➤ For Business Process Monitor transaction CIs, the KPI objective values are 
either taken from End User Management Administration or the rule 
definition: 

➤ For CIs using the Transaction Performance Rule (ID# 13), the Business 
Process Monitoring source adapter references the transaction thresholds 
defined for the corresponding monitoring object in End User 
Management Administration. The threshold values map to KPI objective 
values for three status levels in Dashboard: OK, Minor, and Critical.

➤ For CIs using the Transaction Availability Rule (ID# 5), KPI objectives are 
taken from the default values for the rule in the Business Rules 
Repository. The rule defines objective values for all five status levels in 
Dashboard.

➤ For Real User Monitor monitoring CIs, depending on the rule used, the KPI 
objective values are taken from the Real User Monitor source adapter, End 
User Management Administration, or the rule definition. For example:

➤ For RUM Application Error Monitor CIs using the RUM Event Monitor 
Volume Rule (ID# 73), the objective values are defined directly in the 
source adapter. The objective values defined for this rule use four of the 
Dashboard status levels: OK, Warning, Minor, and Critical.

➤ For RUM Page Monitor CIs using the RUM Page Monitor Availability Rule 
(ID# 49), the source adapter references the Availability threshold defined 
in End User Management Administration for the page. This is a single 
value, so two status levels are used in Dashboard: OK and Critical.

➤ For RUM Sessions Monitor CIs using the RUM Session Monitor 
Availability Rule (ID# 52), the source adapter does not define objective 
values, so KPI objectives are taken from the default values for the rule in 
the Business Rules Repository. The rule defines objective values for three 
Dashboard status levels: OK, Minor, and Critical.
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For all end user monitoring CIs, you can edit the objective values in the KPIs 
tab to use as many of the status levels as you require, as described in 
“Defining Logical Objectives” on page 194.

Warning: KPIs created for CIs by the source adapter templates, frequently 
have objective values that differ from the default ones used by the business 
rule. However, when editing one of these KPIs in the KPIs tab, if you select a 
different rule and then revert to the original rule, the original objective 
values are replaced with the rule default values.

Defining Logical Objectives
The objectives values for a KPI should cover the whole spectrum of possible 
measurements for that KPI. (This means active measurements, the objectives 
do not take into consideration the values given to a KPI for no data, 
downtime, and so on.) 

The KPI measurement is evaluated against each objective level, starting from 
OK (green), and continuing (in order) to Critical (red). This process stops at 
the first objective level into which the KPI measurement fits. 

To define where the boundaries of each objective level falls, each objective 
from OK to Major is associated with an Operator. (The Critical objective 
definition is always Otherwise, meaning that this status is applied to all 
measurements that fall beyond the Major objective limit.) You can select the 
operator that matches your requirements; the same operator is applied to all 
objective levels.

The available operators are:

> 
>=
<
<=
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You must make sure that the objectives contain logical values (according to 
the data type) and are correctly ordered, and that the operator is logical for 
the order. For example:

➤ If you enter descending objective values, such as 70, 55, 40, 20, you must use 
operator > or >=, so that the OK objective covers all measurements greater 
than 70. 
For a KPI measurement of 88: 88 >= 70 is true, so assigned status is OK.
For a KPI measurement of 18: evaluation of the KPI measurement against 
every objective is false, so status falls into the Otherwise category and be 
assigned status Critical.

➤ If you enter ascending objective values, such as 10, 25, 35, 40, you must use 
operator < or <=, so that the OK objective covers all measurements less 
than 10.
For a KPI measurement of 7: 7 <= 10 is true, so assigned status is OK.
For a KPI measurement of 50: evaluation of the KPI measurement against 
every objective is false, so status falls into the Otherwise category and be 
assigned status Critical.

Excluding Statuses
Not all the statuses need be used for a KPI; for example, the OT Impact KPI 
by default uses only OK (green) and Critical (red) status. There are two 
methods used in Dashboard to exclude statuses, as described in the 
following sections.
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Blank Objective Value

When the objective value for a status is left blank, Dashboard ignores that 
status during KPI status calculation. For example, the Performance KPI for a 
transaction may have the following objectives defined (taken from the 
threshold settings for the transaction in End User Management 
Administration):

In this case, if the measurement for the KPI does not fall into the OK 
objective level, then Warning is skipped and the measurement is evaluated 
against the Minor objective level. If it does not fall into that level, Major is 
also skipped, and the KPI is assigned Critical status.

If you want to exclude statuses when editing the objective values for a KPI, it 
is recommended that you use this method.

Repeated Objective Value

Dashboard allocates status by starting at OK status, and evaluating the KPI 
measurement against each objective level until the right level is found. 
When an objective value is repeated for two or more statuses, the repeat 
occurrences are passed over and those statuses are not used. 
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For example, the Availability KPI for a RUM page monitor may have the 
following objectives defined (by using the Availability threshold setting in 
End User Management Administration for all four defined objective values):

In this case, if the measurement for the KPI is greater or equal to 98%, then 
it is given OK status. If it is less than 98%, then evaluation against the 
Warning, Minor, and Major statuses also does not give any result and these 
statuses are not used; the KPI is then assigned Critical status.

Example of Defining Objectives

A specific transaction monitor CI is using the Transaction Performance Rule. 
For this transaction, the required objectives are as follows:

➤ The objective for acceptable performance time is under 6000 milliseconds. 
An average performance time that reaches 6000 milliseconds is already of 
concern.

➤ Performance time of 8000 milliseconds is considered seriously problematic.

➤ Performance time of 10000 milliseconds is considered critical.

In addition, Warning status is not required for this KPI.
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In the Edit KPI window for the transaction’s Performance KPI, the objective 
levels and operator are modified as follows:

When a measurement is calculated for the KPI from the incoming 
performance data, the measurement is compared with the objectives 
assigned to the KPI as follows:

➤ For a measurement under 6000 milliseconds, status = OK

➤ For a measurement of 6000 milliseconds or more, but under 8000 
milliseconds, status = Minor

➤ For a measurement of 8000 milliseconds or more, but under 10000 
milliseconds, status = Major

➤ For a measurement of 10000 milliseconds or more, status = Critical

Units of Measurement for Objectives
The objectives use a unit of measurement, shown after the objective value 
box in the KPI Objectives area:
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The unit is part of the business rule definition, and indicates the format of 
the calculated measurement. This format may reflect the units used by the 
incoming data (for example, milliseconds for performance time data), or it 
may be a new format applied as a result of the business rule calculations (for 
example, dollars for a financial loss calculation). If required, the default unit 
for a rule can be changed in the rule definition (as described in “Rule Details 
Dialog Box” in CI Attribute Customization).

The following default units are used (listed alphabetically):

Default Unit Description

<No unit> is displayed after the objective value box for 
business rules that handle volume, where the KPI 
measurement represents a simple numerical count. 
For example, this is the case for the RUM 
Transaction Monitor Volume Rule.

Financial ($) This unit is used for business rules that determine 
financial loss for a CI, for example, the Impact Over 
Time Rule.

Milliseconds or Seconds This unit is used for business rules that handle 
performance time data for a transaction or monitor, 
for example, the Transaction Performance Rule or 
RUM Page Monitor Performance Rule.

Percentage (%) This unit is used for business rules that handle 
availability over time data for a transaction, for 
example, the Transaction Availability Rule, and for 
the PNR Rule, where the KPI measurement 
represents percentage of time remaining for CI 
unavailability before the SLA is in breach of 
contract.
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Example of Defining Objectives
A specific transaction monitor CI is using the Transaction Performance Rule. 
For this transaction, the required objectives are as follows:

➤ The objective for acceptable performance time is under 6000 milliseconds. 
An average performance time that reaches 6000 milliseconds is already of 
concern.

➤ Performance time of 8000 milliseconds is considered seriously problematic.

➤ Performance time of 10000 milliseconds is considered critical.

In addition, Warning status is not required for this KPI.

In the Edit KPI window for the transaction’s Performance KPI, the objective 
levels and operator are modified as follows:

When a measurement is calculated for the KPI from the incoming 
performance data, the measurement is compared with the objectives 
assigned to the KPI as follows:

➤ For a measurement under 6000 milliseconds, status = OK

➤ For a measurement of 6000 milliseconds or more, but under 8000 
milliseconds, status = Minor

➤ For a measurement of 8000 milliseconds or more, but under 10000 
milliseconds, status = Major

➤ For a measurement of 10000 milliseconds or more, status = Critical
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Selectors for KPIs

When a monitoring (leaf) CI has a KPI and associated business rule that are 
intended to be applied to actual data samples, the KPI properties include a 
selector. A selector is a filter definition that defines which samples are 
relevant for the KPI.

For information on editing selector definitions in the source adapters, see 
“Define Selectors” in IT World Model Management.

Note: Selectors are also defined for Dynamic Rule Factory CIs, but directly as 
part of the CI definition, not in a KPI. The selector used by a Dynamic Node 
Factory can be defined and/or edited in the IT Universe Manager tab of 
CMDB Administration, as described in “Working with Dynamic Node 
Factory” in IT World Model Management. The functionality and definitions 
for a Dynamic Rule Factory selector are the same as for a KPI selector, as 
described in this section.

Role of the Selector
Monitoring CIs are CIs that are intended to receive real-time data from the 
data samples sent by the external system (purely logical CIs do not receive 
data samples). The data samples, containing information collected by a 
monitoring system (either HP or third-party), are supplied to HP Business 
Availability Center over the bus.

The Business Logic Engine filters the data samples arriving on the Bus using 
selectors, which are set using Dashboard Administration. A selector is 
defined as part of the monitor rule for a KPI attached to a monitoring CI. 
The selector identifies and catches the data that is relevant for the CI and 
the KPI.
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A different selector can be used by each KPI with an associated monitor rule, 
enabling (when required) the use of different samples for each KPI. When a 
monitoring CI is added to the HP Universal CMDB by a monitoring adapter 
(as described in “Predefined Monitoring Service Views” in IT World Model 
Management), a selector is automatically defined for each of the default KPIs 
for the CI. 

If required, you can edit the default KPI selectors in the KPIs tab. You can 
also attach new KPIs to a monitoring CI, assign a monitor rule and manually 
define the selector.

For more information about defining selectors, see “Define Selector 
Expressions” on page 228, “Build Complex Filters” on page 229, “Use 
Predefined Sample Data for Selectors” on page 230, or “Manually Define 
Custom Selectors” on page 233.

KPIs for User Modes

HP Business Availability Center provides the option to define Dashboard 
KPIs for two different user types (modes): operations and business. This 
option enables the creation of two versions of a single KPI, where each KPI 
version is geared towards the particular viewing requirements of one of the 
user types.

For example: You might want to create two versions of the Availability KPI, 
so that the Availability KPI for an operations user shows Critical status (red) 
when transaction availability is below 30%, and the Availability KPI for a 
business user shows Critical status when transaction availability is below 
20%.

Each user type sees the appropriate version of the KPI in the Dashboard 
views.
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Understanding KPI Status

For each CI, Dashboard displays real-time status in one or more KPI columns 
in the view. 

Each KPI can include three icons: Status, Trend, and History.

A color-coded icon (LED) is displayed for each KPI in a view, representing 
the status assigned to that component for its current performance level. In 
addition to the main status icon for a KPI, the KPI column can contain 
additional icons showing trend and history for the CI under that KPI. 

The status of a KPI in Dashboard provides an indication of how well a 
business process or system is meeting your business objectives. Based on 
traffic light colors (with additions), the Dashboard shows you whether the 
KPI measurement is meeting the objective requirements (green), is critically 
failing (red), or is at some business risk level between the two (olive, yellow, 
orange). For more details about objectives, see “KPI Objectives”. 

The status of each KPI is calculated using a business rule. A different 
business rule may be used for a parent CI and a child CI with the same KPI 
attached. The business rules are defined for the KPI in Dashboard 
Administration. For details on the rules, see “List of Dashboard Business 
Rules” in CI Attribute Customization.

This section includes the following topics:

➤ “Types of CIs” on page 204

➤ “Colors of KPI Statuses Used in Dashboard” on page 205

➤ “Status Scores” on page 207
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➤ “Stopped/Downtime Status” on page 208

➤ “Influence of Must and Weight on Status” on page 209

Types of CIs
There are two types of CIs whose status is calculated differently:

➤ Monitor CI. Monitor CIs receive real data from data samples. These data 
samples are used to calculate the status of the KPIs attached to the monitor 
CIs.

The foundation of status definition for all monitor CIs is a comparison of 
performance metrics with objective values. 

➤ Group CI Status. For group CIs (all CIs except monitor CIs), Dashboard 
displays a status icon that represents a “summary” of the status for the child 
components (that is, the CIs that belong to the lower level in the 
hierarchical structure). 

The Details tooltip for each status icon provides some information regarding 
the calculation method in use for the KPI. For details, see 
“Stopped/Downtime Status” on page 208.

Note: The color displayed for a CI icon in Dashboard represents a summary 
of interim status values for a predefined duration (the default duration value 
is generally 300 seconds). The calculation of status values is an ongoing 
process, using samples collected every 60 seconds (default granularity 
value), thus the interim status may actually change several times over the 
duration without causing any change in the color of the icon. For example, 
if the icon for a transaction is red at the beginning of a duration, and during 
the duration the interim status changes from red to green and back to red, at 
the end of the duration the icon is still red.
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Colors of KPI Statuses Used in Dashboard
The following shows the main status levels that are used to show status for 
KPIs in Dashboard (note that some of the Dashboard KPIs use text in place 
of icons, but use the same color coding to indicate status as shown here):

Icon Description Status Name Numerical Code Definition

Red with 
attached “X”

Critical 0 The measurement calculated for 
the KPI fell within the value 
range for the Critical objective.

Orange with 
attached 
exclamation 
marks

Major 5 The measurement calculated for 
the KPI fell within the value 
range for the Major objective.

Yellow with 
attached 
exclamation 
mark

Minor 10 The measurement calculated for 
the KPI fell within the value 
range for the Minor objective.

Olive with 
tilda

Warning 15 The measurement calculated for 
the KPI fell within the value 
range for the Warning objective.

Green OK 20 The measurement calculated for 
the KPI fell within the value 
range for the OK objective.

Gray with 
attached 
dash

Uninitialized -1 No performance measurement 
data has yet been received for 
this KPI. This may be the case if 
no measurements have been 
taken for the CI in the period 
since starting Dashboard.

Gray with 
attached 
dash

Not up to 
date (Decay)

-2 The KPI has passed a timeout 
period during which no new 
information has been received.

The default timeout period is 15 
minutes, and the default decay 
status color is gray.
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Note: The numerical code is used in HP Business Availability Center files to 
perform calculation instead of the corresponding status.

Note: To change the color of the icons used at each status level, you can 
customize some of the icons, or complete sets of icons. For details, see 
“Change the KPI Status Icons” in CI Attribute Customization.

Note the following specialized status icon information:

➤ Change icons indicate when a change was made to a specific static attribute 
of a specific CI in the HP Universal CMDB. For details, see “Real-Time 
Changes to CI Properties” on page 23.

➤ If all members of a group have Uninitialized status, the group status is 
Uninitialized, regardless of which calculation method is in use. A group also 
has Uninitialized status if it has no children.

➤ As long as there are one or more children in a group that have a colored 
status, then one of the group business rules is used to define status for the 
group, regardless of the number of children that have Uninitialized, 
Stopped, or Downtime status.

For Trend and History status, see “Trend and History” on page 210.

Gray with 
attached 
dash and 
green 
outline

Stopped or 
Downtime

-3 (Stopped) 
-4 (Downtime)

The corresponding 
profile/group/monitor for the 
CI is currently disabled. For 
details, see “Stopped/Downtime 
Status” on page 208.

Gray with 
white center

Not 
applicable 
for this CI

N/A This KPI is not applicable for 
the CI.

Icon Description Status Name Numerical Code Definition
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Status Scores
Real-time statuses can be:

In most rules, only the main three statuses (0, 10 and 20) are used.

When a score has been calculated from more than one value, the scores are 
assigned status using the following definitions:

➤ 0 = worst

➤ 0 < score < 7.5 = bad

➤ 7.5 to 12.5 (inclusive) = middle

➤ 12.5 < score < 20 = good

➤ 20 = best

They are then assigned the colors:

Note: Only relevant statuses (0-20) are taking into consideration (“grey” 
statuses are ignored).

0 worst

5 bad

10 middle

15 good

20 best

worst red

bad orange

middle yellow

good olive

best green
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Stopped/Downtime Status
If a monitor in SiteScope or Business Process Monitor is stopped (disabled 
indefinitely) or in downtime (disabled for a scheduled time period), 
Dashboard displays a Stopped/Downtime status icon for the corresponding 
CIs (gray with a green outline). 

When the downtime or stopped period finishes, the status icon changes to 
No Data until data is received for the CI.

You can determine whether the CI is stopped or in downtime by holding the 
cursor over the Stopped/Downtime icon for the CI. The displayed Details 
tooltip gives the CI status, the rule used to calculate the result, and, if the CI 
is in downtime, to give the date and time when downtime finishes.

The following applies for the status of groups containing Stopped or 
Downtime status CIs:

➤ If at least one child has a status other than Stopped, Downtime, or 
Uninitialized, then the status for the group is calculated in the usual way, as 
described in “Understanding KPI Status” on page 203.

➤ If all of the children have either Stopped, Downtime, or Uninitialized status, 
the group has Uninitialized status.

➤ If all of the children have Stopped status, the group also has Stopped status.

➤ If all of the children have Downtime status, or there is a combination of 
Stopped and Downtime, the group has Downtime status, and its Details 
tooltip displays the earliest time given for the end of downtime for all 
children in the group.
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In the Top View tab, the icon for a Stopped or Downtime status CI is shown 
in gray with a green border.

Influence of Must and Weight on Status
When Must and Weight properties have been defined for the relationship 
between a parent CI and a child CI, these properties have an impact on the 
status calculations for the KPIs of the parent CI.

Must and Weight can be used to qualify a relationship. Weight is used for 
weighted percentage status calculations. Must is used for dominant child 
status calculations.

The dominant and/or weight information affects only the status of the 
group to which this CI belongs, and does not affect the status of the CI 
itself. The status of a group CI is based on its child CIs, and the status of a 
monitor CI is based on the information received from the monitoring 
source. 

For more details about Weight and Must, see “Understanding the Percentage 
Rule” in CI Attribute Customization.
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Trend and History

The following status levels are used to show historical and trend status for 
monitor CIs in Dashboard:

The trend status has three positions: up, down, and no change. It shows the 
trend of the real-time status.

The history status can display the worst status or the average status over a 
time period. 

Icon Description Status Status Definition

Small gray 
downward 
arrow

Downward 
trend

Real-time status shows a downward 
trend.

Small gray 
double-sided 
arrow

Stable trend Real-time status shows a stable trend. 

Small gray 
upward 
arrow

Upward trend Real-time status shows an upward 
trend. 

Small green 
with 
attached 
checkmark

Historical OK All performance measurements fell 
within the OK objective level over a 
time period up to the present.

Small yellow 
with 
attached 
exclamation 
mark

Historical 
Warning

At least one performance 
measurement fell within the 
Warning objective level, but no 
measurements fell within the Critical 
objective level, over a time period up 
to the present.

Small red 
with 
attached “X”

Historical 
Critical

At least one performance 
measurement fell within the Critical 
objective level, over a time period up 
to the present.
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Note: No history or trend status is displayed for a CI if there is no relevant 
data, for example, if it is uninitialized or stopped, or if it is not relevant for 
the KPI.

Move the mouse over the Trend icon to display the name of the trend, the 
name of the CI, and the trend of the KPI in the selected time period. For 
details about the tooltip, see “Trend” in CI Attribute Customization.

Move the mouse over the History icon to display the name of the KPI, the 
name of the CI, and the type of history used when calculating the history 
status, and the worst or average status of the KPI in the selected time period. 
For details about the tooltip, see “History” in CI Attribute Customization.

For more information on how to customize your trend and history statuses 
and explanations about how those statuses are calculated, see “Status 
Calculations” in CI Attribute Customization.

You can customize the set of Trend and History icons. For details, see 
“Change the KPI Status Icons” in CI Attribute Customization.

Note: If a transaction in an HP Virtual User Generator script is renamed, 
Business Availability Center considers it as a new transaction. A new BPM 
Transaction from Location CI is created in the CMDB using the new name, 
and the CI with the old transaction name is removed after it stops receiving 
samples. In Dashboard, the new CI will not display trend and history status 
data from before the transaction name change.

The way the trend and history status is determined is described in the 
following sections:

➤ “History Calculation” on page 212

➤ “Trend Calculation” on page 213

➤ “Modifying the Trend and History Status Calculations” on page 213
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History Calculation
The history status icon displays either the worst status or the average status 
for the CI’s KPI during a specified time period. 

The calculation method for history status is determined by the value set for 
the HistoryType parameter (one of the global parameters in the Business 
Rules Repository, described in “Preconfigured Rule/KPI Association in 
Dashboard” on page 213). The possible calculation methods are Worst 
(default value) or Average. Whichever calculation method is used, only 
status scores that have meaning (scores 0 to 20—the non-gray icons) are 
taken into consideration.

➤ Worst. Takes the worst status over the period of time specified in the 
HistorySize parameter (also one of the global parameters).

For example: if HistorySize is 60 minutes (default value) and the KPI’s values 
for the last 60 minutes are: 10, 10, 5, 0, -2, 20, the worst status is 0, so the 
history icon is red.

➤ Average. Takes the average status over the period of time specified in the 
HistorySize parameter (Simple Moving Average). The calculation result is 
rounded to the nearest of the following values: 0, 5, 10, 15, or 20. 

For example: if HistorySize is 60 minutes and the KPI’s values for the last 60 
minutes are: 10, 10, 5, 0, -2, 20, the Average status is 10 (rounded from 
(10+10+5+0+20)/5=9), so the history icon is yellow.
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Trend Calculation
The trend status icon shows the trend in real-time status for the CI KPI, 
using three directions: up, down, and no change.

Trend analysis is performed by comparing the Simple Moving Average 
(SMA) value for a long window with the SMA for a short window. If the 
short window SMA is higher than the long window SMA, the trend is 
considered to be up. If the long window SMA is higher, the trend is 
considered to be down. The SMA is calculated only on status scores that 
have meaning (scores 0 to 20—the non-gray icons).

➤ Long window SMA. Based on the mean status of a KPI over the period of 
time specified in the HistorySize parameter (default = 60 minutes), one of 
the global parameters in the Business Rules Repository, described in 
“Preconfigured Rule/KPI Association in Dashboard” on page 213.

➤ Short window SMA. Based on the mean status of a KPI over the period of 
time defined by (TrendRate * HistorySize). The TrendRate parameter 
(default = 0.3) represents the time rate between the long and short window, 
and is defined in the hidden parameters described in “Modifying the Trend 
and History Status Calculations” on page 213.

Modifying the Trend and History Status Calculations
You can modify the way the trend and history statuses are calculated and 
displayed, by editing certain rule parameters. A rule parameter can be set in 
three places: 

➤ As part of the global rule parameters that apply to all rules and affect all CIs. 
For details on editing global parameters, see “Global Attributes Dialog Box” 
in CI Attribute Customization.

➤ Directly for a rule, so that it affects all CIs that use this rule. For details on 
editing rule parameters, see “Rule Details Dialog Box” in CI Attribute 
Customization.

Some parameters for trend and history statuses are predefined and can be 
viewed and edited in the Business Rules Repository page; others are hidden, 
but can be manually added on the Repositories tab if you want to override 
the parameter default value. 
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Persistent Data and Historical Data

A KPI whose data is persistent is attached to a CI whose Save KPI data over 
time for this CI option has been selected. For details, see “KPIs Page” on 
page 324. This option is selected by default for Business Process, Line of 
Business, and Monitor Application CIs. This option is not available for 
Monitor type CIs.

For each CI with the Save historical data for this CI option, the following 
information is stored in the database:

➤ Every status change for each KPI

➤ The current calculated value for each KPI, read at regular time intervals (the 
default time interval is 15 minutes)

When the option is first selected, the current status for all of the CI KPIs is 
written to the database. As long as the settings remain the same, each time 
there is a change in status for one of the CI’s KPIs (for example, from Critical 
to OK), the status change is written to the database.

Note: Saving historical data for long periods of time or for many CIs and 
KPIs can require a lot of database memory, so this option should be used 
with care. When you no longer require data to be saved for a CI, clear the 
Save historical data for this CI check box for that CI.

This capability is used in the Dashboard reports. For details, see “Dashboard 
Reports” on page 141.
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Configure a KPI

This section describes the processes for the main task flow used to configure 
KPIs, and gives examples.

Configure a KPI using the steps described in this section.

This task includes the following steps:

➤ “Define or Edit KPIs” on page 215

➤ “Set Up the User Mode for the KPI” on page 215

➤ “Attach KPIs to CIs” on page 216

➤ “Monitor CI Property Changes in Real-Time” on page 218

➤ “View the Result in Dashboard” on page 219

Define or Edit KPIs
You can globally define or edit a KPI. For details, see “KPIs Repository Page” 
in CI Attribute Customization.

You can edit a specific KPI. For details, see “KPI Details Dialog Box” on 
page 594.

Set Up the User Mode for the KPI
This step is optional.

HP Business Availability Center provides the option to define Dashboard 
KPIs for two different user types (modes): operations and business. This 
option enables the creation of two versions of a single KPI, where each KPI 
version is geared towards the particular viewing requirements of one of the 
user types. For details, see “KPIs for User Modes” on page 202.

For details about the User Mode functionality, see “Set Up User Mode 
Functionality” on page 234.
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Example

For a detailed example, see “Example–Scenario of KPI Versions for User 
Modes” on page 237.

Attach KPIs to CIs
You can attach additional KPIs to any CI. You can attach one of the default 
KPIs provided with HP Business Availability Center, or attach a KPI that you 
defined in the KPIs repository. 

For details about attaching a KPI to a CI, see “Attach KPIs to CIs” on 
page 220.

If you have set a version for a KPI, manually attach the KPI versions to the 
CIs to which you want them to apply. For details, see “Attach KPI Versions 
to CIs” on page 236.

Example–Attaching a PNR KPI to a CI

The PNR (Point of No Return) KPI enables you to view how well agreement 
objectives are being met. When the PNR KPI is defined for a CI, a bar is 
displayed in Dashboard indicating how much more time (in percentages) 
the CI can be unavailable before the agreement is in breach of contract. For 
an explanation of unavailability, see “Unavailability Calculation” on 
page 87.

Perform the following procedure to view Service Level Management data in 
an information bar in Dashboard.

To set up Dashboard to display Service Level Management data in 
Dashboard:

 1 Create an agreement. For details, see “Agreement Wizard” in Using Service 
Level Management.

The agreement must include a CI with an attached Availability KPI for the 
Dashboard PNR KPI to show data in reports. 
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 2 In Dashboard Administration, attach a PNR KPI to the same CI. For details 
on attaching a KPI, see “No Data Timeout for Transaction CIs” on page 190. 
During KPI creation: 

➤ Choose the PNR KPI.

➤ Select the agreement whose data is to be displayed in Dashboard.

➤ Select the calendar and tracking period. These parameters are defined 
when creating the agreement. For details, see “Define Agreement 
Properties Page” in Using Service Level Management.

➤ Add the objective’s ranges that Dashboard uses to calculate when 
unavailability time approaches breach of contract levels.
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 3 View the results in Dashboard: Applications > Dashboard > Console. Choose 
the view and select the CI.

For details on the information that Dashboard displays in the Console page, 
see “Service Level Management Results in the Console Page” on page 86.

Monitor CI Property Changes in Real-Time
For a limited number of CIs, Dashboard can monitor for changes to the CI 
properties (or changes to the properties of the CI’s child CIs) in real-time. 
For details, see “Attach KPI Versions to CIs” on page 236.

This information is in addition to the Dashboard Change Report, which 
shows a historical report on changes to properties for CIs over a period of 
time. For details, see “Change Report Page” in IT World Model Management.
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View the Result in Dashboard
If you have defined user modes for a KPI, each user type sees in Dashboard 
the appropriate KPI version for their assigned user mode (operations or 
business user), for all KPIs that are defined as specific to a user mode. Users 
who are not assigned a user mode (undefined) see KPIs for both modes, as 
do system administrators:

In the Geographical Map and Custom Map tabs, status at a location is based 
on whichever KPI versions the user sees in Dashboard:
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Attach KPIs to CIs

You can attach additional KPIs to any CI. You can attach one of the default 
KPIs provided with HP Business Availability Center, or attach a KPI that you 
defined in the KPIs repository. For details about the KPI repository, see 
“Overview of the KPIs Repository” in CI Attribute Customization.

There can be only one instance of each KPI for a CI. For each new KPI, 
define the KPI type and business rule. Where relevant, also define additional 
information required by the rule.

Dashboard Administration also gives you the option of attaching a KPI to 
multiple CIs. The KPI is added to all CIs that do not already have that KPI 
attached. All instances of the KPI have the same defined business rule and 
properties. 

For information on KPI functionality, see “How Dashboard KPIs Work” on 
page 184.

The actions of attaching a new KPI to a CI, and defining the KPI properties, 
must be undertaken with care; these actions can result in KPIs that give an 
inaccurate performance assessment in Dashboard. Please read the notes and 
limitations before proceeding. For details, see “Notes and Limitations for 
KPIs and CIs” on page 185.

For details about attaching a new KPI to a single CI or to multiple CIs, see 
“New KPI/Add KPI to Multiple CIs/Edit KPI/Edit KPI for Child Transaction 
Dialog Box” on page 328.
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Edit KPI Properties

You can edit KPI properties for individual KPIs in the Edit KPI window. You 
can also perform a multiple edit on certain KPI properties for transaction 
CIs.

Editing KPI properties must be undertaken with care; the changes can result 
in KPIs that give an inaccurate performance assessment in Dashboard. Read 
notes and limitations before proceeding. For details, see “Notes and 
Limitations for KPIs and CIs” on page 185.

Edit a KPI Properties
You can modify all properties for a defined KPI (apart from the KPI type), 
whether it is a default KPI for the CI, or a KPI attached by a user.

For details, see “New KPI/Add KPI to Multiple CIs/Edit KPI/Edit KPI for Child 
Transaction Dialog Box” on page 328.

Edit the KPI Properties for Multiple Transaction CIs
The KPIs tab has a multiple edit function, enabling you to modify the 
Availability or Performance KPIs for all BPM Transaction from Location CIs 
in a group. This function enables you to define new business rule parameter 
values and/or objective values for all child transactions CIs that appear in a 
subtree of a view, in one operation.

You can define the new values in the Edit KPI for Child Transactions 
window. Every new value you define replaces the previous value for that 
property, for each transaction CI in the subtree. Property boxes left blank in 
the Edit KPI for Child Transactions window do not affect the CIs. For details, 
see “New KPI/Add KPI to Multiple CIs/Edit KPI/Edit KPI for Child 
Transaction Dialog Box” on page 328.

Before using the Edit KPIs for Child Transactions function, you should make 
sure that the planned new values are logical for all transaction CIs in the 
subtree. You should also review the Notes and Limitations section; for 
details, see “Notes and Limitations for KPIs and CIs” on page 185.
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Example

The following example describes editing the objective values for transaction 
CIs in a subtree.

 1 In the KPIs tab, the Performance KPI objective values for every transaction 
CI in the myapp subtree appear as in the following figure. They are displayed 
by clicking the Edit KPI button for any of the transaction CIs.

For this example, two additional objective values are added, to include 
Warning and Major status levels for each transaction CI, and the Minor 
objective value is modified.
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 2 In View Explorer, select the parent CI for the subtree—in this case, the 
Application CI myapp:

 3 In the right pane, click the Edit KPIs for child transactions button for the 
required KPI—in this case, the Performance KPI.
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 4 In the Edit KPI for Child Transactions window, enter the required values—in 
this case, 10000 for Warning objective, 11000 for Minor objective, and 
12000 for Major objective.
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 5 After applying the changes, all transaction CIs in the myapp subtree have 
the following objective values defined:
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Set Up the Real-Time Monitoring of CI Property Changes

For a limited number of CIs, Dashboard can monitor for changes to the CI 
properties (or changes to the properties of the CI’s child CIs) in real-time. 

This information is in addition to the Dashboard Change Report, which 
shows a historical report on changes to properties for CIs over a period of 
time. For details on the Change Report, see “Change Report Page” in 
IT World Model Management.

To display real-time changes for a CI and its children, the Monitor changes 
check box must be selected for that CI in the KPIs tab. 
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You can set the monitor changes option for up to 20 CIs. After you configure 
20 CIs, a message is displayed when you try to set the option for another CI, 
stating that the limit has been reached.

If you then clear the option for one or more of the configured CIs, the 
option becomes available again for all CIs, until the 20 CIs limit is again 
reached.

Note: To change the 20 limit, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Application, and locate the Maximum monitored CIs entry in the Change 
Impact Properties table. Modify the value as required. However, change this 
value with caution to avoid overload on the system.

When the monitor changes option has been set for a CI, Dashboard 
continuously monitors that CI and all its child CIs, to see if a change occurs 
in one of the significant properties defined for the CIs.

The significant properties vary for each CIT, according to the CIT definition 
in Admin > CMDB > CI Type Manager. In CI Type Manager, in the Attributes 
tab for the CIT, the Change Monitored column must be selected for a 
property, in order for that property to be significant and therefore 
monitored. For more information on CIT definitions, see “CI Type 
Manager” in CI Attribute Customization.

If a change occurs in one of the significant properties for the CI or the CI 
children, then an icon is displayed in Dashboard beside the CI name. For 
more information, see “Analyze Real-Time Change Information” on 
page 39.

After a change occurs, the change icon is displayed for 24 hours (default 
value). You can change the default value. For details, see “Modify the 
Changes Period for the Change Report” on page 61.
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Define Selector Expressions

In the selector Filter area, you define selector expressions to filter the data 
samples, To target only those samples that are relevant for the KPI. A 
selector expression requires a Field, an Operator, and a Value, defined in 
that order. For more information, see “Selector Expression Parameters” on 
page 243.

There are two methods for defining selector expressions:

➤ Using predefined sample parameters. Define the selector expressions by 
selecting from metadata—predefined sample types and sample parameters 
in the database. For more information, see “Use Predefined Sample Data for 
Selectors” on page 230.

➤ Manually, to build a custom selector. Define the selector expressions by 
manually defining the sample type and sample parameters. You can build a 
custom selector using any field name, and, if required, can combine fields 
from two or more data types. For more information, see “Manually Define 
Custom Selectors” on page 233.

Note: You can have HP Business Availability Center automatically assign the 
default selector for the monitoring CI, by leaving the selector expressions 
blank in the New KPI/Edit KPI window. After clicking OK to close the 
window, HP Business Availability Center assigns the KPI the default selector 
for the CI, as used by the default KPIs attached to the CI.

A selector filter can consist of a single simple expression, or you can build 
more complex filters containing blocks of selector expressions. For more 
information, see “Build Complex Filters” on page 229.
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Build Complex Filters

You can build more complex filters for a KPI, by defining blocks of selector 
expressions that together form a complex logical expression: 

➤ Narrow the filter by using a logical And operator to attach additional 
selector expressions to an expression block. 

➤ Widen the filter by using a logical Or operator to add alternative expression 
blocks (each containing one or more selector expressions).

You can define as many selector expressions and blocks of selector 
expressions as required:

➤ To define an additional selector expression within a block, click the And 
button for that block. An additional empty selector expression row is 
displayed in the block.

For example, you can define a filter that looks for transaction samples that 
contain both profile name X and transaction name Y. 

➤ To define an alternative expression block, click the Add ’OR’ Expression 
button. A new block is created, with an empty selector expression row.
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Example

You can define a filter that looks for transaction samples that contain either 
transaction name X or transaction name Y. 

You can add additional selector expressions to the new block using the And 
button for the block. 

A data sample qualifies for the selector if all the selector expressions in a 
single expression block are TRUE for the data sample. For example, either 
selector expressions a and b and c in block 1 are all TRUE, or selector 
expressions d and e and f in block 2 are all TRUE. 

Example of selector with two expression blocks.

Use Predefined Sample Data for Selectors

When defining or editing a selector using predefined sample data, you can 
select Field and Operator values from predefined lists. This definition 
method validates the field names and operators, and prevents errors that 
might occur when manually entering field names. It also simplifies the 
process of defining a selector. 

The predefined fields use metadata, information on sample types collected 
from data samples arriving from various data sources (including HP data 
collectors and third-party data sources) and stored in the database. For 
explanations of the data samples and their fields, see “Data Samples” in 
Reference Information.
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You can use metadata to build a complex filter with multiple selector 
expressions, just as with manually defined filters. For more information on 
defining selector expressions and building complex filters, see “Define 
Selector Expressions” on page 228.

Example–Define a Selector Expression Using Metadata

 1 Define the sample type that applies for this KPI. Select the sample type from 
the list at the top of the Selector area in the New KPI or Edit KPI window. 
The list is based on the sample types currently in the database.

For example, for a KPI that relates to transaction measurements, select 
sample type Transactions from the list.

When you select a sample type from the list, all previously defined 
expressions for the selector are overridden, so the contents of the Filter box 
are automatically deleted. 
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The Field box in the first selector expression converts to a dropdown list, 
containing all valid options for the selected sample type. The Field box 
defines the required reference property in the data samples. 

 2 Select an option from the Field list. 

The Operator list is automatically updated so that it contains only those 
operators that are valid for the selected field. For example, if the selected 
field always contains a text string, then only the operators that are used 
with text are included in the list, such as like, notIn, ==, in.

 3 Enter a value for the selected field in the Value box.

Note: The Value property is case sensitive and must be entered precisely as 
used in the data samples from the data source, or the selector fails. The 
recommended method is to take the values from the samples published on 
the Bus. For details, see “Define Selector Expressions” on page 228.
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Manually Define Custom Selectors

When defining or editing a selector, you can build a custom selector by 
manually defining all information for the selector. Make sure that no sample 
type is defined in the list at the top of the Selector area in the New KPI or 
Edit KPI window (the box should display Custom).

If a sample type was previously selected in the list, and you then select 
Custom, all previously defined expressions for the selector are overridden 
and the contents of the Filter box are automatically deleted.

Every selector must include the definition of the sample type required for 
the KPI, so when manually defining a selector, at least one selector 
expression must contain this information. For example, for a KPI that relates 
to transaction measurements, the selector must “catch” transaction samples, 
which are defined by the sample type “trans_t” in the selector.

Note: The Field and Value properties are case sensitive and must be entered 
precisely as used in the data samples from the data source, or the selector 
fails. The recommended method is to take the values from the samples 
published on the Bus. For details, see “Selector Expression Parameters” on 
page 243.

To define a custom selector expression, enter the required reference property 
in the Field box, select an operator from the Operator list. You can select 
from any of the operators used in Dashboard, and enter the required value 
for the property directly in the Value box.
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Set Up User Mode Functionality

You can set up user mode functionality in HP Business Availability Center 
by defining the mode for users, defining the KPI versions for each mode, 
and attaching the KPI versions to the CIs.

This task includes the following steps:

➤ “Assign a User Mode” on page 234

➤ “Define KPI Versions for the User Modes” on page 234

➤ “Attach KPI Versions to CIs” on page 236

➤ “Example–Scenario of KPI Versions for User Modes” on page 237

Assign a User Mode
There are two ways to assign a user mode to a user:

➤ The system administrator, when defining new users in the Admin > Platform 
> Users and Permissions > User Management page, can set User Mode to 
Undefined, Operations User, or Business User. By default, all new/existing 
users are set as Unspecified (meaning that they see KPIs for both modes in 
Dashboard).

➤ Users can change their own user mode in the Admin > Personal Settings > 
General Settings page. In the User Mode area, select the required mode 
from the Select user mode list.

After changing the mode in the General Settings page, you must log out of 
HP Business Availability Center and log in again to see the mode filtering 
work.

Define KPI Versions for the User Modes
The following steps describe how to define different versions of a KPI to use 
with each user mode. You can assign user modes to a new KPI that you 
define, or to an existing KPI by cloning or overriding the KPI. For more 
information, see “KPIs Repository Page” in CI Attribute Customization.

If you want one of the KPI versions for a user mode to automatically replace 
an existing KPI, then you must override the existing KPI and edit the new 
version.
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It is recommended that you give a name to each KPI that is assigned a user 
mode that easily identifies the KPI with the appropriate user version. For 
example, you can add an appropriate suffix.

Example - Define KPI Versions For User Modes

 1 Access the Admin > Dashboard > Repositories > KPIs page.

 2 Define the business user version of the KPI:

➤ Add the required KPI to the Custom KPIs area by cloning or overriding a 
KPI, or creating a new KPI. Open the KPI for editing.

➤ In the displayed KPI Details window, give the new KPI/copied KPI an 
appropriate name. For example, add the suffix “_biz” (as in 
Availability_biz).

➤ Select Business in the Applicable for User Mode list.

 3 Define the operations user version of the KPI:

➤ Add the required KPI to the Custom KPIs area by cloning or overriding a 
KPI, or creating a new KPI. Open the KPI for editing.

➤ In the displayed KPI Details window, give the new KPI/copied KPI an 
appropriate name. For example, add the suffix “_ops” (as in 
Availability_ops).

➤ Select Operations in the Applicable for User Mode list.

Note: If you override a KPI, the overridden version of the KPI replaces the 
original KPI throughout Dashboard, so all CIs that are assigned the original 
CI (for example, Availability) are automatically updated to the new version 
(for example, Availability_ops).

 4 Edit the details for each KPI version, according to your requirements. For 
example, you might want different business rules to apply to each version. 
For more information, see “KPI Details Dialog Box” in CI Attribute 
Customization.
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 5 If you want to use a different version of a business rule with each KPI 
version, you must define the rule versions in the Business Rules Repository. 
For example, for two versions of the Availability KPI, you may require two 
versions of the Transaction Availability Rule, each with different default 
objective values.

For details on defining business rules, see “Set Up a Business Rule” in 
CI Attribute Customization.

Attach KPI Versions to CIs
You can manually attach the KPI versions to the CIs to which you want 
them to apply. 

➤ If the original KPI is already attached to CIs (for example, the Availability 
KPI is automatically attached to transaction CIs), then the KPI version that 
overrode the original (for example, Availability_ops) is automatically 
attached to the CIs instead. You can manually attach the second KPI version 
(for example, Availability_biz).

➤ If there are two new KPI versions, one for business and one for operations 
then for every applicable CI you manually attach the two versions (and 
delete the original KPI if it is not required).

To attach the KPI versions to CIs, select Admin > Dashboard > KPIs page, add 
the KPI versions to each CI where they are required, so that the CIs have 
both versions of the KPI. You can add the KPI to multiple CIs in one 
operation. For example, you might want to define different objective values 
for the KPI. For KPIs that require selectors: Do not define anything in the 
Selector area, leave the selector expressions empty. Click OK to save the KPI 
details. The KPI version is added to each selected CI, and propagates up the 
hierarchy to the parent CIs. After you click OK to add the KPI to the CI(s), 
HP Business Availability Center automatically replaces each blank selector 
with the default selector defined for the other KPIs attached to each CI. For 
details, see “New KPI/Add KPI to Multiple CIs/Edit KPI/Edit KPI for Child 
Transaction Dialog Box” on page 328.
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Example–Scenario of KPI Versions for User Modes

In the following example scenario, two versions of the Availability KPI are 
set up, one for each user mode. The Availability_ops version uses the default 
objective values; however, when the Availability_biz version is attached to 
CIs, different objective values are defined.

To set up and use Availability KPI versions for user modes:

 1 Access the Admin > Dashboard > Repositories > KPIs page.

 2 In the Factory KPIs area, select the check box for the Availability KPI and 
click Clone. The cloned KPI is displayed in the Custom KPIs area. 

 3 Click the Edit button for the cloned KPI. In the displayed KPI Details 
window, edit the KPI properties as follows:

➤ In the Display Label box, add the suffix _biz to the Availability label.

➤ Select Business in the Applicable for User Mode list. 

➤ Click OK.

 4 In the Factory KPIs area, select the check box for the Availability KPI and 
click Override. The old Availability KPI is shown as overridden, and the new 
version of the KPI is displayed in the Custom KPIs area. 
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 5 Click the Edit button for the new KPI. In the displayed KPI Details window, 
edit the KPI properties as follows:

➤ In the Display Label box, add the suffix _ops to the Availability label.

➤ Select Operations in the Applicable for User Mode list. 

➤ Click OK.

The KPI names are displayed in the Custom KPIs area. 

 6 Access the Admin > Dashboard > KPIs page and open the End User Monitors 
View. For all BPM Transaction from Location CIs, the Availability KPI has 
been replaced with the Availability_ops KPI.
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 7 Add the Availability_biz KPI to all BPM Transaction from Location CIs. Use 
the keyboard CTRL key to select all the CIs, then right-click one of the 
selected CIs and select Add KPI.

The Add KPI to Multiple CIs window opens.

 8 Edit the properties in the Add KPI to Multiple CIs Window as follows:

➤ Select Availability_biz in the KPI list.

➤ Select Transaction Availability Rule in the Business rule list.

➤ In the Objectives area, enter the objective values required for Availability 
KPI in business user mode: 80, 60, 40, 20.
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➤ Leave the selector expressions empty.
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➤ Click OK. The Availability_biz KPI is added to the KPIs list for each 
selected CI.

The appropriate selector is automatically defined for each new KPI, by 
copying the selector definitions for the other KPIs attached to the BPM 
Transaction from Location CI. (You can click the Edit buttonfor the 
Availability_biz KPI to view the selector.)

The Availability_biz KPI also propagates up to the CI parents, using the 
default group rule for the KPI.
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 9 In the Applications > Dashboard > Console page, you can see the 
Availability KPI versions as follows:

➤ For users assigned Operations mode:

➤ For users assigned Business mode:

A CI can display different status for each Availability KPI version (although 
each KPI has the same Availability score), because of the different objective 
levels defined for each version.
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Selector Expression Parameters

For each selector expression, you must define the following:

Parameter Description

Field The reference property that the selector expression 
checks in the data samples sent from the data 
source.

Operator The relational operator that the selector expression 
uses when comparing the actual value for the 
property against the value defined in the selector. 
The expression gives a result of TRUE or FALSE for 
each data sample.

The following operators are available:

➤ ==

➤ !=

➤ >

➤ >=

➤ <

➤ <=

➤ in

➤ notIn

➤ like

Value The property value that the expression compares 
with the value in the data sample. The value must 
be in numeric format if a numeric operator is 
selected, or it must be entered between quotation 
marks if a text string operator is selected.
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Modify the Number of CIs Monitored for Change in 
Real-Time

For a limited number of CIs, Dashboard can monitor for changes to the CI 
properties (or changes to the properties of the CI’s child CIs) in real-time. 

This information is in addition to the Dashboard Change Report, which 
shows a historical report on changes to properties for CIs over a period of 
time. (For details on the Change Report, see “Change Report Page” in 
IT World Model Management.)

For details on where to set the Monitor changes check box see “KPIs Page” 
on page 324. 

You can set the monitor changes option for up to 20 CIs. Once 20 CIs have 
been configured, a message is displayed when you try to set the option for 
another CI, stating that the limit has been reached.

If you then clear the option for one or more of the configured CIs, the 
option becomes available again for all CIs, until the 20 CIs limit is again 
reached.

Note: To change the 20 CIs limit, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click Applications, select Dashboard 
Application, and locate the Maximum monitored CIs entry in the Change 
Impact Properties table. Modify the value as required. However, change this 
value with caution to avoid too much load on the system.

When the monitor changes option has been set for a CI, Dashboard 
continuously monitors that CI and all its child CIs, to see if a change occurs 
in one of the significant properties defined for the CIs.

The significant properties vary for each CIT, according to the CIT definition 
in Admin > CMDB > CI Type Manager. In CI Type Manager, in the Attributes 
tab for the CIT, the Change Monitored column must be selected for a 
property, in order for that property to be significant and therefore 
monitored. For more information on CIT definitions, see “CI Type 
Manager” in CI Attribute Customization.
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If a change occurs in one of the significant properties for the CI or the CI 
children, an icon is displayed in Dashboard beside the CI name. For more 
information, see “Real-Time Changes to CI Properties” on page 23.

After a change occurs, the change icon is displayed for 24 hours (default 
value). You can change the default value, as described in “Modify the 
Changes Period for the Change Report” on page 61.

Change the Default Business Logic Engine Calculation Time 
Interval

You can change the default Business Logic Engine calculation time interval 
in the Infrastructure Settings page. 

Select Admin > Platform > Setup and Maintenance > Infrastructure Settings, 
click Foundations, select Online Business Logic Engine, and locate the 
Model calculation interval entry in the Calculation Related Settings table. 
Edit the value as required.

Change the No Data Timeout Value for Transaction CIs

When a KPI is using a monitor rule (for example, the Transaction 
Availability Rule), the Business Rule Parameters area includes the No data 
timeout property. This property defines the number of seconds from the 
time the last sample was received for the KPI, until the KPI is timed out—at 
which point the KPI changes to decay status (gray). For details, see “No Data 
Timeout for Transaction CIs” on page 190.
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10
Dashboard Ticker 

This chapter describes how to install, set the preferences, and control the 
Dashboard Ticker, and how to display HP Business Availability Center data 
on your desktop in a Ticker Window or in a Message Window.

This chapter describes: On page:

Concepts

Introduction to Dashboard Ticker 250

Understanding Dashboard Ticker 250

Ticker Window 251

Message Window 252

Tasks

View Data in Dashboard Ticker 253

Control Dashboard Ticker 255

Set Ticker Preferences 256
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Introduction to Dashboard Ticker

HP Dashboard Ticker enables you to monitor a selected view in a non-
intrusive manner on your desktop in a Ticker Window or in a Message 
Window without opening HP Business Availability Center.

Using HP Dashboard Ticker, you can, without opening HP Business 
Availability Center, select a view, select the server where HP Business 
Availability Center is installed, adjust the rate and the scrolling speed of the 
Ticker Window, and open the Message Window.

Understanding Dashboard Ticker

After you install HP Dashboard Ticker, one of HP Dashboard Ticker’s icons 
appears in the desktop tray bar. The type of icon displayed indicates 
different situations. A tooltip is available for each icon to describe HP 
Dashboard Ticker’s status.

Status Icon Description Tooltip

Online. The ticker has connected with 
the server and is monitoring status.

Connected with 
<server-url>

where server-url is 
the URL of the 
server.

Message. An incoming message was 
received. A KPI has turned to Critical 
state. 

Incoming message

Offline. The server could not be found 
or the response returned from the 
server is not recognizable.

Offline - <reason>

where reason 
explains why the 
ticker is offline.

Connecting. Dashboard Ticker is 
attempting to connect to the server. 

The indication is an animated icon.

Connecting...
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For details about installing the Ticker, see “Install Dashboard Ticker” on 
page 253.

HP Dashboard Ticker attempts to connect with the server using the supplied 
server address after the period of time specified in the Update interval 
parameter in the Preferences. If the server cannot be found or a connection 
cannot be established, the tray icon changes to Offline. For details about the 
Update interval parameter, see “Ticker Preferences Dialog Box” on page 338.

The tray icon changes to Connecting if Dashboard Ticker is trying to 
connect to the server. 

The tray icon changes to Online when the server has connected successfully. 

Every KPI in the selected view is checked. Any KPI with an error status is 
checked against the information already in HP Dashboard Ticker. If it is the 
first time this KPI appears in the view, or if the KPI’s status has changed to 
an error status, it is displayed in the Message Window and/or the Ticker 
Window. As soon as a message is put in the queue, the tray icon changes to 
Message, indicating that there is a message to be viewed. HP Dashboard 
Ticker’s internal message queue can contain an unlimited number of 
messages. 

Ticker Window

The Ticker Window displays a scrolling list (from right to left) of the top 
level CIs monitored by Dashboard along with icons that display the status of 
each one of the CI’s KPIs.
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Move the mouse above any icon in the Ticker Window to display a tooltip 
that includes the name of the KPI.

For details, see “Ticker Window” on page 335 in the user interface section.

Message Window

The Message Window is used to inform the user that a KPI’s status has 
changed to error/poor/worst. 

The Message Window displays the following information: 

For details, see “Message Window” on page 337 in the user interface section.
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View Data in Dashboard Ticker

HP Dashboard Ticker enables you to monitor a selected view in a non-
intrusive manner on your desktop in a Ticker Window or in a Message 
Window without opening HP Business Availability Center. For details, see 
“Introduction to Dashboard Ticker” on page 250. 

This task includes the following steps:

➤ “Install Dashboard Ticker” on page 253

➤ “Launch Dashboard Ticker” on page 253

➤ “Meet the Requirements” on page 254

➤ “Control Ticker Behavior” on page 254

➤ “Set the Ticker Preferences” on page 254

➤ “View Dashboard Information in Dashboard Ticker” on page 255

Install Dashboard Ticker
Install HP Dashboard Ticker as explained in this section.

To install HP Dashboard Ticker, select Admin > Platform > Setup and 
Maintenance to open the Downloads page, click HP Dashboard Ticker and 
follow the on-screen instructions.

Launch Dashboard Ticker
After HP Dashboard Ticker is installed, you must launch it to configure its 
behavior.

To launch HP Dashboard Ticker, select Start > Programs > HP Dashboard 
Ticker > HP Dashboard Ticker to launch the application and open the 
Preferences page.

For details, see “Ticker Preferences Dialog Box” on page 338.
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Meet the Requirements
To use the HP Dashboard Ticker you must have the following software 
installed on your computer: 

➤ Win2000 or Windows XP 

➤ Microsoft Internet Explorer 6.0 Service Pack 1 or later

Note: The requirements listed above are for the desktop version of HP 
Dashboard Ticker. To log on to HP Business Availability Center from the 
Message Window, you must fulfill the requirements detailed in the 
HP Business Availability Center Database Guide PDF.

Control Ticker Behavior
You can control the behavior of HP Dashboard Ticker using the options that 
are displayed by right-clicking the icon in the tray bar. Depending on the 
icon, a subset of the capabilities described in this section is displayed. 

For details, see “Control Dashboard Ticker” on page 255.

Set the Ticker Preferences
You can set the Ticker preferences so that you can view messages 
automatically or you can click the Message icon to display the Message 
Window. The Message Window fades out after 5 seconds. 

If you click the icon in the Message Window, the message that is currently 
displayed is removed from the queue as soon as you close the window. 

If you select to display the Message Window automatically and you do not 
click that window, the Message Window fades out after 5 seconds, and the 
message is considered unread. It is not removed from the queue.

For details, see “Set Ticker Preferences” on page 256.
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View Dashboard Information in Dashboard Ticker
HP Dashboard Ticker enables you to monitor a selected view in a non-
intrusive manner on your desktop in a Ticker Window or in a Message 
Window without opening HP Business Availability Center.

For details about the Ticker Window, see “Ticker Window” on page 251.

For details about the Message Window, see “Message Window” on page 252.

Control Dashboard Ticker

You can view an event in the Message Window or in the Ticker Window. 
You can open the Web browser, connect to the HP Business Availability 
Center server, and display the view in Dashboard. You can select what 
information is displayed in HP Dashboard Ticker, and how it is displayed.

You can control the behavior of HP Dashboard Ticker using the options that 
are displayed by right-clicking the icon in the tray bar. For details, see 
“Understanding Dashboard Ticker” on page 250. 

Depending on the icon, a subset of the following options is displayed:

➤ Show Current Event. To display the event if an event is waiting in the 
queue. For details, see “Message Window” on page 337.

➤ Show Ticker. To display the Ticker Window. For details, see “Ticker Window” 
on page 335.

➤ Log On. Opens the default Web browser, connects to the HP Business 
Availability Center server, and displays the view in Dashboard. For details, 
see “Console Page” on page 262.

➤ Preferences. To modify the information that is displayed in HP Dashboard 
Ticker, and how it is displayed. For details, see “Ticker Preferences Dialog 
Box” on page 338.

➤ About. To display the About window.

➤ Exit. To exit HP Dashboard Ticker.
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Set Ticker Preferences

You can view messages automatically (defined in Preferences) or you can 
click the Message icon to display the Message Window. The Message 
Window fades out after 5 seconds. 

If you click the icon in the Message Window, the message that is currently 
displayed is removed from the queue as soon as you close the window. 

If you select to display the Message Window automatically and you do not 
click that window, the Message Window fades out after 5 seconds and the 
message is considered unread. It is not removed from the queue.

You can:

➤ Reload a View to Display in the Ticker Window or in the Message Window

➤ Select the View to Display in the Ticker Window or in the Message Window

➤ Change the Server You are Accessing

➤ Modify the Refresh Rate of the Ticker Window

➤ Change the Scrolling Speed of the Ticker Window

➤ Select the Dock Orientation of the Ticker Window on Your Desktop

➤ Display a Popup Message Window When a New Message Arrives

➤ Sound an Alert When a New Message Arrives

➤ Automatically Load HP Dashboard Ticker When You Start Your Computer

For details about the steps to follow to view data in Dashboard Ticker, see 
“View Data in Dashboard Ticker” on page 253.

For details about setting the Ticker preferences, see “Ticker Preferences 
Dialog Box” on page 338.
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11
Dashboard User Interface

This chapter includes the pages and dialog boxes that are part of Dashboard 
user interface, listed in alphabetical order.

This chapter describes: On page:

Acknowledgment History and Details Dialog Box 260

Acknowledgments Details Dialog Box 261

Console Page 262

Custom Map Page 267

Defining/Editing Filters Dialog Box 271

Filter Name Dialog Box 274

Filters Page 275

Find Visible and Hidden Child CIs Dialog Box 280

Geographical Map Page 282

Node Details Dialog Box 289

Topology Map Page 290

Top View Page 291
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Acknowledgment History and Details Dialog Box

The dialog box includes the following elements (listed alphabetically):

Description Enables you to view the details of the current 
acknowledgment or the acknowledgment history of 
the CI.

To Access: Click the down arrow  to the right of a CI or 
right-click a CI in View Explorer and select 
Acknowledgment > Acknowledgment details. 

Included in Tasks “Acknowledge Performance Problems” on page 36

GUI Element Description

Acknowledgment 
details

Select to display the details of the currently opened 
acknowledgment in the Acknowledgment details box. 

Action The type of action that was performed:

➤ Clear. When the acknowledgment history was 
cleared.

➤ Unset. When the acknowledgment was unset.

➤ Info. Details were added to the acknowledgment 
without changing the acknowledgment status.

➤ Open. When the acknowledgment was set.

➤ Edit. When details were added to the 
acknowledgment.

Add Click to add the contents of the Add details box to the 
acknowledgment history.

Add details Add information about the actions you are going to 
perform to solve the problem. You can add information 
whether the acknowledgment is Open or Closed.

CI history Select to display the details of all of the 
acknowledgments over time in the Acknowledgment 
details box.

Clear Click to clear the acknowledgment history.
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Acknowledgments Details Dialog Box

Date The date and time when the acknowledgment status 
was modified.

Message Displays the status of the acknowledgment or the 
information that was entered in the Add details box.

User The name of the user who modified the status.

Description Enables you to set or unset a CI acknowledgment.

To Access: Click the down arrow  to the right of a CI 
and select Acknowledgment > Set/Unset 
Acknowledgment to open the Set/Unset 
Acknowledgment dialog box.

Click the Ack icon to the right of the CI.

Important 
Information

The Ack check box is enabled only if there is at least 
one KPI defined for the CI, and at least one of the KPIs 
has a status other than OK (green).

A tooltip for the Ack icon displays the current status of 
the CI’s acknowledgment. 

The dialog box is a toggle dialog box. If you have 
acknowledged the CI, the top line in the dialog box is: 
The acknowledgment will be unset. If you have not 
acknowledged the CI, the top line in the dialog box 
displays: The acknowledgment will be set.

GUI Element Description
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The dialog box includes the following elements (listed alphabetically):

Console Page

GUI Element Description

Add details Add information about the actions you are going to 
perform to solve the problem. You can add information 
whether the acknowledgment is Open or Closed.

OK Click to set or unset the acknowledgment depending on 
the previous status of the dialog box.

Description Shows the components of the active Dashboard view 
organized into the same hierarchy tree format that you 
defined for the CIs in Dashboard Administration. For 
details, see “Working with CIs” in IT World Model 
Management. 

To Access: Select Applications > Dashboard, and click 
the Console tab.

Important 
Information

Customizable: You can customize this tab. For details, 
see the customization section in “Dashboard Console” 
on page 83.

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Included in Tasks “Display and Customize View Information in the 
Console Tab” on page 88

Useful Links “Understanding the Console Page” on page 84

“View Explorer” in Reference Information

“Real-Time Changes to CI Properties” on page 23
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The tab includes the following elements (listed alphabetically):

GUI Element Description

Click to access the context menu options. For details, 
see “Dashboard Menu Options” on page 40.

The acknowledge utility enables you to track 
performance problems identified in the system and in 
the network infrastructure by keeping a record of when 
the problem was acknowledged and by which user. You 
can access the utility using context menu options or by 
clicking the Ack icon that is displayed in an Ack 
column in some of the Dashboard tabs.

A user with the appropriate permissions can show or 
hide the Ack column in the Dashboard application. To 
do that, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, click 
Applications context, select Dashboard Application, 
and locate the Show CI Acknowledgment column in 
the Business Console area, and select false to hide the 
Ack column, or true display the Ack column. The 
change takes effect immediately.

Note: A tooltip for the Ack icon displays the current 
status of the CI’s acknowledgment.

Indicates that at least one change-monitored property 
of the CI’s child CIs has changed. 

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details about setting this feature, see “Analyze Real-
Time Change Information” on page 39.
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Indicates that at least one change-monitored 
property of the CI’s child CIs has changed.

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details about setting this feature, see “Analyze Real-
Time Change Information” on page 39.

Indicates that at least one change-monitored property 
of the CI and at least one change-monitored property 
of the CI’s child CIs have changed.

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details about setting this feature, see “Analyze Real-
Time Change Information” on page 39.

GUI Element Description
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Click to toggle the sound on or off. The alert sound is a 
WAV file downloaded by the browser. The icon tooltip 
indicates the action you perform if you click the 
button. 

When the sound is switched on, a sound alert is played 
when the Console is currently displayed and a CI’s KPI 
changes status to Critical (red). The Critical status icon 
is also shown flashing until the next screen refresh. 

Notes:

➤ The sound is played only if the status of a CI’s KPI in 
the currently displayed tree branches has changed to 
Critical. If a CI in a hidden part of the view has 
changed to Critical but does not change the status of 
any of the CIs in the currently displayed branches, 
no sound is heard.

➤ If the view is being loaded for the first time, no 
sound is played for the CI’s KPIs that are loaded at 
Critical status.

➤ If you are using Mozilla, you must download a plug-
in for playing WAV files, otherwise no sound is 
played.

➤ To use another alert sound for Dashboard, you must 
be a user with administrative permissions, access 
<HP Business Availability Center server root 
directory>\AppServer\ webapps\site.war
\bam\pages\sounds and replace the ding.wav file 
with your own .wav file (you must rename your file 
ding.wav). The change takes effect immediately.

<CIs> The tree is built from group parent, children and 
monitor configuration items (CIs). For details, see 
“Working with CIs” in IT World Model Management. 

<Context menu 
options>

Right-click the CI bar to display context menu options. 
For details, see “Top View Menu Options” on page 75.

<Expand/collapse> Click [+] or [-] in the tree of CIs to expand or collapse 
the tree.

GUI Element Description
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<KPIs and their 
statuses/values>

For each CI in the view, Dashboard displays real-time 
status in one or more KPI columns (for example, 
System, Performance, and Availability). A color-coded 
icon (LED) represents the status assigned to the KPI for 
its current performance level. In addition to the main 
status icon for a KPI, the KPI column can contain 
additional icons showing trend and history for the CI 
under that KPI. For details, see “Understanding KPI 
Status” on page 203.

Note: If a KPI is relevant for at least one CI in the tree 
branches currently displayed, then that KPI is 
displayed for all CIs. The KPIs that are not relevant for 
a particular CI display a hyphen (-) meaning that those 
KPIs are not applicable for this CI.

Note: Move the cursor above a KPI status icon to 
display a tooltip providing additional information 
about the KPI: 

➤ CI Name. The name of the CI.

➤ Status. The status of the CI (calculated according to 
one of the status calculation methods). It may also 
display:

➤ Not up to date. For decayed CIs, indicating that 
the CI has passed its timeout period. (For a 
SiteScope CI, this status is displayed after a 
SiteScope monitor is disabled.)

➤ Stopped. When a Business Process profile is 
stopped.

➤ Calculation Rule. The name of the rule that 
calculates the KPI status or value.

➤ Held Status Since. The date and time since which 
this CI has held its current operational status.

➤ Invisible Children. Might not appear. The number of 
child CIs belonging to other views, which are 
connected to this CI but do not belong to this view. 
For details, see “Visible and Hidden Child CIs” on 
page 24.

GUI Element Description
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Custom Map Page 

Last Update Shows connectivity with the Dashboard servlet, 
running on the Tomcat servlet engine by displaying 
the time the information in the tab was last updated.

Description Enables you to create or display a map for the selected 
view with the view's CIs represented by real-time status 
indicators and a background custom image that 
describes the real world that your view represents.

To Access: 

➤ Select Admin > Dashboard, and click the Custom 
Map tab.

➤ Select Applications > Dashboard, and click the 
Custom Map tab.

Important 
Information

Use as an image, any diagram or picture, created using 
any tool, provided that the format is supported by the 
browser. It is recommended to use one of the following 
formats: GIF, JPG, or PNG.

CI icons should not overlap otherwise you see only the 
top status indicator in the custom map.

After setting a CI icon on the diagram, you can move 
the cursor over it to display the CI name in a tooltip.

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Included in Tasks “Display a View in a Custom Map” on page 129

Useful Links “About Custom Map” on page 128

“View Explorer” in Reference Information

GUI Element Description
267



Chapter 11 • Dashboard User Interface
The tab includes the following elements (listed alphabetically):

GUI Element Description

This icon appears only in Dashboard Administration.

Marks the location of the status indicator for the CI. 

This icon appears only in Dashboard Application.

Indicates the worst status (worst of all KPIs) of the CI. 

Use the Refresh button at any time to reload the 
diagram (for example, if changes have been made to 
the source file). Reloading the diagram does not affect 
the position of the indicators.
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<Tooltip> Move the cursor above the status icon of the CI to 
display additional information about each KPI 
attached to the CI in a separate section. The tooltip 
associated with a CI status indicator displays 
information about each KPI attached to the CI in a 
separate section. The color of each section represents 
the color of the corresponding KPI’s status. For details 
about the colors, see “Understanding KPI Status” on 
page 203.

The tooltip can display any of the following 
information, depending on the KPI:

➤ the header of each section displays Details followed 
by the name of the KPI

➤ CI name. The name of the CI.

➤ Status. The status of the KPI.

➤ Held status since. The date and time when the status 
changed to the current status.

➤ Historical worst. The tooltip of the historical status 
of the CI. For details, see “Trend and History” on 
page 210.

GUI Element Description
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Add CI Icon This button appears only in Dashboard 
Administration.

Click to add the selected icon. The CI icon is displayed 
in the left top corner of the diagram with a blue outline 

. Drag the CI to the required location in the 
diagram. The CI icon is set at that position.

Clear CI Icons This button appears only in Dashboard 
Administration.

Click to clear all the CI icons. A confirmation message 
is issued: You are about to clear all nodes from the 
view. Are you sure?

Delete Image This button appears only in Dashboard 
Administration.

Click to delete the image and all the CI icons from the 
custom map associated with the current view.

Image URL This field appears only in Dashboard Administration.

The image URL. It can use HTTP or HTTPS, but must 
use the format: http://hostname/<path_to_image>

To use a local machine as the location of the image, 
enter the URL with the following format: 
file:///<path_to_image> 

This results in an image that cannot be displayed for a 
user working outside the local network.

You can also use a file-sharing path as follows: 
\\server\<path_to_image>

Remove CI Icon This button appears only in Dashboard 
Administration.

Click to remove the CI icons in the custom map. 

Revert This button appears only in Dashboard 
Administration.

Click to revert to the last saved configuration before 
you save the changes.

GUI Element Description
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Defining/Editing Filters Dialog Box

The dialog box includes the following elements (listed alphabetically):

Description Used to define new filters or customize existing filters

To Access: Click Application > Dashboard, and click the 
Filters tab. Select the view in the View Explorer. Click 
Active Filters.

Important “Predefined Filters” on page 273

Included in Tasks “Create or Customize an Active Filter” on page 101

GUI Element Description

To invert the selection use the Invert Selection button. 

Acknowledged Select one of the following options:

➤ All. To display all of the CIs whether they are 
acknowledged or not.

➤ Yes. To display the CIs that are acknowledged.

➤ No. To display the CIs that are not acknowledged.

Cancel Click to exit the Defining/Editing Filters dialog box 
without saving your changes to the filter criteria for the 
currently displayed filter. 

Warning: The filter you create is saved and appears in 
the Active Filters list.

Clear All Clears all the selected filter fields.

Define filter Select the check box for each KPI status type that you 
want to include in the filter. 

Specify any combination of the listed filter criteria. The 
filter displays the CIs that meet all of the selected 
criteria, as follows:

If no status is selected for a KPI then all statuses are 
included in the filter.
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Filter by Change Select one of the following options to filter by the CIs 
that are set to be monitored in real-time for changes 
(only 20 CIs and their children can be monitored at a 
time). For details, see “Real-Time Changes to CI 
Properties” on page 23:

➤ Ignore Configuration Change. To display all CIs, 
whether their configuration changed or not.

➤ Only Changed Configuration Items. To display only 
the CIs whose configuration changed.

➤ Exclude Changed Configuration Items. To display 
only the CIs whose configuration did not change.

Filter by CI type Select one of the following options:

➤ All. All the CI types are included (monitor and non-
monitor CIs).

➤ All excluding monitors. All the CI types are included 
except for monitor CIs that are excluded.

➤ Monitors only. All the CI types are excluded except 
for monitor CIs that are included.

New Click to define a completely new filter in the Filter 
Name dialog box that opens. All the KPI’s statuses are 
cleared. 

Note: By default, a filter is called Custom Filter when 
you create a filter without assigning it a name.

OK Click to save your changes to the currently displayed 
filter and to close the Defining/Editing Filters dialog 
box.

Rename Click to rename the filter; for example, when you are 
want to change the name of a filter you created.

Save As Select the filter name in the Select a filter list, and click 
to use the selected filter as the basis for the new filter. 
The KPIs’ statuses that were selected for the filter you 
are using as a model are still selected.

The Filters Name dialog box opens, where you can 
specify a name for the filter you are creating.

GUI Element Description
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Predefined Filters

The predefined filters are:

Select a filter Click to modify an existing filter, select the filter in the 
box and click Select a filter. 

To use the selected existing filter as the basis for the 
new filter, select the filter name in the box, and click 
Select a filter. Then click Save As. The KPI statuses that 
were selected for the filter you are using as a model are 
still selected.

Predefined filters are used to include or exclude CIs 
according to their type, and KPIs according to their 
status. These filters cannot be modified or deleted. 

For details, see “Predefined Filters” on page 273.

Visibility Select the required visibility option:

➤ Private. If you want to create a private filter.

➤ Public. If you want to create a public filter.

Note: Visibility is displayed only to the administrator 
or to a user with the appropriate permissions.

Different levels of visibility are available. For details, 
see “Visibility Levels” on page 94.

Predefined Filter Name Description

global: Show All Displays all of the CIs, all their KPIs, and the status 
of the KPIs.

global: Show Errors Displays, for all CI types, only the CIs whose 
Availability, Customer, HP System, OT Impact, PNR, 
Performance, RT Impact, System, User, Volume, and 
custom KPIs have a critical status.

global: Show Errors – 
Monitors Only

Displays only the monitor CIs whose Availability, 
Customer, HP System, OT Impact, PNR, 
Performance, RT Impact, System, User, Volume, and 
custom KPIs have a critical status.

GUI Element Description
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Filter Name Dialog Box

The dialog box includes the following element:

global: Show Errors and 
Warnings

Displays, for all CI types, only the CIs whose 
Availability, Customer, HP System, OT Impact, PNR, 
Performance, RT Impact, System, User, Volume, and 
custom KPIs have a minor, major, or critical status.

global: Show Monitors 
Only

Displays only the monitor CIs, their KPIs, and the 
status of the KPIs.

global: Show PNR Displays, for all CI types, only the CIs whose PNR 
KPI has an OK, Warning, Minor, Major, Critical, or 
No Data status.

Description Used to define a new filter name.

To Access: In Defining/Editing Filters, select Save As.

Useful Links “Naming Conventions” in Reference Information

GUI Element Description

Name Enter the name of the filter.

Predefined Filter Name Description
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Filters Page

Description Enables you to view operational status for specific 
segments or components of your business. The Filters 
tab displays (in a flat non-hierarchical way) the 
configuration items (CIs) that match the following 
criteria: they belong to the selected view, and at least 
one of their Key Performance Indicators (KPIs) has the 
status specified in the active filter.

To Access: Select Applications > Dashboard and click 
the Filters tab.

Important 
Information

➤ Sort the information displayed in the Filters tab 
according to the entries in any column by clicking 
the column header. Toggle between ascending and 
descending order by clicking the header again.

➤ If you select (in View Explorer) a specific CI, the 
filter works only on the CI’s subtree. 

➤ If you select the view's root, the filter is applied to 
the whole view.

➤ Hold the cursor over a CI to display its full name in a 
tooltip.

Customizable: For details, see “Add a Details Link to 
CIs in the Filters Page” on page 105.

Included in Tasks “Display and Customize a View Information in Filters” 
on page 96

Useful Links “About the Filters Tab” on page 93

“Naming Conventions” in Reference Information

“View Explorer” in Reference Information

“Real-Time Changes to CI Properties” on page 23
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Filter Definition Area

The area includes the following elements (listed alphabetically):

GUI Element Description

Click to toggle the sound on or off. The sound plays 
when a CI changes status to Critical (red), to provide an 
aural notification of the change in status. 

If you want to use another alert sound for Dashboard, 
access <HP Business Availability Center server root 
directory>\AppServer\webapps\site.war\bam\pages
\sounds and replace the ding.wav file with your own 
WAV file (you must rename your file ding.wav).

Note: The change takes effect immediately.

Active Filters link Define or modify active filters in the Defining/Editing 
Filters dialog box. For more information, see 
“Defining/Editing Filters Dialog Box” on page 271.

Apply  To apply the Quick Filter selection to the display.
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List of existing filters Select a filter from the Active Filters list. The filter can 
be one of the predefined filters or a custom filter.

Quick Filter by 
Statuses

Quick Filter enables you to display CIs whose KPIs have 
one of the selected statuses. The filter is a temporary 
filter that persists until you log off, until you change its 
selection of statuses, or until you select another filter.

After you have selected a combination of filters to 
display a view’s data, you can further refine the report 
by selecting specific KPI’s statuses. The CIs that are 
displayed have at least one of their KPIs with one of the 
selected statuses.

Select a combination of KPI statuses in the Quick Filter 
bar. You can also use one of the options in the list to 
further filter the results:

➤ All. To display all types of CIs whose KPIs match the 
selected combination of KPI statuses selected in 
Quick Filter.

➤ Monitors only. To display only the monitor CIs 
whose KPIs match the selected combination of KPI 
statuses selected in Quick Filter.

➤ All excluding monitors. To display all types of CIs, 
except the monitor CIs, whose KPIs match the 
selected combination of KPI statuses selected in 
Quick Filter.

Note: You cannot save the settings you selected in 
Quick Filter, but you can create a similar filter using 
Active Filter. For details, see “Defining/Editing Filters 
Dialog Box” on page 271.

GUI Element Description
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Filtered CIs Area

The area includes the following elements (listed alphabetically):

GUI Element Description

Indicates that at least one change-monitored property 
of the CI’s child CIs has changed. 

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details about setting this feature, see “Analyze Real-
Time Change Information” on page 39.

Indicates that at least one change-monitored property 
of CI itself has changed. 

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details about setting this feature, see “Analyze Real-
Time Change Information” on page 39.

Indicates that at least one change-monitored property 
of the CI and at least one change-monitored property 
of the CI’s child CIs have changed. 

Hold the cursor above the icon to display a tooltip that 
provides more information about the change. The 
tooltip header indicates whether the change was made 
to the CI, the CI’s child CIs, or both. The tooltip body 
lists the CIs that were changed. 

For details about setting this feature, see “Analyze Real-
Time Change Information” on page 39.
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<Tooltip> Move the cursor above a KPI status icon to the Details 
tooltip that includes the following information: the 
name of the KPI and the name of the CI, the name of 
the rule used to calculate the KPI status, and the time 
and date when the KPI status changed to the current 
status.

Ack Displays an icon that represents the CI 
Acknowledgment status.

Note: A tooltip for the Ack icon displays the current 
status of the CI’s acknowledgment.

The acknowledge utility enables you to track 
performance problems identified in the system and 
network infrastructure by keeping a record of when the 
problem was acknowledged and by which user. You can 
access the utility using context menu options or by 
clicking the Ack icon  that is displayed in an Ack 
column in some of the Dashboard tabs.

Note: A user with the appropriate permissions can 
show or hide the Ack column in the Dashboard 
application. To do that, select Admin > Platform > 
Setup and Maintenance > Infrastructure Settings, click 
Applications context, select Dashboard Application, 
and locate the Show CI Acknowledgment column in 
the Business Console area. Select false to hide the Ack 
column and true to display the Ack column. The 
change takes effect immediately. 

Held Status Since The time and date when the KPI status changed to the 
current status.

KPIs Displays text or an icon indicating the current 
operational status of each CI. For an explanation of the 
color coding for status icons, see “Understanding KPI 
Status” on page 203. 

GUI Element Description
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Find Visible and Hidden Child CIs Dialog Box

The dialog box includes the following elements (listed alphabetically):

Last Update Shows connectivity with the Dashboard servlet, 
running on the Tomcat servlet engine by displaying 
the time the information in the tab was last updated.

Name Displays the filtered list of CIs. You can click a specific 
CI name to move to that CI in the Console tab. The 
relevant CI is shown highlighted in the View Explorer. 
The arrow to the right of a CI name opens the options 
menu for the CI. For details, see “Dashboard Menu 
Options” on page 40. 

Description Enables you to list all of the selected CI’s child CIs that 
appear in the CMDB (visible and hidden). 

To access: In the Console, or Filter tab in Dashboard, 
right-click the CI and select the Find Visible and 
Hidden Child CIs option.

Important 
Information

A CI’s child CIs can be specified as included (visible) or 
excluded (hidden) in a specific view. The status of any 
child CI, visible or hidden, has an impact on the status 
of its parent CI in any view where the parent CI 
appears. For details about including or excluding child 
CIs, see “Include Related CIs” in IT World Model 
Management.

Included in Tasks “Visible and Hidden Child CIs” on page 24

GUI Element Description

<KPI> The name of the child CI’s KPI and its status.

<Top part of page> Displays the name of the selected CI, whose child CIs 
you want to list, the CI’s KPIs, and their status in the 
current view.

GUI Element Description
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Name The name of the child CIs (visible and hidden) that 
appear in the CMDB.

Search Click to perform a search for the CIs whose names 
include the selected child CI’s name string in all views, 
and display the results in the View Explorer search 
page. For details, “View Explorer” in Reference 
Information.

From the View Explorer search page, click the 
appropriate CI in the list to display more information 
about the selected CI in the selected view. If the CI is 
not visible in any view, in Dashboard, the following 
message is displayed: Search is complete. There are no 
results to display for the current search parameters.

Note: The CI is not visible in any view in the following 
situations:

➤ It is included in the CMDB but does not belong to 
any view.

➤ It belongs to a view but the Exclude all child CIs 
option has been selected for its parent CI in that 
view. For details, see “New CI Wizard” in IT World 
Model Management.

For more details, see “Visible and Hidden Child CIs” on 
page 24.

Visible A checkmark indicates that the child CI is visible in the 
view.

An X indicates that the child is hidden in the view.

GUI Element Description
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Geographical Map Page

Description Enables you to display real-time status indicators on a 
geographical map, with the view's CIs at the 
geographical locations they were assigned. The status 
indicator shows the worst status of the CIs at the 
geographical location. You can also access detailed 
information about the CI’s KPIs. 

When you magnify the map, the main cities appear for 
the part of the map that is displayed on the screen.

The geographical map display can be rendered using:

➤ Virtual Earth. For details, see “Using Virtual Earth” 
on page 283.

➤ A maps applet. For details, see “Using the Map 
Applet” on page 286.

➤ Google Earth. For details, see “Using Google Earth 
(Admin)” on page 288.

To Access: 

➤ Select Admin > Dashboard, and click the 
Geographical Map tab.

➤ Select Applications > Dashboard, and click the 
Geographical Map tab.

Important 
Information

The Geographical Map tab shows a different display, 
depending on the type of setup you have selected. The 
types of setups are: Virtual Earth, Map Applets, or 
Google Earth (available only in Dashboard 
Administration). For details, see “Select the Display 
Technology” on page 115.

Included in Tasks “Display and Customize a View in Geographical Map” 
on page 112

Useful Links “Understanding Geographical Maps” on page 108

“View Explorer” in Reference Information
282



Chapter 11 • Dashboard User Interface
Using Virtual Earth

The page includes the following elements (listed alphabetically):

Description If you have an Internet connection, you can display 
the geographical map using Microsoft MSN Virtual 
Earth (Version 4.0) in Dashboard Geographical Map 
tab. HP Business Availability Center integrates Virtual 
Earth online mapping functionality, available over 
MSN, to enable you to use the geographical map of a 
view. 

Virtual Earth geographical maps are based on Microsoft 
Network (MSN) technology and use dynamic HTML.

The Virtual Earth geographical map presents a flat 
geopolitical view of the planet where you can display 
only the country borders, only the geographical 
features, or both. 

When you magnify the view, the main cities appear for 
the part of the map that is displayed on the screen.

Useful Links “Understanding Virtual Earth” on page 111

“View Explorer” in Reference Information

GUI Element Description

Enable you to zoom in and out to enlarge or shrink the 
map. 

Note: You can save the adjustments that you make in 
Dashboard Administration. The adjustments you make 
in Dashboard Application are lost when you change 
tab or application.

Click to shift the center of the map to the nearest CI.

Note: You can save the adjustments that you make in 
Dashboard Administration. The adjustments you make 
in Dashboard Application are lost when you change 
tab or application.
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Click to zoom out completely.

Note: You can save the adjustments that you make in 
Dashboard Administration. The adjustments you make 
in Dashboard Application are lost when you change 
tab or application.

 This icon is only available in Dashboard Application.

Click to open the map on a standalone page. 

Close the page to return to Dashboard.

<Adjustments> ➤ Click the map and drag to move the map in the 
window.

➤ Double-click the map to zoom in.

Note: You can save the adjustments that you make in 
Dashboard Administration. The adjustments you make 
in Dashboard Application are lost when you change 
tab or application.

<Status of a location> The geographical map of the view displays the worst 
status at each geographical location. 

The color coding is the same as for other icons in 
Dashboard. For more information about color coding, 
see “Understanding KPI Status” on page 203. 

The round icon represents the status of a location 
when at least one of the CIs is not a monitor CI.

The square icon represents the status of a location 
where all the CIs are monitor CIs.

<Tooltip> Move the cursor above a status icon to display the 
location tooltip that provides the worst status for all 
KPIs associated with the location. A KPI is associated 
with a location if that KPI is assigned to at least one of 
the CIs attached to the location. For details about the 
contents of the tooltips, see “Geographical Map 
Tooltips” on page 109.

<View> When you select a view in View Explorer, the 
Geographical Map tab displays the selected view bar 
centered in the tree with all its root CIs expanded. 

GUI Element Description
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2D

Click to display the map in two-dimensional format.

3D

Click to display the map in three-dimensional format.

Note: This is available only if you have Windows XP 
installed on your local computer.

Last Update Shows connectivity with the Dashboard servlet, 
running on the Tomcat servlet engine by displaying 
the time the information in the tab was last updated.

open In a Virtual Earth map, open the map in a standalone 
page by clicking open to explore the map in one 
window and perform other tasks in the main BAC 
window.

Road/Aerial/Hybrid Click:

➤ Road to display the map with the country borders

➤ Aerial to display the map with the topographical 
features

➤ Hybrid to display the map with both the country 
borders and the topographical features

Note: You can save the adjustments that you make in 
Dashboard Administration. The adjustments you make 
in Dashboard Application are lost when you change 
tab or application.

Search Use this feature to perform a search in Microsoft MSN 
Virtual Earth (outside of HP Business Availability 
Center). 

GUI Element Description
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Using the Map Applet 

The area includes the following elements (listed alphabetically):

Description If you do not have an Internet connection, the 
Geographical Map page displays a maps applet graphic 
instead of a Virtual Earth map. 

The Geographical tab displays the worst status at each 
geographical location and detailed information about 
the CI’s KPIs. 

The map applet present a flat geopolitical view of the 
planet. 

Useful Links “Understanding the Maps Applet” on page 112

“View Explorer” in Reference Information

GUI Element Description

 Enable you to zoom in and out to enlarge or shrink the 
map.

Note: You can save the adjustments that you make in 
Dashboard Administration. The adjustments you make 
in Dashboard Application are lost when you change 
tab or application.

<Adjustments> Click the area that interests you. The map shifts to 
make the location you clicked the new center of the 
map.

Note: You can save the adjustments that you make in 
Dashboard Administration. The adjustments you make 
in Dashboard Application are lost when you change 
tab or application.

<Status of a location 
with group CIs or 
with monitor CIs>

The geographical map of the view displays the worst 
status at each geographical location. 
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<Status of a location> The geographical map of the view displays the worst 
status at each geographical location. 

The color coding is the same as for other icons in 
Dashboard. For more information about color coding, 
see “Understanding KPI Status”. 

The round icon represents the status of a location 
when at least one of the CIs is not a monitor CI.

The square icon represents the status of a location 
where all the CIs are monitor CIs.

<Tooltip> Move the cursor above a status icon to display the 
location tooltip that provides the worst status for all 
KPIs associated with the location. A KPI is associated 
with a location if that KPI is assigned to at least one of 
the CIs attached to the location. For details about the 
contents of the tooltips, see “Geographical Map 
Tooltips” on page 109.

<View> When you select a view in View Explorer, the 
Geographical Map tab displays the selected view bar 
centered in the tree with all its root CIs expanded. 

GUI Element Description
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Using Google Earth (Admin)

The area includes the following elements (listed alphabetically):

Description Displays the worst status at each geographical location 
and detailed information about the CI’s KPIs. 

Google Earth presents a three-dimensional view of the 
planet. When you magnify the view, the main cities 
appear for the part of the map that is displayed on the 
screen.

Important 
Information

Note to HP Managed Software Solutions: This feature 
is not available when working with HP Managed 
Software Solutions.

Notes: 

➤ The integration of CI locations with your Google 
Earth installation is at the beta stage.

➤ This feature is only available from Dashboard 
Administration.

Useful Links “Understanding Google Earth” on page 110

“View Explorer” in Reference Information

GUI Element Description

<Places area> Select the view and filter the CIs you want to display.

<Status of a location> The geographical map of the view displays the worst 
status at each geographical location. 

The map presents color-coded status indicators that 
represent the worst status at each geographical 
location. The color coding is the same as for other 
icons in Dashboard. For more information about color 
coding, see “Understanding KPI Status” on page 203. 

The round icon represents the status of a location with 
group CIs.

The square icon represents the status of a location with 
monitor CIs.
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Node Details Dialog Box

The dialog box includes the following elements (listed alphabetically):

<Tooltip> Move the cursor above a status icon to display the 
location tooltip that provides the worst status for all 
KPIs associated with the location. A KPI is associated 
with a location if that KPI is assigned to at least one of 
the CIs attached to the location. For details about the 
contents of the tooltips, see “Geographical Map 
Tooltips” on page 109.

<Zoom and 
directions tools>

Enable you to zoom in or out of the current display 
and to scroll.

Description Enables you to view CMDB details about the CI.

To Access: In the Console or Filters tab, click Details for 
the appropriate CI.

GUI Element Description

Calc Rule ID The ID number of the calculating rule.

CMDB ID The internal CMDB ID corresponding to the CI (the 
value returned by the field entity_id).

CMDB Property 
Name

The name of the CMDB property.

CMDB Property 
Value

The value of the CMDB property.

KPI CMDB ID The internal CMDB ID corresponding to the KPI (the 
value returned by the field kpi_id).

Result The result of the calculation.

System KPI (x) Where x is the KPI ID (the value returned by the field 
kpi_type).

GUI Element Description
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Topology Map Page

Description Displays the results of a pattern or an instance view. 
You set up the topology map by creating an instance 
view or pattern view in View Manager. The topology 
map shows the results of the currently selected view in 
the View Explorer, and consists of CIs and relationships 
that are defined in the view you created in View 
Manager.

To Access: Select Applications > Dashboard and select 
the Topology Map tab. In View Explorer, select the 
required view from the View list.

Important 
Information

For information on pattern and instance views, see 
“Working with Pattern and Instance Views in 
IT Universe Manager” in IT World Model Management. 

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Context menu options are available from View 
Explorer. For details, see “Dashboard Menu Options” 
on page 40.

From the Topology Map tab, the Open in Console 
context menu option is available to open the Console 
tab opens and displays the selected CI and its direct 
child CIs. For details, see “Console Page” on page 262.

Included in Tasks “Display and Customize a View Information in the 
Topology Map” on page 136

Useful Links “Understanding the Dashboard Topology Map” on 
page 133

“View Explorer” in Reference Information
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The page includes the following elements (listed alphabetically):

Top View Page

GUI Element Description

<Node> The nodes in the topology map represent CIs.

Hold the pointer over a node to display its tooltip which 
describes the type of the CI.

<Relationship> The links in the topology map represent relationships.

Hold the pointer over a relationship to display its tooltip, 
which describes the type of the relationship.

<Toolbar> For details, see “Toolbar Options” in Reference Information.

Last Update Note: This only appears in the Topology Map in 
Dashboard.

Shows connectivity with the Dashboard servlet, running 
on the Tomcat servlet engine by displaying the time the 
information in the tab was last updated.

Description Enables you to see the business availability of your 
system components at a glance. The CI bars in the tab 
provide a visual representation of real-time IT 
performance metrics mapped onto business 
applications, based on the hierarchy tree structure 
defined for each view. The connecting lines between 
the bars define the relationships between the CIs.

To Access: Select Applications > Dashboard, select a 
view in View Explorer, and click the Top View tab.
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Important 
Information

Do not select a new view in the Role-Based Views list 
until the currently selected view has finished loading. 
Doing so may cause the browser to freeze. If this 
happens, close the Top View page, then close any other 
open pages, and reopen the page.

Note: You can add this report as a portlet in My BAC. 
For details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Functionality:

➤ Click anywhere in the tab to change the emphasis of 
the graphic. The graphic rotates to display the 
components of the subtree for the nearest bar.

➤ Click and drag anywhere in the tab to move and 
rotate the graphic around that point.

➤ Increase or reduce the gap between each branch by 
holding down the ALT button on the keyboard and 
dragging in the tab.

➤ When you open the Top View tab, it displays by 
default the active view at the root level, centered 
around the view name bar. Any manipulation you 
do to the graphic is not saved; if you move to 
another tab, then when you open the Top View tab 
again it reverts to the default display format.

Included in Tasks “Display and Customize View Information in Top 
View” on page 70.

Useful Links “Understanding Top View” on page 68

“View Explorer” in Reference Information
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The page includes the following elements (listed alphabetically):

GUI Element Description

<CIs, Child CIs, and 
Root CIs>

The tree is built from branch parent and children 
configuration items (CIs) and monitor CIs. For details, 
see “Working with CIs” in IT World Model Management. 

Right-click a bar to display the context menu options. 
For details, see “Top View Menu Options” on page 75.

Click a bar to move the bar to the center of the graphic.

When you select a CI in View Explorer, Top View 
displays the selected CI centered in the tree with all its 
sub-branches expanded. If you select a CI in the Top 
View tree, it is highlighted in the View Explorer. 

<KPIs and their 
statuses/values>

For each CI, Dashboard displays the CI’s KPIs and their 
real-time status as a color-coded icon (LED). For details, 
see “Understanding KPI Status” on page 203.

For details about the icons, see “KPI Icons in Top View” 
on page 73.
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<View bar> When you select a view in View Explorer, Top View 
displays the selected view bar centered in the tree with 
all its root CIs expanded. 

➤ Expand and collapse the branches of a subtree by 
clicking the expand (+) or collapse (-) symbols, 
displayed in the bottom right corner of the bar. 

➤ When branches are too long to fit on the screen, Top 
View displays lines emerging from the bar, to 
indicate the number of branches and leaves that are 
hidden. Click the end of one of these lines to display 
the entire hidden branch.

Hold the cursor over a bar to enable the following 
functionality:

➤ The bar is outlined in grey.

➤ If the CI has a long name, the bar expands to display 
the full name.

➤ A tooltip is displayed, providing status and 
performance data in each KPI for the item. 

<View Explorer> When you select a CI in View Explorer, Top View 
displays the selected CI centered in the tree with all its 
sub-branches expanded. If you select a CI in the Top 
View tree, it is highlighted in the View Explorer. 

Acknowledgment 
Details

Right-click a CI bar and select this option to display 
acknowledgment information for the CI. For details, 
see “Acknowledgment” on page 42.

GUI Element Description
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Expand more levels Right-click a CI bar and select this option to open a 
number of levels (7 by default) below the selected level.

Expand to problem Right-click a CI bar and select this option to collapse 
the branches where CIs do not have critical or major 
statuses.

Last Update Shows connectivity with the Dashboard servlet, 
running on the Tomcat servlet engine by displaying 
the time the information in the tab was last updated.

NOC View Click to display the top view tree in a separate window 
to be used by a Network Operations Center (NOC). 

To return to the Top View tab, close the Top View 
standalone window.

Only one instance of Top View can be displayed at a 
time; this means that if you are displaying the top view 
in the NOC View standalone window, you do not see it 
in the Top View tab and vice versa. 

Open in new window Right-click a CI bar and select this option to open a 
popup window that contains the page accessed by the 
specified URL. This is useful to open external 
applications. 

By default, this option does not appear in the menu. 
For details on setting this option, see “Access an 
External Application from Top View” on page 71.

Set/Unset 
Acknowledgment

Right-click a CI bar and select this option to set or clear 
the CI acknowledgment. For details, see 
“Acknowledgment” on page 42.

View in Console Right-click a CI bar and select this option to view the 
CI’s branch in the Console tab. For details, see 
“Console Page” on page 262.

GUI Element Description
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12
Reports User Interface

This chapter includes the pages and dialog boxes that are part of Dashboard 
reports user interface.

This chapter describes: On page:

Configuration Items Dialog Box 298

KPIs Dialog Box 299

KPIs Distribution Over Time Report 300

KPIs Over Time Report 303

KPIs Summary Report 308

KPIs Trend Report 311

Related Change Requests Report 314

Service Impact Report 316

Statuses Dialog Box 319
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Configuration Items Dialog Box

The dialog box includes the following elements (listed alphabetically):

Description Enables you to select the CIs to be included in a 
Dashboard report, for the duration of a Web session. 
The report provides information based on the selected 
CIs.

To access: In a Dashboard report, click Configuration 
Items in the reports settings area.

Important 
Information

➤ When selecting CIs for the KPI Summary, KPI Trend, 
and KPI Distribution Over Time reports, only CIs 
that meet the following criteria are available for 
selection in the Configuration Items dialog box:

➤ The CIs have attached KPIs.

➤ The CIs are flagged to save KPI data over time 
(historical data). For details, see “Persistent Data 
and Historical Data” on page 214.

➤ The CI types are defined for inclusion in these 
reports; by default, Application, Business Process, 
Business Service, and Line of Business CITs are 
defined for inclusion. (Contact Customer Support 
if you need to change the supported CITs.)

➤ When selecting CIs for the KPIs Over Time report, 
only non-monitor (leaf) CIs are available for 
selection. 

➤ Only CIs are flagged to save KPI data over time 
(historical data) appear in the KPIs Over Time report 
For details, see “Persistent Data and Historical Data” 
on page 214.

GUI Element Description

Click the required button to select all CIs, clear all CIs, 
or reverse the current selection.

Browse The default mode for the Configuration Items dialog 
box, enabling you to select a view and CIs.
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KPIs Dialog Box

Search Click Search to move to Search mode, where you can 
search for CIs. For details, see “View Explorer” in 
Reference Information.

View Select the relevant view from the dropdown list (start 
typing in the view name to filter the list), or click the 
ellipse button to open the Select View dialog box, 
where you can select a view from the view folders tree.

Note: Only the CIs selected in the currently displayed 
view are saved for the report filter when you click OK. 
If you select another view before clicking OK, all 
previous CI selections are discarded.

<View tree> Displays the CIs in the selected view. Select the check 
boxes for the required CIs.

Description Enables you to select the KPIs to be included in a 
Dashboard report, for the duration of a Web session. 
The report provides information based on the selected 
KPIs.

To access: In a Dashboard report, click KPIs in the 
reports settings area.

Important 
Information

You must define at least one CI for the report before 
you can select KPIs. After selecting CIs, the Application 
KPI is in some cases selected automatically (if it is 
attached to the selected CIs).

GUI Element Description
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The dialog box includes the following elements (listed alphabetically):

KPIs Distribution Over Time Report

GUI Element Description

Click the required button to select all KPIs, clear all 
KPIs, or reverse the current selection.

KPIs Lists the KPIs that are attached to the selected CIs. 
Availability and Performance are listed first, then all 
other KPIs in alphabetical order.

Select the check boxes for the required KPIs.

Description Enables you to analyze KPI trend by viewing KPI status 
distribution over time for selected statuses.

To access:

➤ Select Applications > Dashboard > Reports tab > KPIs 
Distribution Over Time

➤ Select My BAC and move to the Dashboard Reports 
page

Important 
Information

➤ This report is produced only for certain CIs with 
historical KPI data. For details, see “Configuration 
Items Dialog Box” on page 298.

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Useful Links “Working with Dashboard Reports” on page 142
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Report Settings

GUI Element Description

<Common report 
settings>

See “Understanding Common Report Elements” in 
Reference Information.

Configuration Items Displays the name of the selected CI for the report, or if 
more than one is selected, indicates the number of CIs 
that the report is based on; for example, Filtered (4) 
means that four CIs are selected for inclusion in the 
report.

Click the Configuration Items link to open the 
Configuration Items dialog box where you can select 
CIs.

KPIs Indicates the number of KPIs that are included in the 
report, out of the total number of KPIs that are 
attached to the selected CIs; for example, Filtered 
(1/3). 

All is displayed when all available KPIs are selected.

Click the KPIs link to open the KPIs dialog box where 
you can select KPIs.

Default value: If the Application KPI is attached to any 
of the selected CIs, then this KPI is selected 
automatically.

Statuses Indicates the number of statuses that are included in 
the report, out of the 7 possible statuses, for example, 
Filtered (5/7).

Click the Statuses link to open the Statuses dialog box 
where you can select statuses.

Default Value: All statuses that are defined as 
non-critical are selected, and All Non-Critical Statuses 
is displayed. For details, see “Statuses Dialog Box” on 
page 319.
301



Chapter 12 • Reports User Interface
Report Content

The report includes the following elements (listed alphabetically):

GUI Element Description

<Bar chart> Each KPI instance for each CI is displayed in a separate 
bar chart (as long as there is relevant data for the KPI 
on that CI). Each chart shows status distribution (in 
percentage) for the KPI over the selected time frame. 

<Bar> Each bar in a chart represents a time interval, 
according to the granularity selected for the report. For 
example, if the selected granularity is every 1 week, 
then each bar represents a week during the overall time 
frame. The legend for the x-axis shows the time 
interval for each bar.

Each bar is divided into colored status sections, 
according to the statuses selected for inclusion in the 
report, so that each section represents the percentage 
of time that the status was held by the KPI during that 
time interval.

Tooltip: Hold the pointer over a bar section to display a 
tooltip containing the following information:

➤ Status. The name of the status represented by the 
section.

➤ Status Duration. Amount of time that the KPI held 
this status during the time interval. This can be 
given in hours, minutes, and seconds (for example, 
01:10:48) or in days and hours (for example, 30 
days, 9 hours).

➤ Status Percentage. Percentage of the time interval 
that the KPI held this status. 
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KPIs Over Time Report

Description Enables you to view the status or the value, over time, 
of selected KPIs and CIs, in table or graph format.

To access: Select Applications > Dashboard, > Reports 
tab > KPIs Over Time. The report is also available from 
the context menu of CIs in Dashboard.

Important 
Information

➤ To display the KPIs Over Time report make sure that 
the Save historical data for this CI option has been 
selected for the CI. For details, see: “KPIs Page” on 
page 324.

➤ To display the KPIs Over Time report with values 
data, make sure that you also have the 
saveValuesToPersistency global attribute set to true 
in all of the rules. For details, see “Global Attributes 
Dialog Box” in CI Attribute Customization.

Note: If this option is selected, data on status and 
measurements over time for a CI is saved in the 
database. The persistent data is used to produce KPIs 
over time reports and Business Dashboard reports, as 
described in “KPIs Over Time Report” on page 303.

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in My BAC.

➤ If you select a future date in the To setting in the 
report settings, the report is not generated and an 
error message is issued.

Included in Tasks “View KPIs Over Time Information” on page 170

Useful Links “Understanding the KPIs Over Time Report” on 
page 143
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Report Settings

The area includes the following elements (listed alphabetically):

GUI Element Description

<Common report 
settings>

See “Understanding Common Report Elements” in 
Reference Information.

Configuration Items Indicates the number of CIs that are included in the 
report, for example, Filtered (4) means that four CIs 
are selected for inclusion in the report.

To select CIs, click the Configuration Items link. For 
details, see “Configuration Items Dialog Box” on 
page 298.

KPIs Indicates the number of KPIs that are included in the 
report, out of the total number of KPIs that are defined 
for the selected CIs, for example, Filtered (1/3). 
All is displayed when all available KPIs are selected.

To select KPIs, click the KPIs link. For details, see “KPIs 
Dialog Box” on page 299.

Default value: When you select one or more CIs and 
the Performance and Availability KPIs are assigned to 
those CIs, the KPIs are automatically selected.

Report type Select:

➤ Statuses. To display the status information in the 
report. For details, see “KPIs Over Time Report with 
Status Data” on page 305. The KPIs Over Time report 
with status data displays only the status of the 
selected KPIs for the selected CIs. Those KPIs may 
also have values in the HP Universal CMDB but the 
report does not show the values. 

➤ Values. To display the value information in the 
report. For details, see “KPIs Over Time Report with 
Value Data” on page 307. The KPIs Over Time report 
with values data displays only the value of the 
selected KPIs for the selected CIs. Those KPIs may 
also have statuses in the HP Universal CMDB but the 
report does not show the statuses. 
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KPIs Over Time Report with Status Data

The page includes the following elements (listed alphabetically):

GUI Element Description

Click to display status information about the children 
that contribute to the status of the selected CI’s KPI. 
For details, see “Drilling Down to Influencing Children 
in KPIs Over Time Reports with Status Data” on 
page 148.

Click to display status information about the parents of 
the CI whose status is influenced by the status of the 
selected CI’s KPI. For details, see “Drilling Up to 
Influenced Parents in KPIs Over Time Reports with 
Status Data” on page 149.

<Drill down> This capability is available only in graph format.

Click a specific segment of the time period to drill 
down to that specific segment of time. For details, see 
“Drilling Down by Time Segments in Status KPIs Over 
Time Reports” on page 147.

<Tooltip> Move the cursor above the graph to display more 
information about the KPI. The background of the 
tooltip reflects the color of the status calculated by the 
rule attached to the KPI and according to the KPI’s 
objectives. The tooltip displays the name of the KPI in 
the tooltip title and the following information:

➤ Configuration Item. The name of the CI to which 
the current KPI is assigned.

➤ Status. The status of the KPI.

➤ Start Time. The time when an event occurred, 
starting the sampling period for that event.

➤ End Time. The time when a new event occurred, 
ending the sampling period of the previous event.

➤ Duration. The duration of the sampling period.

Configuration Item The name of the selected configuration item.
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Duration This field appears only in table format.

The duration of the sampling period.

End Time This field appears only in table format.

The time when a new event occurred, ending the 
sampling period of the previous event

KPI The name of the KPI. 

Start Time This field appears only in table format.

The time when an event occurred, starting the 
sampling period for that event.

Status The table format displays the status of each KPI of each 
CI, according to the selected granularity, during the 
selected time period.

The graph format displays the status of the KPI as a 
background color during the selected time period. A 
tooltip is available for each cell in the graph (see below 
for details).

GUI Element Description
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KPIs Over Time Report with Value Data

The page includes the following elements (listed alphabetically):

GUI Element Description

<Graph> Displays the value of the KPI assigned to a specific CI at 
the specified time (indicated by a colored line).

When you select two KPIs and more than one CI, each 
pair of KPIs is displayed in a separate graph. The left y-
axis displays the scale of the first KPI and the right 
y-axis displays the scale of the second KPI.

When you select one KPI, the Y-axis displays the scale 
for the KPI, a line displays the value of the KPI over 
time, and faint colored horizontal lines show the KPI 
objectives (the colors correspond to the objective 
colors of the KPI).

A legend lists the name of the CI, the name of the KPI 
and the color used to represent the KPI value.
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KPIs Summary Report

<Time period> This field appears only in table format.

Each column represents a time segment corresponding 
to the selected granularity of the selected time 
period. The table displays the value of the KPI in 
the time segment.

<Tooltip> This field appears only in graph format.

Move the mouse over any dot in the graph to display 
the value of the KPI at this point.

Configuration Item This field appears only in table format.

The name of the selected configuration item.

KPI This field appears only in table format.

The name of the KPI. Each selected KPI is displayed in a 
separate line.

Description Enables you to view a summary of KPI status 
distribution over time for each selected KPI.

To access:

➤ Select Applications > Dashboard > Reports tab > KPIs 
Summary

➤ Select My BAC and move to the Dashboard Reports 
page

Important 
Information

➤ This report is produced only for certain CIs with 
historical KPI data. For details, see “Configuration 
Items Dialog Box” on page 298.

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Useful Links “Working with Dashboard Reports” on page 142

GUI Element Description
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Report Settings

GUI Element Description

<Common report 
settings>

See “Understanding Common Report Elements” in 
Reference Information.

Configuration Items Displays the name of the selected CI for the report, or if 
more than one is selected, indicates the number of CIs 
that the report is based on; for example, Filtered (4) 
means that four CIs are selected for inclusion in the 
report.

Click the Configuration Items link to open the 
Configuration Items dialog box where you can select 
CIs.

KPIs Indicates the number of KPIs that are included in the 
report, out of the total number of KPIs that are 
attached to the selected CIs; for example, Filtered 
(1/3). 

All is displayed when all available KPIs are selected.

Click the KPIs link to open the KPIs dialog box where 
you can select KPIs.

Default value: If the Application KPI is attached to any 
of the selected CIs, this KPI is selected automatically.
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Report Content

The report include the following element:

GUI Element Description

<Pie chart> Each pie chart represents a KPI instance (name 
displayed at the top) for a CI (name displayed on the 
left), and summarizes the statuses for the KPI over the 
selected time frame (as long as there is relevant data for 
the KPI on that CI). 

Each pie chart is divided into colored status slices, so 
that each slice represents the percentage of time that a 
particular status was held by the KPI. 

Tooltip: Hold the pointer over a pie slice to display a 
tooltip containing the following information:

➤ Status. The name of the status represented by the 
slice.

➤ Status Duration. Amount of time that the KPI held 
this status during the time frame. This can be given 
in hours, minutes, and seconds (for example, 
01:10:48) or in days and hours (for example, 30 
days, 9 hours).

➤ Status Percentage. Percentage of the time that the 
KPI held this status

Functionality: Right-click a pie for animation 
functionality. For more information, see “Animating 
Report Charts with Macromedia Flash Player” in 
Reference Information.
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KPIs Trend Report

Report Settings

Description Enables you to analyze the trend for changes in KPI 
status over time, for selected statuses.

To access:

➤ Select Applications > Dashboard > Reports tab > KPIs 
Trend

➤ Select My BAC and move to the Dashboard Reports 
page

Important 
Information

➤ This report is produced only for certain CIs with 
historical KPI data. For details, see “Configuration 
Items Dialog Box” on page 298.

➤ Data is displayed in the report starting from the 
point that data was collected for the selected CIs. For 
example, if you set the report to show data every 
week for the past month, but data was collected 
only for the past two weeks, the report shows data 
from two weeks ago to the present date.

➤ You can add this report as a portlet in My BAC. For 
details, see “Add Portlets to <page_name>/Add 
Portlets Dialog Box” in Using My BAC.

Useful Links “Working with Dashboard Reports” on page 142

GUI Element Description

<Common report 
settings>

See “Understanding Common Report Elements” in 
Reference Information.

Configuration Items Displays the name of the selected CI for the report, or if 
more than one is selected, indicates the number of CIs 
that the report is based on; for example, Filtered (4) 
means that four CIs are selected for inclusion in the 
report.

Click the Configuration Items link to open the 
Configuration Items dialog box where you can select 
CIs.
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Report Content

The report include the following elements (listed alphabetically):

Group by Select a radio button to determine how the data is 
organized:

➤ CIs. A separate chart is displayed for each CI, 
containing trend data for all relevant KPIs.

➤ KPIs. A separate chart is displayed for each KPI, 
containing trend data for all relevant CIs.

KPIs Indicates the number of KPIs that are included in the 
report, out of the total number of KPIs that are 
attached to the selected CIs; for example, Filtered 
(1/3).

All is displayed when all available KPIs are selected.

Click the KPIs link to open the KPIs dialog box where 
you can select KPIs.

Default value: If the Application KPI is attached to any 
of the selected CIs, this KPI is selected automatically.

Statuses Indicates the number of statuses that are included in 
the report, out of the seven possible statuses, for 
example, Filtered (5/7).

Click the Statuses link to open the Statuses dialog box 
where you can select statuses.

Default Value: All statuses that are defined as 
non-critical are selected, and All Non-Critical Statuses 
is displayed. For details, see “Statuses Dialog Box” on 
page 319.

GUI Element Description

<Chart in report> A separate chart is displayed for each included CI, or 
for each included KPI, depending on the Group by 
filter selection. Each chart shows status trend (in 
percentage) over time, within the selected time frame. 
(as long as there is relevant data for the KPI on that CI)

GUI Element Description
312



Chapter 12 • Reports User Interface
<Line on chart> Each line on the chart represents the status trend for a 
specific KPI on a specific CI, based on a compilation of 
all statuses selected in the Statuses filter. A legend is 
given to distinguish each KPI or CI.

The points for the line are plotted at the intervals 
defined by the report granularity (the legend for the 
x-axis shows the time interval for each point), so that 
each point represents a period of time during the 
overall time frame.

Each point shows the percentage of time that the KPI 
held all included statuses during that time interval. For 
example, if the KPI had OK status for 10% of the time 
interval, and Warning status for 20%, and both of these 
statuses are included in the Statuses filter, then both 
periods are included in the total percentage (adding 
30% to the total).

Tooltip: Hold the pointer over a point on the line to 
display a tooltip containing the following information:

➤ Status Duration. The total time that the KPI held the 
included statuses during the time interval. This can 
be given in hours, minutes, and seconds (for 
example, 01:10:48) or in days and hours (for 
example, 30 days, 9 hours).

➤ Status Percentage. Percentage of the time interval 
that the KPI held the included statuses. 

Note: When one line is on top of another, the 
information is the same for both lines.

GUI Element Description
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Related Change Requests Report

Report Settings

Report Content

The report includes the following elements (listed alphabetically):

Description Enables you to view change request information from 
Change Control Management in HP Business 
Availability Center Dashboard. The report lists all 
change requests that impacted on the CI during the 
default time period. The list may include change 
requests that resulted in a direct change to the CI (a 
CCI), or that affected the CI as a result of a 
modification to the change request (an ACI).

To access: In Dashboard, right-click the relevant CI and 
select Go to Report > Related Change Requests.

Important 
Information

The Related Change Requests option is enabled only if 
HP Business Availability Center is configured to work 
with Change Control Management. For more 
information, see “View Related Change Requests 
Reports” on page 172. 

Included in Tasks “View Related Change Requests Reports” on page 172

GUI Element Description

<Common report 
settings>

See “Understanding Common Report Elements” in 
Reference Information.

GUI Element Description

Actual End Time The time at which execution of the change request 
ended.

Actual Start Time The time at which execution of the change request 
began.

Contact The owner of the selected change request.
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Description A linked description of the change request. The link 
opens the change request in the service desk system, 
where you can see more information on the requested 
change. (You may need to enter login information for 
the service desk system.)

Level The level of the change request in the hierarchy in 
Change Control Management. Possible values are 
Release or Change.

Severity The degree of impact of the change request. The 
severity level is defined in Change Control 
Management.

Status The status of the change request in Change Control 
Management. You can configure HP Business 
Availability Center to include additional status levels 
used in Change Control Management. For details, see 
“Understanding Deep Transaction Tracing Integration 
in Dashboard” on page 155.

GUI Element Description
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Service Impact Report

Business Services Summary Area

The area includes the following elements (listed alphabetically):

Description Displays information about the Business Service CIs 
impacted by the selected CI.

To access: In the Console or Filter tab, right-click the 
relevant CI and select Show Service Impact.

Important 
Information

If there are no Business Service CIs attached to the CI, 
the report is empty.

You can hide KPIs so they do not appear in the report. 
To do that, select Admin > Platform > Setup and 
Maintenance > Infrastructure Settings, choose 
Applications, select Dashboard Application, and locate 
the KPIs to hide in the report entry in the Dashboard 
Application - Service Impact table and add the KPI 
numbers separated by a comma. For example, to 
remove the Performance and Availability KPIs, enter 
6,7. Removing KPIs has an impact on the value/status 
of the CIs to which those KPIs are assigned.

Included in Tasks “View Service Impact Report” on page 174

GUI Element Description

Current Status The worst status of the KPI assigned to the selected 
Business Service CI.

Name The name of the Business Service CI impacted by the 
selected CI.

Click one of the Business Service CI in the list to 
display KPIs and SLA details in the <service> Service 
Details area. 
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Over Time Status 
Week to Date

The average status of the KPI over a predefined time 
period. The default is: week to date.

To modify the predefined time period, select Admin > 
Platform > Setup and Maintenance > Infrastructure 
Settings, choose Applications, select Dashboard 
Application, and locate the Default Over-Time Time 
Period entry in the Dashboard Application - Service 
Impact table and modify the entry value.

SLAs Current Status The worst status of all the SLAs where the Business 
Service CI is included. 

If the SLA Current Status is No Data and the SLAs table 
below the main table indicates: No information, the 
Business Service CI is not included in any SLA.

If the SLA Current Status is No Data and the SLAs table 
below the main table indicates: No Data, the Business 
Service CI is included in the SLA and the SLA worst 
status is No Data.

SLAs Forecasting The worst expected status of the SLAs where the 
Business Service CI is included. 

If the SLA Forecasting Status is No Data and the SLAs 
table below the main table indicates: No information, 
the Business Service CI is not included in any SLA.

If the SLA Forecasting Status is No Data and the SLAs 
table below the main table indicates: No Data, the 
Business Service CI is included in the SLA and the SLA 
Forecasting worst status is No Data.

GUI Element Description
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Service Details Area

The area includes the KPI and the SLAs tables.

KPI Table

The KPI table includes the following elements (listed alphabetically):

SLAs Table

The table includes the following elements (listed alphabetically):

GUI Element Description

Current Status The current status of the KPI assigned to the selected 
Business Service CI, as it appears in Dashboard.

KPI The list of KPIs attached to the selected Business 
Service CI.

Over Time Status The status of the KPI over a predefined time period, as 
it appears in the KPI Summary Report in Dashboard.

GUI Element Description

Current Status The current status of the SLA.

Customer The customer related to the SLA.

Expected Breach 
Date

The expected breach date of the SLA.

Forecasting Status The expected status of the SLA, based on extrapolation. 
For additional information, see “Business Services 
Summary Area” on page 316.

SLAs The list of SLAs where the selected Business Service CI 
is included. For additional information, see “Business 
Services Summary Area” on page 316.
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Statuses Dialog Box

Description Enables you to select the KPI statuses to be included in 
a Dashboard report, for the duration of a Web session. 
The report provides information based on the selected 
statuses.

To access: In a Dashboard report, click Statuses in the 
reports settings area.

Important 
Information

➤ You must define at least one CI for the report before 
you can select statuses. 

➤ When you first select the CIs for the report or open 
the report, the default status selection is 
automatically applied. The default selection is for all 
statuses that are defined as non-critical, meaning all 
statuses other than Critical.

You can modify the definition of non-critical 
statuses in the Infrastructure Settings page:
Select Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, choose Applications, select 
Dashboard Application, and locate the Default 
Non-Critical Statuses entry in the Business Report 
Properties table. Modify the value to include or 
exclude the required statuses.
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KPIs User Interface

This chapter includes the pages and dialog boxes that are part of 
Configuring a KPI user interface.

 

Context Menus List Editor Dialog Box

This chapter describes: On page:

Context Menus List Editor Dialog Box 321

Event Details Dialog Box 322

KPIs Page 324

New KPI/Add KPI to Multiple CIs/Edit KPI/Edit KPI for Child 
Transaction Dialog Box

328

Description Enables you to select the context menus you want to 
assign to the CI.

To Access: Click Edit in the KPIs page.

Important 
Information

Move the context menus from the Available Context 
Menus box to the Active Context Menus box, the other 
way around, using the arrows.
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Event Details Dialog Box

Description Enables you to display data from the last sample that 
arrived for a monitor CI; this includes all of the 
parameters for the CI, and the parameter values at the 
last update.

To Access: From the Console or Filters tabs in 
Dashboard, click the status icon for a monitor CI. (If 
there is an associated Event Details dialog box for a CI, 
then the cursor changes to a hand when you hold the 
cursor over the status icon for the CI.)

Important 
Information

To view the Event Details dialog box for CIs, you must 
configure Dashboard to save the last sample for the CI. 
You can configure this per KPI rule (so that you only 
see sample details for a monitor CI under that KPI), or 
for all rules. For details on how to do this, see “View 
Sample Details” in Using Dashboard.

Note: Storing last sample details may require use of a 
large amount of memory, slowing down Dashboard 
performance.

Note: You can open as many Event Details dialog boxes 
as required; if you move to another application or 
administration page in HP Business Availability Center, 
any open Event Details dialog boxes are closed.

Included in Tasks “View Sample Details” on page 34
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The dialog box includes the following elements (listed alphabetically):

GUI Element Description

Event Message area Displays the details for the CI (according to the KPI) at 
the last update. 

Note: The Event Details dialog box is not automatically 
refreshed when there is a new update for the CI. You 
can refresh by right-clicking in the dialog box (outside 
of the Event Message panel) and selecting Refresh, or 
by closing and reopening the dialog box.

Event Source area Contains parameters providing information on the KPI 
(in the Dimension name field) for which the event 
details are relevant, the date and time of the last update 
to the CI, and the CI status at that update.
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KPIs Page

KPIs area

The area includes the following elements (listed alphabetically):

Description If you select a CI in View Explorer (not the root CI), the 
KPIs page displays the KPIs and associated business 
rules defined for the selected CI.

If you select the root CI in View Explorer, the KPIs 
page display all the view's KPIs when you expand the 
KPI Selection area. 

To Access: Select Admin> Dashboard, click the KPIs tab, 
and select the required view and then the required CI 
in the View Explorer in the left pane. (For information 
on using View Explorer, see “View Explorer” in 
Reference Information.)

Important 
Information

➤ You can sort the information displayed in the KPIs 
table by clicking on the column header. You can 
switch the column between ascending and 
descending order by clicking the header again.

➤ Selecting a view’s root CI in the KPIs page, enables 
you to limit the KPIs that are displayed for a view in 
Dashboard. Status in Dashboard is calculated based 
on visible KPIs only. This means that any excluded 
KPI has no influence on the overall status 
calculations made for CIs or locations in the Top 
View, Geographical Map, Custom Map, or Topology 
Map tabs. 

Included in Tasks “Configure a KPI” on page 215

GUI Element Description

Click to edit an existing KPI for a CI (or for multiple 
transaction CIs), as described in “New KPI/Add KPI to 
Multiple CIs/Edit KPI/Edit KPI for Child Transaction 
Dialog Box” on page 328.
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Click to edit the KPIs for the child transactions. For 
details, see “New KPI/Add KPI to Multiple CIs/Edit 
KPI/Edit KPI for Child Transaction Dialog Box” on 
page 328.

The Edit KPI for child transactions button is enabled for 
all KPIs, however:

➤ The option is only relevant Transaction and 
Availability KPIs (an error message is displayed for 
other KPIs).

➤ The option has validity only when there are 
Business Process Monitor transaction CIs contained 
in the subtree. 

Note: 

➤ Changes made in the Edit KPIs for Child Transaction 
window have no effect on KPIs other than 
Transaction and Availability, or on CIs for which the 
option does not apply.

➤ After applying the Edit KPI for child transactions 
option, a KPI was saved successfully message is 
displayed in the top-right corner of the page, even if 
no changes were made to any CIs.

➤ If a transaction CI in the subtree is using a business 
rule other than the default monitor rule for the KPI 
(Transaction Availability Rule or Transaction 
Performance Rule), then when you apply the Edit 
KPI for child transactions option, the existing rule is 
replaced with the default rule.

Click to delete a KPI attached to a CI.

Appears only when you select the root CI in View 
Explorer.

Click the required button to select all options, clear all 
options, or reverse the current selection.

GUI Element Description
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Business Appears only when you select the root CI in View 
Explorer.

A star indicates if the KPI is defined for the Business 
user mode. For details about user mode, see “KPIs for 
User Modes” on page 202.

Business Rule The name of the business rule attached to the KPI.

KPI The name of the KPI.

Monitor changes Set Dashboard to monitor (in real-time) changes made 
to the properties for a selected CI, or to the child CIs 
for the selected CI, as described in “Change the No 
Data Timeout Value for Transaction CIs” on page 245.

For a limited number of CIs (20 by default), Dashboard 
can monitor for changes to the CI properties (or 
changes to the properties of the CI’s child CIs) in 
real-time. To change the default, see “Set Up the Real-
Time Monitoring of CI Property Changes” on page 226

This information is in addition to the Dashboard 
Change Report, which shows a historical report on 
changes to properties for CIs over a period of time. (For 
details on the Change Report, see “Change Report 
Page” in IT World Model Management.)

Note: The Monitor changes option is only enabled if:

➤ You are working in a shared CMDB environment.

➤ You enable change impact monitoring by selecting 
Admin > Platform > Setup and Maintenance > 
Infrastructure Settings, click Applications, select 
Dashboard Application, and locate the Host name 
for MAM GUI Web server entry in the Change 
Impact Properties table. Define the Web server name 
and restart HP Business Availability Center.

New KPI Click to attach a new KPI to the CI. For details, see 
“New KPI/Add KPI to Multiple CIs/Edit KPI/Edit KPI for 
Child Transaction Dialog Box” on page 328.

GUI Element Description
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Operations Appears only when you select the root CI in View 
Explorer.

A star indicates if the KPI is defined for the Business 
user mode. For details about user mode, see “KPIs for 
User Modes” on page 202.

Save KPI data over 
time for a CI

Click to set HP Business Availability Center to save KPI 
data for CIs, as described in “KPIs Over Time Report” 
on page 303.

You can enable/disable this option for multiple CIs by 
selecting the required CIs in View Explorer (using the 
keyboard CTRL key) and right-clicking one of the 
selected CIs. 

The option is selected by default for CIs of the 
following types: Business Process, Business Process 
Group, Line of Business, Application (logical 
application), and End User Management Application 
Related Group. The option is not available (disabled) 
for monitoring CIs. 

(If you also want to save data on the actual 
measurements for the KPIs, you must change the 
default settings for Dashboard in the Repositories, as 
described in “Change the No Data Timeout Value for 
Transaction CIs” on page 245.)

Saving status (and measurements) data for long periods 
or for many CIs can occupy a lot of database memory, 
so this option should be used with care. When you no 
longer require data to be saved for a CI, clear the check 
box.

GUI Element Description
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Context Menu area

The area includes the following elements (listed alphabetically):

New KPI/Add KPI to Multiple CIs/Edit KPI/Edit KPI for Child 
Transaction Dialog Box

GUI Element Description

Default Menu The default menu is, by default, assigned to the CI.

<Context menu> The name of the context menus that you assigned to 
the CI.

Edit Click to open the Context Menus List Editor dialog box 
where you select the context menus you want to assign 
to the CI.

Description Enables you to attach additional KPIs to any CI or to 
edit the properties of a CI’s KPIs. 

To Access: Click the KPIs tab and select:

➤ (Single CI) the required CI in View Explorer, and 
either click the New KPI/Edit KPI  button in the 
right pane, or right-click the CI in View Explorer and 
select Add KPI/Edit KPI. 

➤ (Multiple CIs) the required CIs in View Explorer 
using the keyboard Ctrl key, right-click one of the 
selected CIs in View Explorer, and select Add 
KPI/Edit KPI.

➤ (multiple transactions) the required group-level CI 
in View Explorer, and either click the Edit KPI for 
child transactions  button corresponding to the 
KPI (Performance or Availability) that you want to 
edit. 
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Important 
Information

There can be only one instance of each KPI for a CI. For 
each new KPI, you define the KPI type and business 
rule. Where relevant, you also define additional 
information required by the rule.

You can attach one of the default KPIs provided with 
HP Business Availability Center, or attach a KPI that 
you defined in the KPIs repository (as described in “Set 
Up a KPI” in CI Attribute Customization). When you 
attach a KPI to multiple CIs, the KPI is added to all CIs 
that do not already have that KPI attached. All 
instances of the KPI have the same defined business 
rule and properties. Attaching a new KPI to a CI, and 
defining the KPI properties, must be undertaken with 
care; these actions can result in KPIs that give an 
inaccurate performance assessment in Dashboard. Read 
the “Notes and Limitations for KPIs and CIs” on 
page 185 before proceeding.

For information on KPI functionality, see “How 
Dashboard KPIs Work” on page 184.

Note: Changes made in the Edit KPIs for Child 
Transaction window will have no effect on KPIs other 
than Transaction and Availability, or on CIs for which 
the option does not apply.

Included in Tasks “Configure a KPI” on page 215
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KPI Area

The area includes the following elements (listed alphabetically):

GUI Element Description

Hold the pointer over the question mark icon to 
display additional information for the rule.

Business Rule After selecting a KPI, the Business rule list is 
automatically updated to display all business rules that 
are relevant for the selected KPI. Select the required 
rule from the list. The rule is used to calculate the 
measurement and status for the KPI. For an 
explanation of the role of the rules, see “About 
Business Rules” on page 187. For information on each 
individual rule, see “List of Dashboard Business Rules” 
in CI Attribute Customization.

Note: You should only select a monitor rule if the KPI 
is attached to a monitoring CI. For more information, 
see “Monitor Rules” on page 188.

Important: After selecting a rule, the New KPI window 
is automatically updated to display the areas (Business 
Rule Parameters, Objectives, Selector, and so on) that 
are relevant for the selected rule.

KPI Select a KPI from the KPI list. The list contains the 
names of all available KPIs (KPIs that are already 
attached to the CI are not included in the list). For an 
explanation of each individual KPI, see “List of 
Dashboard KPIs and Their Details” in CI Attribute 
Customization.

Note: When defining a KPI for multiple CIs, the KPI list 
contains all KPI types.

OK If you do not define a selector for the KPI, then after 
clicking OK to close the New KPI window, HP Business 
Availability Center automatically assigns to the KPI the 
default selector (generally defined for the other KPIs 
attached to the monitoring CI).
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Business Rule Parameters Area

SLA If you are defining a PNR KPI, select the required values 
from the SLA list.

For information on defining the PNR KPI, see “Event 
Details Dialog Box” on page 322.

Time Interval If you are defining a PNR KPI, select the required values 
from the Time interval lists.

For information on defining the PNR KPI, see “Event 
Details Dialog Box” on page 322.

Tracking Period If you are defining a PNR KPI, select the required values 
from the Tracking period lists.

For information on defining the PNR KPI, see “Event 
Details Dialog Box” on page 322.

Description Enables you to view and modify the parameters 
relevant for the selected rule. All parameters have 
default values.

Important 
Information

If required, modify the parameter values by entering a 
new value in the appropriate boxes. The information 
after each box directs you as to the type of value that 
can be entered, for example, Any Number, Text, or 
Boolean.

For information on rule parameters and possible 
values, see the section for the relevant rule, as 
described in “List of Dashboard Business Rules” in 
CI Attribute Customization.

Multiple KPI selection. In the Business Rule Parameters 
area, the value box is empty. Enter the required value 
in the boxes. Make sure you enter values that apply 
logically to all transactions in the group. 

For information on rule parameters and possible 
values, see the section for the relevant rule, as 
described in “List of Dashboard Business Rules” in 
CI Attribute Customization.

GUI Element Description
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Objectives Area

The area includes the following elements (listed alphabetically):

Description Enables you to define value ranges that are used to 
determine status for the KPI. The measurement for the 
KPI (calculated by the business rule) is compared with 
the objectives, and a color status assigned accordingly. 

The objectives are defined in a unit of measurement 
appropriate to the type of data dealt with by the rule. 
The unit is indicated after the objective value box.

Important 
Information

This area is displayed when necessary.

If required, you can modify the default values for the 
objectives.

Multiple KPI selection. In the Objectives area, the value 
box is empty. Enter the required value, or select a 
different operator for the objectives. Make sure you 
enter values that apply logically to all transactions in 
the group. 

For information on defining objectives, see “KPI 
Objectives” on page 191.

GUI Element Description

OK, Warning, Minor, 
Major, Critical

Enter the required objective value for each status in the 
appropriate box. Make sure that the numbers you enter 
are logically ordered.

For more information on objectives functionality and 
defining objectives, see “KPI Objectives” on page 191.

Operator Select the required operator. This operator is applied for 
all objectives.

Note: The Objectives area in the Edit KPIs for Child 
Transaction window displays the default Operator for 
the rule. When you apply your changes, the displayed 
default operator is updated to all transaction CIs 
(regardless of which operator they were using 
previously).
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Selector Area

Description Enables you to define the filter criteria for the KPI. The 
selector catches data samples from the incoming data 
that meet the filter criteria. A selector is required for all 
KPIs (attached to monitoring/leaf CIs) that are 
intended to calculate a measurement based on original 
sample data; otherwise no data is mapped to the KPI 
and it remains gray in Dashboard.

Important 
Information

The Selector area is displayed when necessary.

If relevant for the rule, the Selector area is displayed in 
the window. This area is displayed only for certain 
monitor rules and for Dynamic Node Factory CIs.

For a detailed explanation of selector functionality and 
defining selectors, see “Selectors for KPIs” on page 201.

In the Filter area, define selector expressions to create a 
filter for the selector. Each selector expression defines a 
required criteria for the new KPI. 

Note: If you do not define a selector for the KPI, then 
after clicking OK to close the dialog box, HP Business 
Availability Center automatically assigns to the KPI the 
default selector (generally defined for the other KPIs 
attached to the monitoring CI). For details, see “Define 
Selector Expressions” on page 228.
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The area includes the following elements (listed alphabetically):

GUI Element Description

<box> Selector filters can be manually defined to create a 
custom filter, or defined using metadata (predefined 
sample types). If you want to use metadata for the 
filter, select a sample type from the list at the top of the 
Selector area.

When the list displays Custom, the filter is defined 
manually. 

For more information, see “Use Predefined Sample 
Data for Selectors” on page 230.

Add “OR” Expression You can create additional expression blocks (each 
containing one or more selector expressions) using the 
Add “OR” Expression button, to widen the filter.

For more details, see “Build Complex Filters” on 
page 229.

And Click to define additional selector expressions to build 
a more complex filter. You can attach additional 
selector expressions to the first selector expression 
using the And button, to create an expression block 
that narrows the filter. 

For more details, see “Build Complex Filters” on 
page 229.

Field Enter the name of a reference property contained in 
the incoming sample. 

Operator Select an option from the Operator list. 

Value Enter the required value for the property. 

For more information, see “Define Selector 
Expressions” on page 228.
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Ticker User Interface

This chapter includes the pages and dialog boxes that are part of Dashboard 
Ticker User Interface. 

Ticker Window

This chapter describes: On page:

Ticker Window 335

Message Window 337

Ticker Preferences Dialog Box 338

Description Enables you to view a scrolling list (from right to left) 
of the top level CIs monitored by Dashboard along 
with icons that display the status of each one of the 
CI’s KPIs. The icons correspond to the icons displayed 
in the Top View tab in Dashboard. 

To Access: Set up Dashboard Ticker. 
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The Ticker Window includes the following elements (listed alphabetically):

Important 
Information

➤ You set the scrolling speed of HP Dashboard Ticker 
in the Scrolling speed parameter in the Preferences 
page. For details, see “Ticker Preferences Dialog Box” 
on page 338.

➤ When you have moved the Ticker Window to a 
specific location on your desktop, the window is 
displayed in the same location the next time you 
select Show Ticker in the Preferences page or when 
you restart your computer.

➤ If you move the mouse to the Ticker Window, 
scrolling stops; it resumes when you move the 
mouse out of the Ticker Window.

➤ If you change any parameter in the Preferences page, 
scrolling restarts from the beginning.

➤ Modify the number of CI’s levels you want to 
display by changing the value of the Number of 
levels parameter in the Preferences. For details, see 
“Ticker Preferences Dialog Box” on page 338.

Included in Tasks “View Data in Dashboard Ticker” on page 253

GUI Element Description

<icons> The icons correspond to the icons displayed in the Top 
View tab in Dashboard. For details, see “KPI Icons in 
Top View” on page 73.

<tooltip> Move the mouse above any icon in the Ticker Window 
to display a tooltip that includes the name of the KPI. 
For details, see “Ticker Window” on page 251.
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Message Window

The Message Window includes the following elements (listed 
alphabetically):

Description Conveys that a KPI’s status has changed to 
error/poor/worst. 

To Access: Setting up Dashboard Ticker. 

Important 
Information

➤ The window is displayed either automatically or 
manually. For details on how to set this option, see 
“Ticker Preferences Dialog Box” on page 338. 

➤ When you close the message window, the entry that 
was displayed is removed from the queue. You 
cannot redisplay that information. When you 
reopen the window, the next message in the queue 
is displayed.

➤ If you specified in the Preferences that an alarm 
should be sounded when a KPI’s status changes to 
error/poor/worst, an alarm sounds when the 
message is displayed. For details about the 
Preferences dialog box, see “Ticker Preferences 
Dialog Box” on page 338.

Included in Tasks “View Data in Dashboard Ticker” on page 253

GUI Element Description

The status icon of the KPI.

<first line> The name of the CI.

<second line> The name of the KPI.

<third line> The date and time when the status change was received 
by Dashboard Ticker.

Log-on Click to automatically open the view you specified in 
the Preferences, in the Console tab in Dashboard.
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Ticker Preferences Dialog Box

Connection Settings Area

The area includes the following elements (listed alphabetically):

Description

Displays the current preferences for running the 
Dashboard Ticker. 

To Access: Right-clicking the Dashboard Ticker icon in 
the desktop tray bar and selecting Preferences.

Included in Tasks “View Data in Dashboard Ticker” on page 253

GUI Element Description

BAC server URL In the BAC server URL box, enter the URL or the IP 
address of the server you want to access. The URL 
format must be: http://<HP Business Availability 
Center server>/<virtual_Web_URL>
where virtual_Web_URL may be, for example: HPAM.

Update interval box The update interval timeout (in seconds). The 
minimum interval is 5 seconds.

Default Value: 15 seconds.

MMS customer Select if you are an HP Managed Software Solutions 
customer. In the ID box that is displayed, enter the 
customer ID number.
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Login Information Area

The area includes the following elements (listed alphabetically):

Selection Area

The area includes the following elements (listed alphabetically):

Ticker Window Area

The area includes the following elements (listed alphabetically):

GUI Element Description

User name Enter your user name.

Password Enter your password.

GUI Element Description

View name Select the name of the view you want to display in the 
ticker. 

Reload Click if you want to reload the views from the 
HP Business Availability Center server you are 
accessing.

Number of levels Enter the number of levels you want to display in the 
Ticker. When displayed in the Ticker, all levels are 
flattened out.

GUI Element Description

Scroll speed Select a scrolling speed: Low, Mid, or High. The default 
is Mid.

Dock orientation Select the location of the Ticker on your desktop: 

➤ Top. The Ticker is docked at the top of the desktop.

➤ Bottom. The Ticker is docked at the bottom of the 
desktop.

➤ None. The Ticker is not docked. You can move it 
around on of the desktop.The default is None. 
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Options Area

The area includes the following elements (listed alphabetically):

GUI Element Description

Show incoming 
message desktop 
alert

To automatically display the Message Window when a 
new message arrives. If you do not select this option, 
you have to click the message icon to display the 
Message Window.

Play incoming 
message sound alert

To automatically sound an alert when a new message 
arrives.

When the sound is switched on, a sound alert is played 
when the Ticker Window is currently displayed and a 
CI’s KPI changes status to Critical (red). The Critical 
status icon is also shown flashing until the next screen 
refresh. The alert sound is a WAV file downloaded by 
the browser. 

Note:

➤ The sound is played only if the status of a CI’s KPI in 
the currently displayed tree branches has changed to 
Critical. If a CI in a hidden part of the view has 
changed to Critical but does not change the status of 
any of the CIs in the currently displayed branches, 
no sound is heard.

➤ If the view is being loaded for the first time, no 
sound is played for the CI’s KPIs that are loaded at 
Critical status.

➤ If you are using Mozilla, you must download a plug-
in for playing WAV files, otherwise no sound is 
played.

To use another alert sound, access (if you are a user 
with administrative permissions) <HP Business 
Availability Center server root directory>\AppServer\ 
webapps\site.war\bam\pages\sounds and replace the 
ding.wav file with your own .wav file (you must 
rename your file ding.wav). The change takes effect 
immediately.
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Load Dashboard 
Ticker when my 
computer starts

Select to automatically load Dashboard Ticker when 
you start your computer. For details about the Ticker 
Window, see “Ticker Window” on page 335.

Show Ticker Window 
when my computer 
starts

To automatically load Dashboard Ticker Message 
Window when you start your computer. For details 
about the Message Window, see “Message Window” on 
page 337.

GUI Element Description
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